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Welcome to Peer Software's powerful file mirroring, backup and distribution solution, PeerSync v9.2. With this product you will be able to conveniently synchronize folders for back-up
purposes or portability requirements. Never again will you overwrite newer data by attempting to manually update an individual file or the contents of a folder.
History
PeerSync has been available for download/purchase since early 1995. Since then hundreds
of downloads have been logged from various international forums where PeerSync was
made available and thousands of copies have been sold. PeerSync is an MS Windowsbased product. Originally written in Visual Basic, the current product is written in Delphi Object Pascal. PeerSync originated as a solution to a problem frequently encountered by our
own developers, that of keeping files in sync between multiple hard drives. Developers working on-site at customers' locations or at home during crunch schedules would then have to
synchronize their data back to the office server. This was most often done manually, with
each individual file being dragged to the appropriate server folder. Invariably, data would be
lost when one or several of the server files contained new information which was subsequently overwritten. In addition to loss of work and resulting frustration, the process was
also time consuming. Anywhere from 20 minutes to 2 hours would be spent during each synchronization. After reviewing several commercially available products, it became apparent
that an effective and user-friendly solution to this common problem did not exist, hence the
development of PeerSync.
Description
Configured through the Profiler, an intuitive and easy-to-use application, PeerSync automatically synchronizes multiple directories and sub-directories from user-defined Source to Target Folders. While removing the frustration and loss of time associated with manual synchronization, PeerSync prevents loss of data by checking file dates and times to ensure that
newer information is not overwritten. Synchronization can occur between any mapped or
UNC connected drives located on local computers or computer networks. While processing
and performing any number of simultaneous tasks, PeerSync retains and expands upon the
selectivity and precision of manual synchronization by offering a suite of automated file inclusion and exclusion features. Files can be included within synchronization according to standard DOS-type wild cards and excluded using sub-string comparisons or file attribute settings.
Files can be also be excluded according to their date and size. In addition, PeerSync can be
configured to update or add files which are out-dated or non-existent in the current Target
Folder. Precision and scope are further enhanced through PeerSync Jobs and Command
Line Modes. A virtually unlimited number of folder combinations (Jobs) can be created and
stored in Profiles which can be run manually or automatically using command line arguments. While synchronizing large numbers of folder combinations at once, each combination
can have a unique set of exceptions. In this way PeerSync combines the benefits of precise
folder matching with that of an automated environment. Real-Time Source Folder monitoring
and repetitive operations on the host PC are also available with PeerSync's options. PeerSync can also be used for network file management purposes. Reports run during synchronization can display added, updated, and opened files as well as directories created, and can
display unmatched files found in Target directories.
Embedded Open File Manager (EOFM)
PeerSync's Embedded Open File Manager (EOFM) option was created and bundled into
PeerSync through a third party partner named EVault. EVault has announced that EOFM is
now "End-of-Life" and no further development or support will be provided. Thus, Peer SoftCopyright © 1993-2014 Peer Software Inc. All Rights Reserved
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ware will no longer be including EOFM as part of PeerSync beginning in PeerSync version
9.0. In addition, we are no longer able to provide technical support on EOFM effective immediately.
For Peer Software customers currently using EOFM and who are on a valid maintenance
support contract, we offer a FREE upgrade from EOFM to the Volume Shadow Copy Service
(VSS) option. We urge all customers to take advantage of this FREE upgrade offer. Peer
Software is continuing development and support for VSS.
PeerLock Configuration Support
Starting with PeerSync v7.4, customers who are running PeerLock 2.0.1 or higher on the
same machine as PeerSync are able to configure PeerLock directly from the PeerSync Profiler. Configuration options include the ability to link specific PeerSync Profile Jobs to PeerLock, ability to access/view/edit the PeerLock Global Settings from the PeerSync Profiler,
ability to install/uninstall the PeerLock Service, as well as launch and view PeerLock directly
from the PeerSync Profiler.
Version 7.4 and higher of PeerSync also supports real-time or scheduled bi-directional replication using our TCP replication mode. In this version, PeerSync now supports bi-directional replication with target directories that reside outside the LAN, WAN, or VPN.

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all responsibility for any data loss or damage.
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved Privacy Policy
PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.
The PeerSync Help Manual was built on Saturday, May 24, 2014
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Product Information
License
YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND CONDITIONS
BEFORE INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE. INSTALLING,
USING OR DISTRIBUTING THIS SOFTWARE INDICATES ACCEPTANCE OF THESE
TERMS AND CONDITIONS. IN THIS AGREEMENT, ''YOU'' MEANS YOU AS AN
INDIVIDUAL IF YOU ARE USING THIS SOFTWARE FOR PERSONAL USE. IF YOU ARE
USING THE SOFTWARE ON EQUIPMENT OWNED OR OPERATED BY A COMPANY
OR ORGANIZATION (COLLECTIVELY ''COMPANY''), BY ACCEPTING THIS
AGREEMENT, YOU REPRESENT THAT YOU ARE DULY AUTHORIZED TO ACCEPT
THIS AGREEMENT ON BEHALF OF YOUR COMPANY.
COPYRIGHT
The software programs (hereafter the "Software") and documentation (hereafter the "Documentation") is copyrighted and remains the property of Peer Software, Inc. All rights are reserved.
LICENSE
Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive, nontransferable license to install and use the Software and accompanying Documentation contained in the trialware distribution package (hereafter called the "Trialware Package") you received (THE "Original Distribution") for your internal business purposes only. The Trialware
Package consists of copies of the Software and Documentation received via an electronic
transfer mechanism or an electronic storage medium including, but not limited to, diskette,
hard disk, removable disk, tape or optical devices such as CD-ROM or WORM. This license
to install and use the Software and Documentation is conditioned upon User’s compliance
with the terms of this Agreement.
You may install and use the Trialware Package on one or more computers provided there is
no chance that it will be used simultaneously on more than one computer. If you need to use
the Software on more than one computer simultaneously or on a network, please contact
Peer Software, Inc. for information about network licenses.
The Software is protected by trade secret and copyright laws and international treaty provisions. You are not obtaining title to the Software or Documentation or any copyright or other
intellectual property rights. You further acknowledge that title and full ownership rights to the
Software and Documentation will remain the exclusive property of Peer Software, Inc. or its
suppliers, and You will not acquire any ownership rights to the Software. You may not sublicense, lease, rent, sell, convey, translate, modify, decompile, incorporate into another
product, convert to another programming language, reverse engineer or disassemble the
Software or Documentation for any purpose. You may not modify, or create derivative works
based in whole or in part upon, the Software. You agree to not remove, obscure, or alter Peer
Software, Inc.’s or any third party's copyright notice, trademarks, or other proprietary rights
notices affixed to or contained within or accessed in conjunction with or through the Software
and Documentation. Peer Software, Inc. reserves the right to periodically conduct audits
upon advance written notice to verify compliance with the terms of this Agreement.
Once a license is purchased from Peer Software, Inc., the Trialware Package will be authorized to function as the full working version of the Software with access to all licensed features.
NETWORK LICENSE
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation must purchase a Network License. Two forms of Network Licenses are offered, a Site License and Enterprise or Concurrent User License. With a Site License, any user who accesses the Software or Documentation requires a user license, regardless of the frequency
of use. Once a Site License is purchased Software and Documentation may be copied to all
users who have been licensed. Site Licenses are customized for each purchase. The license
is based on a quantity of simultaneous users and or CPU installations.
The Concurrent User License allows the licensed number of users to simultaneously access
the Software and Documentation. The User agrees to operate metering software, which restricts the simultaneous number of users to the quantity purchased. The Software and Documentation must be installed on network servers under the control of metering software.
Both Site and Concurrent User Licenses allow installation of the Software and Documentation to any number of servers on any number of geographic sites, limited only by the quantity
of licenses purchased.
TERM AND TRIAL PERIOD
You are permitted to use the Trialware Package for a trial period (hereafter the "Trial Period")
of thirty (30) days or 30 uses (which ever comes first) after receipt of the Trialware Package.
After such time, if you continue to use the Trialware Package, you must register your copy
with Peer Software, Inc. Failure to register after the Trial Period constitutes termination of
this license. Upon registration, a password (hereafter called the "Password") will be provided
to eliminate the registration reminder screen.
This license is effective until terminated. You may terminate it by destroying the Software,
Documentation, and all copies thereof. This license will also terminate if you fail to comply
with any of the terms or conditions herein. You agree, upon such termination, to destroy all
Software, Documentation, and copies thereof. Upon request, You agree to certify in writing
that all copies of the Software and Documentation have been destroyed.
LIMITED WARRANTY
THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY
OF ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO
THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED
TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE EXPRESSLY AND
SPECIFICALLY DISCLAIMED.
EXCLUSIVE REMEDY
YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING
FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR THIS
LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR
REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF
NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).
LIMITATIONS OF LIABILITY
UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT,
OR OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC.
SHALL HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR
LOSSES OF ANY NATURE. IN NO EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR
ANY DAMAGES IN EXCESS OF THE LIST PRICE PEER SOFTWARE, INC. CHARGES
FOR A LICENSE TO THE SOFTWARE.
Some states do not allow the exclusion of the limit of liability for consequential or incidental
damages, so the above limitation may not apply to you.
BACK-UP
You may make one copy of the Trialware Package for backup purposes only.
DISTRIBUTION
You may distribute the Trialware Package to others via an electronic transfer mechanism or
electronic storage media provided that no files are deleted from the Original Distribution Trialware Package or are modified in any way. Files may be added to the Trialware Package
expressly for the purpose of identifying the party distributing the Trialware Package. You may
also place the Trialware Package into any archive or compressed format for ease of distribution.
You may not distribute the product Registration Key to others under any circumstances.
GENERAL
Export of the Software may be subject to compliance with the rules and regulations promulgated from time to time by the Bureau of Export Administration, United States Department of
Commerce, which restrict the export and re-export of certain products and technical data. If
the export of the Software is controlled under such rules and regulations, then the Software
shall not be exported or re-exported, directly or indirectly, (a) without all export or re-export licenses and United States or other governmental approvals required by any applicable laws,
or (b) in violation of any applicable prohibition against the export or re-export of any part of
the Software. Some countries have restrictions on the use of encryption within their borders,
or the import or export of encryption even if for only temporary personal or business use. You
acknowledge that the implementation and enforcement of these laws is not always consistent
as to specific countries. Although the following countries are not an exhaustive list there may
exist restrictions on the exportation to, or importation of, encryption by: Belgium, China (including Hong Kong), France, India, Indonesia, Israel, Russia, Saudi Arabia, Singapore, and
South Korea. You acknowledge it is your ultimate responsibility to comply with any and all
government export and other applicable laws and that Peer Software, Inc. has no further responsibility after the initial license to you within the original country of sale.
In addition, neither the Software nor the Documentation and underlying information or technology may be downloaded or otherwise exported or re-exported (i) into (or to a national or
resident of) any country to which the United States has embargoed goods; or (ii) to anyone
on the United States Treasury Department's list of Specially Designated Nations or the United States Commerce Department's Table of Denial Orders. By using the Software you are
agreeing to the foregoing and you are certifying that you are not located in, under the control
of, or a national or resident of any such country or on any such list.
This agreement shall be governed by the laws of the state of New York and shall inure to the
benefit of Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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action arising under this Agreement shall be filed in any state or federal court located in
Suffolk county in the State of New York, and You hereby agree, acknowledge and submit to
the exclusive jurisdiction and venue of such courts for the purposes of such action, waive any
right You may have to object to such jurisdiction or venue.
This Agreement sets forth all rights for the user of the Software and is the entire agreement
between You and Peer Software, Inc. and supersedes any other prior or contemporaneous
agreements or communications with respect to the Software and Documentation. This Agreement may not be modified except by a written addendum issued by a duly authorized representative of Peer Software, Inc. No provision hereof shall be deemed waived unless such
waiver shall be in writing and signed by Peer Software, Inc. or a duly authorized representative of Peer Software, Inc. If any provision of this Agreement is held invalid, the remainder of
this Agreement shall continue in full force and effect. The parties confirm that it is their wish
that this Agreement has been written in the English language only.

PeerSync Installation
PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click
on the executable in the Explorer window, or choose "Run" from the Start Menu and then select the application. For networked installations, PeerSync supports silent installation by
adding "/S" to the installation application's command line.
Example: %PATH%/peersync92.exe/S

See Additional Configuration Entries for more Information on silent installation configuration.
Additionally, PeerSync can use the PeerSync92.lic file for larger networked sales and site licensing. This file will be placed in the "PeerSync" folder. If PeerSync detects this file at startup then it will use this data and bypass all other registration security checks. If the PeerSync92.lic file is located in the same folder as the PeerSync installation application, this file will
then be automatically placed in the PeerSync installation folder during installation. To obtain
a PeerSync92.lic file, please specify your requirements during purchase/registration.
Note: Adding /S /A INSTALL.LOG to the Uninstall.exe command line will perform an automatic silent uninstall of
PeerSync.

Additional Configuration Entries
PeerSync and the PeerSync installation (peersync92.exe) use a configuration file
(PSDef.cfg) to read and set options during and after installation. If a PSDef.cfg file is located
in the same folder as peersync92.exe before installation, this file will be automatically copied
to the PeerSync installation folder during installation.

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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Pre-Installation Configuration Options
The following options are available before installation and are used during manual
and silent installs:
Installation Folder

This option can be set to any directory path and designates
what directory to install PeerSync into.

Disable Install Reboot

This option can be set to 'Yes' or 'No' and allows you to suppress the rebooting (if needed) of your computer after installation.

Install PSProfiler

This option can be set to 'Yes' or 'No' and allows you to decide
if the PSProfiler interface is to be installed.

Install PSWizard

This option can be set to 'Yes' or 'No' and allows you to decide
if the PSWizard interface is to be installed.

Install SNMP

This option can be set to 'Yes' or 'No' and allows you to decide
if files needed for SNMP are to be installed (SNMP is only
available in the Enhanced Package).

Create Start Menu Short- This option can be set to 'Yes' or 'No' and allows you to decide
cut
if shortcuts related to the PeerSync installation will be added to
the Start menu.

Post Installation Configuration Options
The following options are used by PeerSync and other installed applications after install:
User Name

This is used to set the Registration or Evaluation information to
be read in by PeerSync.

Company Name

This is used to set the Registration or Evaluation information to
be read in by PeerSync.

Options

This is used to set the Registration or Evaluation information to
be read in by PeerSync.

Password

This is used to set the Registration or Evaluation information to

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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be read in by PeerSync.
TempFolder

This option can be set to any directory path and will be used
for a temporary folder PeerSync to use. If the path does not
exist, an attempt will be made to create it. If it cannot be created, the default will be used which is the logon users system
Temp path.

Registration and Passwords
If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer Software, Inc. as a fully licensed copy by providing credit card information via phone or secure
Internet registration, or by sending a check or money order to the address below (see included "readme.txt" file for pricing information). As an integral component of PeerSync 9.2
and all subsequent versions, the Profiler application is included as part of registration.
Register online via secure Internet credit card registration at:
http://www.peersoftware.com
Register by phone via credit card by calling:
703.763.7700 between the hours of 9:00 AM to 5:00 PM EST
Register by FAX via Purchase Order:
Send Purchase orders to 703.763.7705
Register by mail, send check or money order to:
Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121
Information Required:
Full name (as it appears on the credit card)
End User Name (user to be licensed for the product)
Company Name (if applicable)
Address (City, State / Province, Country, and Postal Code)
Phone Number
Entire Card Number
Card Expiration Date
Card Security Code
Email Address
(Peer Software, Inc. will send the Authorization Key required to unlock PeerSync's Evaluation Counter to this).
Quantity Discounts
Visit http://www.peersoftware.com or contact us for more information.
Upon registering PeerSync, user information will be generated according to the name and
company name (if any) you specified during registration, as well as a password specific to
the product version you have licensed. This information will be emailed to you and will be
used to activate your current copy. Additional license fees must be paid for multi-user use.
PeerSync may not be commercially distributed or distributed by government agencies including their contractors UNLESS registration fees are paid for by the distributing party.
See License agreement for product redistribution.

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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Please visit http://www.peersoftware.com for different versions of PeerSync and types of licensing we offer.
Note Regarding Updates: As new updates/changes become available, updated versions of the software will be
posted at http://www.peersoftware.com. Check this page periodically to download the latest executables. Your
Authorization Key will continue to work with updated versions unless a major release is issued, or PeerSync is installed in a different folder than the previously installed/authorized version.

Entering Your User Information and Password
Through an Evaluation Copy of PeerSync:
After registration with Peer Software, Inc., you will receive Registration Information generated which is from the information you provided during registration. The password you receive will be specific to the PeerSync product you have licensed and registered with Peer
Software. Upon entering valid password and user information into your Evaluation Copy, that
copy will be immediately converted to a fully licensed version of the appropriate PeerSync
product. The instructions below apply to a "Registered Evaluation Copy" of PeerSync, that
being one whose evaluation period is still active.
To activate your registered and licensed PeerSync product, first run your Evaluation Copy of
PeerSync. Then choose "About" from the Help Menu located on the far right of the Profiler
Menu Bar. To activate your registered and licensed PeerSync product, first run your Evaluation Copy of PeerSync. Then choose "About" from the Help Menu.
Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen,
which contains "User Name," "Company", "Options" and "Password" fields.
Be sure to enter this information exactly as you received it, with the same spacing, hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company name is
omitted, registration will not be accepted). It is advisable to cut-and-paste passwords directly
from the E-mail registration information. If passwords are typed using lower case letters
where upper cases have been indicated, or if other information is typed incorrectly, the message shown below will be displayed. This message indicates that registration was unsuccessful; shows the number of attempts made to register, and contains' a link to Peer Software's website. You will only be allowed a limited number of attempts before the application
closes entirely and will need to be opened again in order to retry.
If registration is successful, your will receive a success dialog. Your Evaluation Copy will
have been immediately activated as a registered version of the PeerSync product you have
licensed, with this change indicated on the interface title bar. Click "OK" on the success dialog to begin usage of your newly activated PeerSync product. You will not have to exit and
restart the application to do so.
Through an Unregistered Copy of PeerSync:
Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has expired, or copies into which a valid password and user information has not yet been entered.
These copies can still be activated as fully licensed versions of whichever PeerSync product
whose usage you have purchased from Peer Software, Inc.
After registration with Peer Software, you will receive Registration Information which is generated from the information you provided during registration. The password you receive will
be specific to the PeerSync product you have licensed.
To activate your copy of PeerSync as a fully licensed version, first run the copy. Because
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your copy is unregistered, the application will not open in its entirety, instead an About PeerSync screen will open. This screen contains "User Name," "Company", "Options" and "Password" fields.
Be sure to enter this information exactly as you received it, with the same spacing, hyphenation, punctuation, and cases (i.e. if a comma or period contained within a company name is
omitted, registration will not be accepted). It is advisable to cut-and-paste passwords directly
from the Email registration information. If passwords are typed using lower case letters
where upper cases have been indicated, or if other information is typed incorrectly, the message shown below will be displayed. This message indicates that registration was unsuccessful; shows the number of attempts made to register, and contains' a link to Peer Software's website. You will only be allowed a limited number of attempts before the application
closes entirely and will need to be opened again in order to retry.
If registration is successful, your will receive a success dialog. Your copy will now have been
immediately activated as a registered version of the PeerSync product you have licensed.
Click "OK" on the success dialog to begin using your registered copy: the About PeerSync
screen will close and the full application interface will be displayed. You will not have to exit
and restart the application to begin usage.
TERMS AND CONDITIONS
READ THE LICENSE AGREEMENT BEFORE USING THIS PROGRAM.
Please send any suggestions, comments or requests for support to the proprietor of PeerSync:
Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121
Phone:
Fax:
Web:

703.763.7700
703.763.7705
http://www.peersoftware.com

Upgrade Information
Visit http://www.peersoftware.com/support/request-product-update.html to get the latest version of PeerSync.
Check this page periodically to download the latest executables. Your Authorization Key will
continue to work with updated versions unless a major release is
To Upgrade PeerSync
Major product upgrades such as v9.1 to v9.2 will require a new product key. Users currently
on annual maintenance must fill out the request for upgrade form to receive the upgrade license key before downloading v9.2.x. Users not on annual maintenance must contact sales
for upgrade pricing.
1. Stop the PeerSync service or application if it is running
2. Terminate any instances of PeerSync.exe or PSProfiler.exe running in the Task Manager
3. Download the latest PeerSync executable from the following link: http://www.peersoftware.com/support/request-product-update.html
4. Launch the installation by selecting "Run" from the download dialog or by double-clicking
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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on the installation file (peersync92.exe)
5. If you are upgrading the current version of PeerSync (9.2.x to 9.2.y) simply install the application over your existing PeerSync and the previous version will be backed up in a subfolder called 'BACKUP' (if the option to keep a backup is selected during the installation). If
you are evaluating a new version of PeerSync 9.2 and you already have an existing copy
of PeerSync 9.1 or older, please select a new directory during the installation.
6. If you wish to remove previous versions of PeerSync you must go to the 'Start Menu-Settings-Control Panel', select the 'Add/Remove Programs' utility and remove the PeerSync
versions you no longer need.
To Upgrade PSListener
1. Stop the PSListener service if it is running
2. Terminate any instances of PSListener.exe running in the Task Manager
3. Download the latest PSListener executable from the following link: http://www.peersoftware.com/support/request-product-update.html
4. Go into the C:\WINDOWS\system32 directory and rename the PSListener.exe file to
PSListener-OLD.exe
5. Launch the installation by selecting "Run" from the download dialog or by double-clicking
on the installation file (pslist21.exe)
6. If you are upgrading the current version of PSListener simply install the application over
your existing location and the previous version will be backed up in a sub-folder called
'BACKUP' (if the option to keep a backup is selected during the installation). If you are
evaluating a new version of PSListener and you already have an existing copy of
PSListener v2.0 or older, please select a new directory during the installation.
7. If you wish to remove previous versions of PSListener you must go to the 'Start Menu-Settings-Control Panel', select the 'Add/Remove Programs' utility and remove the PSListener
versions you no longer need.
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Interface Features

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all responsibility for any data loss or damage.
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved Privacy Policy
PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.
The PeerSync Help Manual was built on Saturday, May 24, 2014

Getting Started
The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255 individual synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a Target Folder (to which the contents of the Source will be synchronized), and then choosing
from more than 80 easily specified Job Settings. These settings determine which contents
will be synchronized, in what manner, and when they will be synchronized -- according to
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved
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your choice of Real-Time, Scheduled, or manually initiated operations.
The process of building a Profile is made quick and simple by allowing you to easily create
Jobs and then follow the sequentially arranged list of Settings screens accessed through the
Selection Tree, which is located on the left side of the application interface. The user begins
by first selecting a single Job or Multiple Jobs from the Profile Job List. Then specific synchronization criteria is applied to the selected items using Job Settings. Once synchronization criteria has been configured for each Job, Run/View Current Profile window is used to
launch the entire Profile. By offering a Tool button Toolbar as well as separate Selection Tree
and Profile Job List windows, Profiler's browser-based interface allows you to easily view,
create, copy, rename, move, or delete Jobs regardless of which Settings screen is currently
being displayed.

Product Definitions
Synchronization

Updating any existing files or adding new files in the Target
Folder using the Source Folder as the guide. When completed,
the Target Folder should contain all of the files in the Source
Folder with matching content and time stamps.

Replication

Same as synchronization, except files that are in the Target
Folder that do not have a matching Source File will be deleted.

Profiles

A Profile is a description of a complete synchronization scenario. Profiles can contain many Source-Target combinations allowing the end-user to define very detailed file synchronizations and run them all within a single request. For example,
you could build a Profile that contains Multiple Source and Target Folders such as:
Source = C:\My DocumentsTarget
=
\\SERVER1\USERS
\TEST\My Documents
Source = D:\LocalData
Target
=
\\SERVER2\USERS
\TEST\LocalData
Source = C:\WINDOWSTarget
=
\\SERVER3\USERS
\Profiles
\TEST\Profiles
Each of these Source-Target entries can then be further detailed with more than 65 options each making each entry a
completely self-contained process while still allowing it to be
run as part of a bigger set or Profile.

Jobs

A Job is a single entry in a Profile. A Profile can contain from
one to 255 Jobs and each Job contains more than 80 individual option settings.

Real-time Mode

In this mode of operation, PeerSync will automatically detect
changes made to the Source Folder(s) and execute the synchronization options selected for the matching Job. Typically,
the Target Folder is updated with the Source Folder change
within moments of the change. Note that PeerSync may have
completed the operation before Windows actually displays the
change in the Target Folder Explorer window.

Scheduled Mode

In this mode of operation, PeerSync will execute the designated Job at the selected time. Each Job in the Profile can
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have the same or different time interval.
Product Support

All support of PeerSync will be handled on our web site support page located at http://www.peersoftware.com/support/submit-a-case.html.
PeerSync is fully supported under all NT based platforms of
Windows but should first be evaluated on each machine in
which you wish to register the product on. PeerSync is no
longer fully supported under Windows 9x platforms.

Notes:
1. The Profiler is not meant to be running persistently on the Desktop. Rather it should be accessed to create/modify
Profiles and to view the status of running Jobs.
2. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

Tool Buttons
Profiler offers a simple set of browser-style Tool Buttons allowing you to easily modify the
current Profile and its Jobs, regardless of which screen has been chosen from the Selection
Tree. These buttons can be hidden by unchecking the "Tool Buttons" option, accessed
through the "Toolbars" item on the View Menu. Even if this Toolbar has been hidden you will
still be able to access its options by using the File, Edit, and Job Menus. You can also
change the placement of these buttons by clicking on the left side of the Toolbar and dragging it to rest above or below the Profile Description Toolbar.

Toolbar
The following descriptions are listed in the order in which they appear left to right on the
Tool Buttons Toolbar and are all accessible via the application Menus.
New Profile

Located on the far left of the Toolbar, this button creates a new
Profile. If another Profile containing unsaved changes is currently open when this button is pressed, a dialog box will open
asking you if you want to save changes to the current Profile
before opening a new one (See Save Profile Button Below). If
you choose "No," the new Profile will replace the current one
and no changes will be saved.
Note: If the current Profile has not been previously saved and "No" is chosen,
the entire Profile will be lost.

Open Profile

This button displays a "Select Profile File" dialog box allowing
you to open an existing Profile. By default, it will open in the
path in which PeerSync has been installed (i.e. C:\Program
Files\PeerSync). Links to previously opened Profiles can be
accessible through a drop-down list opened by clicking on the
arrow key attached to this button.

Save Profile

This button allows you to save new Profiles, or save changes
made to existing Profiles. If you are saving a new Profile, a
"Save As" dialog box will open allowing you to name and store
it as an .SNC file in your choice of folders, with "NewProfile" as
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the default name and the path in which PeerSync has been installed as the default directory. Profiles and Profile modifications must be saved in order to be subsequently accessible.
Launch Current Profile

This feature will launch the current Profile (Job/Global settings). During this process, an instance of PeerSync will be
started with the current Profile as the first parameter and the
arguments selected from the Options/Commands screen as
the subsequent parameters. You can automate this process
via a shortcut, through the startup folder, in the registry or as a
service by selecting one of these features from the StartUp
Services screen.

Terminate/Stop Active
Profile

This option, when available, will allow a user to terminate an
instance of PeerSync that contains an active Profile that is
connected to the Profiler.

Restart Active Profile

This option, when available, provides intelligent restart functionality that eliminates/improves scanning upon PeerSync service/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any other reason).

Connect: Enable Job
Control Mode

This tool button becomes visible when the Profiler has been
started and is in a running state. The option connects the configuration Profile to the running PeerSync. When selected, this
option changes the Job List Display into Job Control Mode.

Disconnect: Enable Configuration Mode

This tool button becomes visible when the Profiler is running as
a service and Job Control Mode has been enabled. When selected, this option changes the Job List Display into the default Configuration Mode.

Add Job

This button adds a Job to the bottom of the current list (See
Profile Job List). Jobs are named "New Job Item" and assigned
a number by default. If you have selected "Use Wizard to Add
New Jobs" from the Options Menu, the Wizard application will
open when this button is pressed. The Wizard provides a
guided, step-by-step method for creating and configuring new
Jobs. A drop-down list attached to this button also allows you
to choose between "Add Job With Wizard" or "Add Job With
Defaults" options. If the former is chosen, Wizard will open
every time this button is pressed. If the latter is chosen, new
Jobs added to the list through this button will be configured
manually using Selection Tree screens. These Jobs will use
whichever default settings are currently applied (See Job
Menu, "Save Defaults").
Note: The first time "Add Job With Wizard" is chosen from the drop-down list,
the Wizard application will open. After that point Wizard will be launched by
pressing the Add Job button.

Copy Job

Creates a copy of the currently selected Job and places it at
the bottom of the Profile Job List. Copies will be numbered by
default and named after the original (i.e. "Copy 1 of My
Syncs").

Rename Job

Allows you to rename the currently selected Job. Jobs can also
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be renamed manually by clicking on them after they have been
highlighted.
Delete Job

Deletes the currently selected Job(s). When this button is
pressed, a dialog box will open asking you to confirm deletion.
Jobs can also be deleted by selecting them and then pressing
the DELETE key on your keyboard.

Move Job Up

Moves the currently selected Job up one place within the Profile Job List.

Move Job Down

Moves the currently selected Job down one place within the
Profile Job List.

Show Selection Tree

Shows or hides the Selection Tree. If the Tree has been hidden, its space will be filled within the interface by the currently
selected Settings screen. When the tree is hidden, screens can
still be selected using the drop-down list attached to the Back
button.

Job View

Click the down arrow button next to this option to see the entire
list of settings that can be used to alter the view of the Job list.
Select Columns This option is available only when the Details
view mode is set. It is used to define the exact
columns to display in the Job list. Options include Source, Target, Group, Modified, and
State.

Back

Large Icons

Select this option to represent each Job as a
large icon in the Job list panel.

Small Icons

Select this option to represent each Job as a
small icon in the Job list panel

List

Select this option to represent each Job as a
list in the Job list panel.

Details

Select this option to represent each Job as a
detailed list in the Job list panel. Use the
Select Columns option to customize the view
to show only the desired columns.

Group by

This option is only available when the Large
Icons, Small Icons, or Details view modes are
selected. Use this option to group the Jobs
based on the following categories: Source,
Target, Job Group, Job State, and Modified.

Options

This option is only available when the Details
view mode is selected. Use this option to customize the look of the Job list panel by selecting: Show Columns, Show Grid Lines, or Row
Select.

Opens the screen located immediately above that, which is
currently being displayed. Settings screens can also be ac-
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cessed using the drop-down list located on the right side of the
Back button; list items follow the same order as that shown on
the Selection Tree.
Next

Opens the Profile Options screen located immediately below
the screen currently being displayed.

Help Manual

Opens the application help file. You may also access specific
parts of the help file for features you are currently observing by
pressing 'F1' on your keyboard.

Profile Description
This field is located bellow the Tool Buttons Toolbar by default and displays a textual description of the current Profile. By default the description for an unsaved Profile will read
"Profile Job List." Unless you enter a unique description into this field, a default description
will be assigned upon saving the Profile; this default description will match the new Profile
name.
Descriptions can be changed at any time; like all Profiler configurations, they must be saved
prior to closing the Profile or application in order to be stored. You can change the placement
of the Profile Description Toolbar by clicking on its left side and dragging it to rest above or
below the Tool Buttons Toolbar. The Profile Description can also be hidden by unchecking
the "Profile Description" option, accessed through the "Toolbars" item on the View Menu.

Menus
1. File Menu
File
This menu includes items allowing you to create and save new Profiles, open existing Profiles, create Profile desktop shortcuts, and exit the application.
New

Create a new Profile. This feature is accessible from the Tool
Buttons Toolbar.

Open

Open an existing Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Reopen

Reopen a recently used Profile.

Save

Save the current Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Save as

Rename and Save the current Profile.

Profile - Revert to Saved

Revert to the last saved settings of the current Profile.

Profile - Merge Existing

Merge an existing Profile into the current Profile.

Profile - Create Shortcut
on Desktop

Create and add a shortcut to PeerSync of the current Profile
and settings/command line arguments to the desktop.

Profile - Save Defaults

Save the current settings of the Profile as the default settings.

Exit

Close/exit the application.

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

18

2. Edit Menu
Edit
Allows you to move one step up or down between Selection Tree options screens while
providing a shortcut to the Run/View Current Profile Activity screen.
Back

Move back to the previous screen. This feature is accessible
from the Tool Buttons Toolbar.

Next

Move on to the next screen. This feature is also accessible
from the Tool Buttons Toolbar.

Run/View Current Profile

Go to the Run/View Current Profile Activity screen.

3. View Menu
View
Allows you to change the appearance of the application interface. "Hint" items enable or
disable pop-up hints activated by passing the mouse pointer over interface features, as
well as those displayed in the Status Bar located at the bottom of the application interface.
In addition to a description of Profiler features, hints will identify command line arguments
associated with those features (if any).
Toolbars - Tool Buttons

Show/hide the Tool Buttons Toolbar.

Toolbars - Profile Description

Show/hide the Profile Description Toolbar.

Toolbars - with Hot
Tracks

Show/hide the hot tracks features for the Toolbars.

Toolbars - with Text Labels

Show/hide description text labels for the Toolbars.

Selection Tree

Show/hide the Selection Tree left side panel. This feature is
also accessible from the Tool Buttons Toolbar.1

Refresh Current Profile
Activity

Refresh Profile activity.

Status Bar

Show/hide the Status Bar at the bottom of the application.

Hints - on Application

Show/hide pop-up hints displayed on the application.

Hints - on Status Bar

Show/hide hints displayed on the Status Bar.

Folders

Allows for the ability to launch and display Source and Target
Folder selections in organized Explorer windows in a set viewing area. This helps the user to view and/or validate the Source
and Target Folder content before, after, and during synchronization. These features may be helpful during evaluation and
when running and testing a newly modified Profile.

Job Groups * (Enhanced
Package)

Similar to Microsoft's Multiple Document Interface (MDI), PeerSync now contains a multi-pane interface that allows the user
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to organize groups of Jobs (Source and Target pairs) by any
convention necessary. User-specified tab controls allow quick
transition from one group to another. The traditional Job list interface is still available for those who do not need the group
panes.
Remote Control * (Enhanced Package)

Displays the Remote Control Dialog which allows for the ability
to monitor PeerSync running as a service on the local machine
and/or any instances of PeerSync running on machines that
are connected to the local machine.

Profile Messages

Open the Profile Message Log file if it exists. The naming convention of the Message Log files is as follows: Profile.snc.log,
where Profile represents the name of the current Profile.

* Note: Some features described on this page require the Enhanced Package.

4. Options Menu
Options
Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard interact with each other and Windows Explorer.
Use Wizard to Add Jobs

Available only if the Wizard is installed during the PeerSync installation. If selected, directs Profiler to open the Wizard application as an easier and simpler way to add new Jobs to a
Profile. If not selected, the Add Job option will use the saved
Job defaults. This feature is toggled on or off depending on
which option was used the last time that a Job was added (with
Defaults or with Wizard).

Create SNC extension
association

If selected, creates an association of any file that has an SNC
extension with the Profiler to be used as the default application
to open these files. If not selected, the association of SNC files
with the Profiler will be removed. This feature is also accessible from the Startup Services screen.

Add Quick-Sync Folder
option to Explorer menu

If selected, will add our Quick-Sync feature to Windows Explorer. To access this feature, simply right-click on any folder
in Explorer, or on your Desktop, and you will be able to sync
the folder to selected Target Folder(s), add the Job to a QuickSync Profile that is stored out in memory, and administer the
ability to modify/add to the Jobs using the Profiler. This feature
is also accessible from the Startup Services screen.

On Profile Exit

This option allows for the ability to do one of the following
when exiting the Profiler while it is connected to an Active Profile: Display Terminate Active Profile Dialog, Leave Active Profile Running, or Terminate Active Profile.

Global Settings

Displays various settings including Recovery/Offline Options,
Performance Options, Reporting Options, Display Options,
ACL Options, Bi-directional Options, Managed Files Options,
and Current Command Line Arguments.
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5. Run Menu
Run
Allows you to Launch the Current Profile, Terminate the Active Profile and Update the Current Profile.
Launch Current Profile

This feature will launch the current Profile (Job/Global settings)
in PeerSync. During this process, an instance of PeerSync will
be started with the current Profile as the first parameter and the
arguments selected from the Options/Commands screen as
the subsequent parameters. You can automate this process
via a shortcut, through the startup folder, in the registry or as a
service by selecting one of these features from the Startup
Services screen. This feature is also accessible from the Tool
Buttons Toolbar.

Terminate Active Profile

This option, when available, will allow a user to terminate an
instance of PeerSync that contains an active Profile which is
connected to the Profiler. This feature is also accessible from
the Tool Buttons Toolbar.

Update Current Profile

This option, when available, will allow a user to update an instance of PeerSync with the current Profile opened in the Profiler.

Restart Active Profile

This option, when available, provides intelligent restart functionality that eliminates/improves scanning upon PeerSync service/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any other reason).

Pre-Sync Report

This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A report will be created and displayed with the work that would
be performed if a synchronization was actually run. This feature may be quite helpful during evaluation and when running
and testing a newly modified Profile. Pre-Sync Report options
are as follows:
Run a Pre-Sync Report (do not sync files/folders)
Starts PeerSync to analyze the work that would be performed if
synchronization was actually run. During this process files and
folders will not be modified. The report file, PreSync.Log, will
be displayed at the end of the run.
Overwrite existing Pre-Sync report files
Enabled by default, this setting overwrites the PreSync.Log file
when the Pre-Sync process completes.
Show Pre-Sync report file at end of run
Enabled by default, this setting will open and display the
PreSync.Log report file after the Pre-Sync process completes.

Reprocess Failed Events This option, when available, will allow for Failed Files to be
processed. Failed Files are files that have failed to be replic-
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ated/synchronized possibly due to Retries being turned off or
exceeded.
Reprocess Failed Scans

This option, when available, will allow for Failed Scans to be
processed. Failed Scans will only occur if a scan is interrupted
or cannot run and the Retry failed connection every x minutes
option is disabled.

Note: Because it is separate from the core software engine, the Profiler allows you to create and configure new
Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on Profiler
screens, "Current" refers to the Profile currently being configured but not yet launched, while "Active" most often
refers to the Profile presently being run by the PeerSync engine.

6. Job Menu
Job
Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has
been checked on this menu, you will be able to select and apply settings to Multiple Jobs.
Add - Job with Defaults

Creates and adds a Job to the current Profile using the saved
Job defaults. This feature is also accessible from the Tool Buttons Toolbar and the Profile Job List Pop-Up Menu.

Copy

Creates a duplicate copy of the currently selected Job and all
of its settings. This feature is also accessible from the Tool
Buttons Toolbar and the Profile Job List Pop-Up Menu.

Rename

Allows for the renaming of the selected Job. This feature is
also accessible from the Tool Buttons Toolbar and the Profile
Job List Pop-Up Menu.

Delete

Allows for the deletion of the currently selected Job(s). This
feature is also accessible from the Tool Buttons Toolbar and
the Profile Job List Pop-Up Menu.

Clear All

This will close the current Profile allowing for the user to create
a new Profile.

Move Up

Moves the currently selected Job up one in the list. This feature is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Move Down

Moves the currently selected Job down one in the list. This feature is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Select All

This will select all of the Jobs.

Invert Selection

This will change the selected state of all the Jobs.

Allow Multiple Selection

Gives the ability to select and apply settings to Multiple Jobs.

Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.

Log File - View

Display the log file for the selected Job.
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Log File - Clear

Clear the log file for the selected Job.

Message Log File - View

Display the message log file for the selected Job or profile.
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Message Log File - Clear Clear the message log file for the selected Job or Profile.
Save Defaults

Stores the currently selected Job Settings as the default for all
subsequent newly added Jobs.

7. Help Menu
Help
While allowing you to access Help files and the About screen, this menu also provides
demonstrations of PeerSync's Real-Time Monitoring and Scheduled Operation modes.
Demos

This option allows the user to instantly run either a Real-Time
or Scheduled test Profile to demonstrate PeerSync's synchronization capabilities.

Web Site

This menu item will have many links back to our web site for
product information, downloads, updates and support.

Online Resources

Provides links to online demos/tutorials/documents and forums.

Check for Updates...

Checks whether you are using the latest version of PeerSync.
This process requires an Internet connection in order to transmit your registration information to our web server for validation. This feature also has the ability to check updates for all
PeerSync related products (if they are installed) directly from
the Profiler. This includes the PSListener, PeerLock, and the
Peer Administrator. A menu option to check for updates will be
displayed for all products that have been installed.

PeerSync Help

Will open the application help file to the contents section. You
may also access specific parts of the help file for features you
are currently observing by pressing 'F1' on your keyboard.

Create Support Info File
on the Desktop...

This option will compile all Profile related files into a zip folder
on the Desktop. This information can be submitted to our support team for analysis. The following is a list of files that are included if they exists:
PeerSync Files:
[ProfileName].snc
PSDEF.CFG
[ProfileName] .tot.xml
[ProfileName]_np .tot.xml
[ProfileName] .cur.xml
[ProfileName]_np .cur.xml
[ProfileName].las.xml
[ProfileName]_np.las.xml
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[ProfileName].snc[.bak*].log
PSError.Log
[JobName].[bak*].log
[JobName].flt[.bak*].log
[JobName].del[.bak*].log
[ProfileName].tlr
[%VariableNames%].txt

ADDCache.cur.txt
ADDCache.las.txt
UPDCache.cur.txt
UPDCache.las.txt
DELCache.cur.txt
DELCache.las.txt
JSCCache.cur.txt
JSCCache.las.txt
EXCCache.cur.txt
EXCCache.las.txt
FFLCache.cur.txt
FFLCache.las.txt
JSHCache.cur.txt
JSHCache.las.txt
MSGCache.cur.txt
MSGCache.las.txt
CTPCache.cur.txt
CTPCache.las.txt
SNCCache.cur.txt
SNCCache.las.txt
MFLCache.cur.txt
MFLCache.las.txt
SupportInfo.txt

- Profile Error Log Files
- Application Error Log File
- Job Level Log Files
- Job Level Error Log Files
- Deletion Cleanup Log Files
- Time Last Run Log File
- Also included are Variable
Data Import and Job Data Import files
- Current cache file of Add
events
- Last cache file of Add events
- Current cache file of Update
events
- Last cache file of Update
events
- Current cache file of Deleted
events
- Last cache file of Deleted
events
- Current cache file of Job
Scans
- Last cache file of Jobs Scans
- Current cache file of Excluded
items
- Last cache file of Excluded
items
- Current cache file of Failed
Events
- Last cache file of Failed
Events
- Current cache file of Historical
Data
- Last cache file of Historical
Data
- Current cache file of Messages
- Last cache file of Messages
- Current cache file of Copy
Thread Progress
- Last cache file of Copy
Thread Progress
- Current cache file for the Profile
- Last cache file for the Profile
- Current cache file of Managed
Files List items
- Last cache file of Managed
Files List items
- Contains the list of files that
PeerSync will try to include in
the support zip folder
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- Configuration File
- PeerLock Log Files

The files will be zipped and stored on the Desktop for easy attachment to e-mails. A copy of the zipped folder will also be
stored in the PeerSync installation folder (i.e. C:\Program Files
\PeerSync\InfoFiles\SupportInfo_ date/tim e.zip).
Create System Info File
on the Desktop...

Creates a system info file (SysInfo.nfo) on the Desktop. A copy
of the file will be kept in the InfoFiles folder located in the PeerSync installation folder (i.e. C:\Program Files\PeerSync\InfoFiles\SystemInfo_200810081953.zip - where 200810081953
represents yyyymmddhhss respectively). Creating the System
Information File takes a few minutes. Keeping a copy of the
System Information file in the InfoFiles folder eliminates the
need to wait for the creation of a new file whenever one is
needed and provides an archive of previous system states that
can be used for troubleshooting.

Register PeerSync

Will display the PeerSync Registration Screen to activate the
PeerSync trial version or upgrade the current license.

License Information

Will display the different Product Editions and Licensing available for PeerSync. Will also display what the current edition
has available as well as other useful information about the current package you are running.

About PeerSync

Will display an about screen, which contains information about
the current PeerSync you are running.

8. Evaluation Menu
Evaluation
Only displayed in evaluation copies of the software, this menu item will contain features
that we believe are helpful to the user during evaluation such as demos, README files,
and other evaluation oriented features.
Read me first...

Opens the Evaluation.txt file that provides instruction on how to
run the built-in Demo, add your first Job, run your first Profile
and steps on how to use Quick-Sync and the Wizard.

Reviewer's Guide

Opens the Reviewer's Guide manual that provides a quick
product overview and useful evaluation scenarios and demonstrations.

Real-Time Monitoring
Demo

Launches a demo that will synchronize the designated source
and target folders automatically upon change in real-time.

Scheduled Operation
Demo

Launches a demo that will synchronize the designated source
and target folders every 15 seconds.

End Demo

Available only if PeerSync is running either the "Real-Time" or
"Scheduled" demo. Selecting this option will terminate the run-
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ning demo.
License Information

Opens the Licensing dialog which lists all the options/features
that are Active or Inactive in the product. The About screen can
be accessed from this dialog by clicking on the Register button.

Buy Now ...

Opens the web browser to our online purchase page from
where the product can be purchased directly.

9. Popup View Menu
View Popup Menu
Activated by right clicking on the Tool Buttons Toolbar, Profile Description Toolbar, or the
Status Bar. Some of these options can be selected from the View Menu.
Tool Buttons

Show/hide the Tool Buttons Toolbar.

Profile Description

Show/hide the Profile Description Toolbar.

with Hot Tracks

Show/hide the hot tracks features for the Toolbars.

with Text Labels

Show/hide description text labels for the Toolbars.

Status Bar

Show/hide the Status Bar at the bottom of the application.

10. Popup Tray Icon Menu
PeerSync Tray Icon Popup Menu
Activated by right clicking on the Tray Icon. The Tray Icon is only accessible when PeerSync is running as an application (not as a service) and has the "Show tray icon" option enabled in the Options/Commands window.
View Log File

Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Message Log File

Allows you to access, launch and view the Message log file for
the current Profile.

View Admin Folder

Allows you to access, launch and view Admin log file Folders
in Explorer for the current Profile.

Open Source Folder

Allows you to access, launch and view Source Folders in Explorer for the current Profile.

Open Target Folder

Allows you to access, launch and view Target Folders in Explorer for the current Profile.

Show Status Display

This item will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status, and
other information while PeerSync is running. This feature is
only available if the Display Status in the PeerSync feature
was enabled for the current Profile.
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Connect/Launch PeerSync Profiler

This item will open the Profiler, if it is not already open, and
send status messages to be displayed on the Run/View Current Profile Activity screen. This connection feature will only
work if the Display Status in Profiler feature was enabled for
the current Profile.

About PeerSync

Will display an about screen, that contains information about
the current PeerSync you are running.

Exit PeerSync

Allows you to close/exit the current session of PeerSync.

Note: A pop-up hint message will be displayed when you mouse over the Tray Icon. This will provide key information about the current PeerSync application running including the Profile name and the status of VSS if it is running.

11. Profile Job List
Located beneath the Toolbars, this window displays all Jobs associated with the current Profile. Use of this list is central to the Profile-building process; all configurations made on the
Job Settings screens (accessed through the Selection Tree) will only be applied to those
Jobs currently selected from this list.
To select a Job, highlight it using the left mouse button. The "Allow Multiple Selection" item
must be checked on the Job Menu in order to select and have settings applied to Multiple
Jobs. To select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on
your keyboard, and then highlight the last Job you wish to include. You can also hold down
the SHIFT key and then use the up or down arrow keys on your keyboard. To select Multiple
Nonadjacent Jobs, highlight the first Job, then hold down the CTRL key on your keyboard
and click on each additional Job you wish to include. Once you have selected a Job or Jobs,
move through the screens found on the Selection Tree and apply settings as desired. Highlighting on the selected Job(s) will appear gray as you move through these screens, indicating that any configured settings will only be applied to those selected Jobs.
The box appearing to the left of each Job must be checked in order for that Job to be included in the active Profile when launched. Although unchecked Jobs will not be processed
upon launch, they will be saved within the Profile for future use and/or selection.
Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job Item
1" by default (this applies to manual Job creation only). The first New Job added within an existing Profile will also bear this name. Successive Jobs will be named "New Job Item 2,"
"New Job Item 3," etc. Any selected Job can be renamed through the "Rename" Tool Button,
through items found on both the Job Menu and Profile Job List Pop-Up Menu described below, or manually by selecting it a second time using the left mouse button.
In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy,
delete, and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by using items found on the Profile Job List Pop-Up Menu described below. You can also navigate
the list and delete items using the DELETE and up and down arrow keys on your keyboard.
Note: In order to navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job List
window; this ensures that during configuration any options chosen from the Selection Tree screens are applied exclusively
to the currently selected Job.

The height of the Profile Job List window can be changed by passing the mouse pointer over
its bottom border until a double/Arrow cursor appears, then dragging the window to meet the
desired size. At minimum size, only a single Job may be viewed. Adding a new Job while this
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view is in effect prompts display of up and down arrow buttons in the right side of the window.
These buttons allow you to view different Jobs within the list.

Job List Pop-Up Menu
Activated by right clicking on the Profile Job List, this menu duplicates the mostly used features found on the Job Menu while providing some additional items listed below.
Synchronize Selected
Jobs

This executes an immediate, non-persistent synchronization of
the currently selected Jobs ("non-persistent" refers to a onetime sync process; "persistent" refers to ongoing sync operations such as Real-Time Monitoring or Scheduled Operations).
During this process, persistent arguments set for the current
Profile will be ignored. When the button is released, a confirmation dialog will be displayed indicating which Jobs have been
selected from the active Profile and asking you to confirm synchronization through a "Yes" or "No" button. If "Yes" is selected, the synchronization will proceed. A message will always
be displayed upon completion of this operation. Other sync operations allow you to choose whether or not such a message
will be displayed.

Create Pre-Sync Report

This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A report will be created and displayed with the work that would
be performed if a synchronization was actually run. This feature may be quite helpful during evaluation and when running
and testing a newly modified Profile.

Connect: Enable Job
Control Mode

See description for this option under Tool Buttons.

Disconnect: Enable Configuration Mode

See description for this option under Tool Buttons.

Start Pending Job: N am e See description for this option under Job Control Mode. This
option is only available when the Job List Display is in Control
Mode.
Start Pending Job: x

See description for this option under Job Control Mode. This
option is only available when the Job List Display is in Control
Mode.

Log File - View

This menu item allows you to view Log reports by opening the
file in a text editor. This feature is also accessible from the Reporting screen.

Log File - Clear

This menu item allows you to clear Log reports. This feature is
also accessible from the Reporting screen.

Message Log File - View

This menu item allows you to view Message Log reports by
opening the file in a text editor. This feature is also accessible
from the View Menu item.

Message Log File - Clear This menu item allows you to clear Message Log reports. This
feature is also accessible from the View Menu item.
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Job List View Options

This feature enables/disables the ability to display the "Click
Here to Add Another Job" Job every time a new Job has been
created.

Use "<Click Here to Add
Another Job>" Feature

This menu item will add a new Job to the end of the Job list
named "<Click Here to Add Another Job>" every time a new
Job is created.

Suppress Add Job Confirm Dialog

This menu item will suppress the Confirmation Dialog that is
launched when clicking on the "<Click Her to Add Another
Job>" Job.

View Job Groups* (Enhanced Package)

This feature enables/disables the ability to allow the user to organize/categorize Jobs within a Profile into Job Groups.
When this feature is enabled, you can create as many Job
Groups as desired. Each Job Group is represented by a Tab.
Each Tab displays the Job Group Name, the number of
Checked Jobs and the number of Total Jobs for the corresponding Job Group, in the following format: GROUP NAME
[CHECKED JOBS / TOTAL JOBS]

Select All

This menu item will select/highlight all Jobs within the current
Job Group for a quick and easy way of modifying all Jobs
within a given Profile. If this feature is not enabled you must
turn on the Allow Multiple Selection feature on from the Job
Menu.

Last Run On

This is a display of the last run date/time of the selected Job
within the current Profile. This is the date/time that will be used
when comparing files for the Bi-directional Synchronization
Mode option on the File Options screen. This feature is also
displayed on the from the Folder Selection screen.

Last Run On - Reset

This allows a means of resetting the last run date/time of the
selected Job within the current Profile.

Job Group Pop-Up Menu* (Enhanced Package)
Activated by right clicking on the Profile Job List, this Popup menu allows for the following
features:
Add Job Group

This menu item will create and add a new Job Group to the existing Profile.

Edit or Delete Job
Groups

These menu items will display the Modify Job Groups Dialog,
allowing for the adding, renaming, moving, re-ordering, modifying and/or the deletion of Job Groups.

Edit Job Groups Dialog

To add a Job Group click "New," then type the desired name
into the field located at the bottom of the dialog. Repeat this
process for each Job Group you wish to add. Entries can be
deleted by selecting them from the list and clicking the "Delete"
key at the bottom of the box. You can also use the "Up" and
"Down" buttons to reorder the items.
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All Tabs - Check All Jobs This menu item will set all Jobs to the checked state allowing
for a quick and easy way of checking all Jobs across all Job
Groups.
All Tabs - Uncheck All
Jobs

This menu item will set all Jobs to the unchecked state allowing for a quick and easy way of unchecking all Jobs across all
Job Groups.

* Note: Some features described on this page require the Enhanced Package.

Selection Tree

Screens can be accessed through the Selection Tree that are used to set synchronization criteria for individual Jobs (Job Settings), as well as set global properties relating to execution
of the entire Profile and all related Jobs (Global Settings). Once you have selected a Job or
Jobs from the Profile Job List , all options configured on Job Settings screens will only be applied to those selections. After synchronization criteria for all individual Jobs have been established, use the Global Settings screens to set global properties relating to all Jobs, as well
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as choosing how you would like the Profile to be executed. The Profile Job List will appear
gray when any Global Settings screen is displayed, indicating that all properties set on that
screen will be applied to the entire Profile.

<%SELECTION%>
The Selection Tree is located at the left side of the Profiler interface. The Selection Tree
can also be hidden by unchecking the "Selection Tree" option, accessed through the "Toolbars" item on the View Menu.
Selection Tree Modes

The Selection Tree Modes are located in a drop-down list
above the Selection Tree. These modes can be used to show/
hide PeerSync configuration windows. The Selection Tree can
be set to Basic, Intermediate, Advanced or Customized. Some
Selection Tree items will not be accessible depending on the
package you are currently using. "Basic" is the default Selection Tree Mode.

Selection Tree Categories

New in PeerSync v7.4, customers who are running PeerLock
v2.0.1 or higher on the same machine as PeerSync will now be
able to configure PeerLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific PeerSync Profile Jobs to PeerLock, ability to access/view/edit the
PeerLock Global Settings from the PeerSync Profiler, ability to
install/uninstall the PeerLock Service, as well as launch and
view PeerLock directly from the PeerSync Profiler.
The Selection Tree can be categorized into four sections:
PeerSync, PeerLock, Startup/Service, and Run/View. By default these categories will not be shown unless you have PeerLock v2.0.1 or newer installed on the same computer as PeerSync. You can manually display these categories by adding
PeerLock windows to the Customized tree mode.

Selection Tree Pop-Up Menu
Activated by right clicking on the Selection Tree, this menu duplicates the items listed in
the Selection Tree, as well as, the items listed in the drop-down list located on the right
side of the Back button on the Tool Buttons Toolbar. When right-clicking on the PeerSync
Selection Tree Category, this Menu offers the following options:
Show All Profile Options

This feature will toggle between showing all Profile Options
and the Custom Options in the Selection Tree.

Customize

This feature will allow the user to select which Profile Options
to display in the Custom Selection Tree, when the "Show All
Profile Options" is turned off. When selected the user will be
given the dialog box shown below to pick and choose which
Profile Options to use.

Selection Tree Categories
PeerSync
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PeerLock
Startup/Service
Run/View
1. PeerSync
1.1 PeerSync Job Settings

PeerSync Job Settings Screens
Folder Selection
Automation
Blackout Settings
Scan Limitations
File Options
Open Files
Managed Files
Byte Replicator
Revisioning
Miscellaneous
Additional Features
Exceptions
Reporting
Admin Reporting
E-mail Reporting
Compression
Pre/Post Process
Note: Some settings are ignored when enabled in conjunction with other settings. For example, report summaries
are ignored in multiple threaded or enhanced Real-Time mode.
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1.1.1 Job List Display

Topics
Configuration Mode
Job Control Mode
Note: The Job List Display is the area within the Profiler listing all the Jobs and visually categorizing them based on
various modes.

The Job List Display is the area within the Profiler listing all the Jobs and visually categorizing them based on various modes for improved Job review.
Configuration Mode
This is the default mode used by the Profiler. Here, each Job is categorized into one of the
following states:
Enabled

All the Jobs which have a checked check box will be listed in
this category.

Disabled

All the Jobs which have an un-checked check box will be listed
in this category.

The Job List Display is the area within the Profiler listing all the Jobs and visually categorizing them based on various modes for improved Job review.
The Profiler supports Job Control functionality that allows every Job to be stopped, started,
or restarted individually. To enter the Job Control mode, right click in the Job List Display
and select Connect: Enable Job Control Mode from the Profile Job List pop-up menu.
Job Control Mode
Active

This category lists Jobs which are running successfully without
any errors.

Active w/Errors

This category lists Jobs which are running but contain errors
typically indicating connectivity issues.
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Active w/Warnings

This category lists Jobs which are running but contain errors
typically indicating Failing Events.

Inactive

Lists Jobs that were disabled or were newly added and the
Profiler does not yet know information about them. As soon as
the Profile is saved, newly added Jobs will be added to the
Pending state.

Pending

Lists Jobs that were enabled or were newly added to the running Profile but have not yet been started.

Stopped

This category lists Jobs which have been stopped since the
Profile has been started.

Job Control Bar
The Job Control Bar buttons allows every Job to be stopped, started, or restarted individually.
Start Pending Jobs:x

Start all the Jobs that are in a Pending state where x represents the total number of Jobs that are in a Pending state.

Start Job

Start the selected Job that is in a Sopped state.

Stop/Restart Job

Stop or restart the selected Jobs that are in an Active state.

Save Profile and Refresh When Job changes are made to the running Profile, a Save
Profile and Refresh option can be seen at the bottom right
corner of the Job List Display. Saving will refresh the Job List
Display to reflect any changes. The Job Control Bar buttons
become disabled and grayed out to indicate that Profile
changes were made which require saving.
Configuration Mode Columns
The following columns can be viewed when in Configuration or Control Mode:
Source

Displays the source paths of the listed Jobs.

Target

Displays the target paths of the listed Jobs.

Group

Lists the name of the group each Job belongs to.

State

Identifies the State each Job belongs to.

Modified

Displays the time and date the last time a Job was modified.
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1.1.2 Folder Selection

Topics
Folder Selection Overview
Source Folder Selection
Target Folder Selection
Include Sub-folders
Swap Source and Target Folders
Last Run On
Other Features
Note: Features listed on this page may require the TCP WAN Connector and/or File Transfer Protocol (FTP) options.

Each Job within a Profile is initially defined by using the Folder Selection screen to select a
Source and Target Folder. The contents of a Source Folder will be synchronized to a Target
Folder according to criteria further defined on other Settings screens. Once you have highlighted a Job or Jobs from the Profile Job List, this screen offers several different methods to
locate and select folders for synchronization. File paths can be typed manually, or you can
browse local and network drives to locate and select your desired folders.

Source Folder Selection
The options listed on this page can be accessed from the Folder Selection window. The following options are available for selecting a Source folder.
Using Normal Mode

Select a "Normal" Source folder if you can navigate to the desired Source directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
Source directory. In some instances Network Logon may be re-
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quired.
Select a Source Folder by typing the file path into the field
provided or by using the Select Source Folder Button. By default, the Source Folder field will contain the path in which
PeerSync has been installed: in most cases this will be C:\Program Files\PeerSync\Source. The convention outlined in this
path must be used when manually typing entries, (i.e. a drive
must be specified followed by a colon, with subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.
UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder" dialog box (see Select Source Folder Button). UNC names will appear in the form \\COMPUTER\SHAREDDEVICE\PATH. For
example: \\SERVER11\D\USERDATA.
Starting with the release of v9.0, we now support the ability to
connect to a remote NetApp filer and register for real-time
event notification. Please visit http://www.peersoftware.com or
contact Sales for license information.
Note: We do not recommend using UNC paths for folders that reside on the
local machine, in this scenario you should use the local path to that folder.

Folders can also be dragged and dropped from MS Windows
Explorer into the Source Folder Field for automatic insertion.
The Source Folder Field holds a folder selection History of up
to 10 entries. They can be selected by clicking on the drop
down button located to the right of the field.
The current path will be displayed below the Source Folder
Selection Field. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the default
PeerSync installation path C:\Program Files\PeerSync\Source
instead.
The Host Name and User Name & Password values (if
provided) are displayed above the Source Folder Selection
field (see Network Logon).
Using TCP Mode

Select a "TCP" Source folder if the Source directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be installed and running on the remote Source machine in order for
PeerSync to be able to communicate with it. This feature supports encryption and compression.
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Note: We strongly recommend the use of a VPN when transferring files over
the public Internet for security purposes. Otherwise, you should use our Encryption feature with a user name and password to protect data and all communication as it is being transferred.

When selecting the TCP Mode for the first time the Source
TCP/Port Configuration window will open automatically for
Source Folder configuration. Otherwise, the previously entered
TCP folder path will be displayed. This path can be manually
edited by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Source IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.
The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.
The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the last
valid TCP path specified or the default path TCP:\\127.0.0.1\C
\Source. 127.0.0.1 represents the loopback IP address of the
local host (i.e. the machine on which PeerSync is running).
The provided Host Name and User Name & Password values
are displayed above the Source Folder Selection field.
Using FTP Mode

Select an "FTP" Source Folder to automatically logon to a
Source FTP server. This feature supports proxy servers/firewalls and has an option to adjust for GMT time on the FTP
server side.
When selecting the FTP Mode for the first time the Source FTP
Logon Configuration window will open automatically for Source
Folder configuration. Otherwise, the previously entered FTP
folder path will be displayed. This path can be manually edited
by typing directly into the field provided or by using the Configuration button. The convention outlined in this path must be
used when manually typing entries, (i.e. the key word FTP
must be specified followed by a colon, two forward slashes, the
Source IP address or machine name, and subsequent folders
separated by forward slashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.
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The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.
The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the last
valid FTP path specified.
The provided Host Name and User Name & Password values
are displayed above the Source Folder Selection field.

Related Options
Source Folder Configuration Button
Select Source Folder Button
Explore/Open/Create Button
Source Folder Popup Menu
Notes:
1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.
3. You cannot monitor a TCP, FTP or any other remote folder/device in Real-Time.
4. Compression, Bi-directional synchronization mode, File Recovery, Exclude empty Source Folders, Turn file
archive attribute off after synchronization and CRC32, as well as other non applicable features are ignored when
using an FTP Source.
5. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored when using a TCP Source.
6. Selecting an FTP Source and a FTP Target for the same Job is not recommended/supported.
7. Selecting a TCP Source and a TCP Target for the same Job is not supported.
8. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the synchronization process (Source or Target).

Source Folder Configuration: Using Normal Mode
The Source folder configure button is activated by clicking on the Configure button located in
right lower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source Folder Configuration window. Alternatively, you may right-click on the Source
Folder field and select Configure: Source Folder (See Source Folder Popup Menu). This window allows for network logon Name and Password information for a remote Source connection.
Detection Method - Global
Detection Method for
Real-Time Monitoring

Choose the desired detection method for the Source folder.
You may choose from the following options:
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Normal (de- Select this option to specify a local or remote drive
fault)
which resides on the network (LAN, WAN, or
VPN). This is the recommended detection method
for most scenarios. Close the Source Folder Configuration dialog once you have selected your desired source folder detection mode and enter the
path to the source folder in the Folder Selection
screen (i.e. D:\Path\Folder).
Note: PeerSync must reside on the source system in order to
enable Normal real-time detection.

NetApp
Select this option to specify the path to a 7-Mode
FPolicy 7- NetApp filer for either real-time or scanning scenMode
arios. Close the Source Folder Configuration dialog once you have selected your desired source
folder detection mode and enter the path to the
source folder in the Folder Selection screen (i.e. \
\NetAppFiler\Share\Folder).
Note: This option can only be activated if the license supports
NetApp detection. Please visit http://www.peersoftware.com or
contact Sales for additional information.

NetApp
FPolicy
cDOT

Select this option to specify the path to a cDOT
NetApp filer for either real-time or scanning scenarios. Close the Source Folder Configuration dialog once you have selected your desired source
folder detection mode and enter the path to the
source folder in the Folder Selection screen (i.e. \
\NetAppFiler\Share\Folder).
Note: This option can only be activated if the license supports
NetApp detection. Please visit http://www.peersoftware.com or
contact Sales for additional information.

Detection Method Options

Exclude
Users

When selecting NetApp fPolicy 7-Mode or NetApp
FPolicy cDOT as the source detection mode, you
have the option to filter/exclude real-time activity
from a list of specific users. Real-time events from
the users in this field will be excluded. Enter the
desired user names in a semi collon delimited
format (i.e. user1;user2;user3).

Allow for
remote
real-time
configuration

This option indicates whether or not the selected
source folder detection method supports real-time
detection for remote paths. Presently, this feature
is only supported for NetApp fPolicy Mode or
Netapp FPolicy cDOT detection modes.

Connection Manager - Global
The Connection Manager tracks and determines if connections are lost to source and/or
target folders. With this new capability PeerSync can proactively detect when a connection
is lost or reconnected, giving the ability to restart real-time and/or scan Jobs if needed.
Automatically use re-

Check this option if you wish to let the Connection Manger
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commended settings
based on Detection
Method (Default)

track the connection status on both the source and target locations. When a lost connection is restored, PeerSync will restart
real-time and/or scan Jobs if the option to "Scan Job once at
start" is enabled. In addition, this logic will apply to only connections which are set for real-time monitoring.

Connection Manger for
Failed Connections

Choose one of the following options to manually disable or enable the Connection Manger which tracks
the connection status on the desired locations.
Disabled
Disable the Connection Manager
Enabled for Source Connections Only
Enable the Connection Manger to track the connection status
only on the source location.
Enabled for Target Connections Only
Enable the Connection Manger to track the connection status
only on the target location.
Enabled for Source and Target Connections
Enable the Connection Manger to track the connection status
on both the source and target locations.

Connection Manager Options

Only include connections that are set for real-time monitoring
Set the Connection Manager to monitor only connections that
are set for real-time detection.
Scan real-time Jobs on reconnect if "Scan Job once at
start" is enabled
Set the Connection Manager to scan real-time Jobs on reconnect if the Scan Job once at start option is enabled.

NetApp FPolicy Settings
Edit or maintain default NetApp settings when selecting NetApp FPolicy cDOT as the detection method. These options are only applicable when using the NetApp FPolicy 7Mode or NetApp FPolicy cDOT detection method.
Automatically detect and
use recommended
NetApp configuration

When using the NetApp FPolicy 7-Mode or NetApp FPolicy
cDOT detection method, checking this option will automatically
populate the required NetApp settings with the defaults.
Uncheck this option if you wish to manually edit these settings.

NetApp Settings

Host Server Edit the host name or IP address of the NetApp
Name
filer.
Root Path Edit the local path of the NetApp share you wish to
Prefix
monitor.
fPolicy
Named

Edit the fPolicy name that is used to register for
event notification on the filer. By default PeerSync
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uses PEERSYNC_COMPUTERNAME, where
COMPUTERNAME is the name of the host where
PeerSync is running. PeerSync will create the
fPolicy name at the start of the Job.
Delete
By default PeerSync will remove/delete the fPolicy
fPolicy on name it used to register for event notification when
Close
the Job is stopped. Disable this option if you do
not want PeerSync to delete the fPolidy name
when the Job is stopped.
FPolicy Options - Global

cDOT
Detection

Check this option when using NetApp FPolicy
cDOT detection method.

Asynchron- If enabled, PeerSync will not wait for a response
ous Mode from the FPolicy server, which enhances overall
performance. To enable Asynchronous Mode via
the command line argument use /Q74Y. This option is enabled by default for both NetApp detection methods (7Mode and cDOT) and cannot be
disable when using cDOT detection mode.

NetApp FPolicy Additional Settings - Global

Exclude
Volumes

If enabled, provides the ability to exclude entire
volumes from scans and real-time detection,
which enhances overall performance. If unchecked, the interface will change to provide the
ability to include specific volumes in the “Include
Volumes” field.

Exclude
Volumes

Provide a list of comma (,) delimited volumes to
exclude when using NetApp FPolicy detection during scans or in real-time. Here is an example of
excluding volumes vol3 and vol4: vol3,vol4. To exclude volumes via the command line use /Q7-s,
where s represents the comma (,) delimited list of
volumes to exclude (i.e. /Q7-vol3,vol4).

Include
Volumes

Provide a list of comma (,) delimited volumes to include when using NetApp FPolicy detection during
scans or in real-time. This field is visible only if the
“Exclude Volumes” check box is un-checked.
Here is an example of including volumes vol1 and
vol2: vol1,vol2. To include volumes via the command line use /Q7+s, where s represents the
comma (,) delimited list of volumes to include
(i.e. /Q7+vol1,vol2).

Exclude Ex-Provide a list of comma (,) delimited file extentensions
sions to exclude when using NetApp FPolicy detection during scans or in real-time. To exclude extensions via the command line use /Q70:s, where
s represents the comma (,) delimited list of extensions to exclude (i.e. /Q70:tmp,dwl,dwl2). Use %
AUTO% for PeerSync to build a list of file extensions dynamically. To use the %AUTO% option
via the command line use /Q70. This is the equiCopyright © 1993-2014 Peer Software Inc. All Rights Reserved
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valent of using the /QR argument for FPolicy only.
NetApp FPolicy cDOT Settings
Edit or maintain default NetApp settings when selecting NetApp FPolicy cDOT as the detection method. These options are only applicable when using the NetApp FPolicy cDOT
detection method.
NetApp FPolicy cDOT
SVM Logon Settings

Username Provide the user name for the account that will be
used to run the API calls against the vServer.
Password Provide the password for the account that will be
used to run the API calls against the vServer.

NetApp FPolicy cDOT
Additional Settings

cDOT Options - Global

Management IP

Optionally, specify the IP address for system
where the Management node is on a separate IP
from the IP used to access the shares.

Include
Shares

Provide a list of alternate shares to register for. Alternate shares are automatically discovered and
registered for by default. This can be disabled by
unchecking the Disable Alternate Share Lookup
option. For example, use this in cases where the
alternate share points to the root level and should
not be included.

Primary
Server

This is an optional list of semi colon (;) delimited
IP addresses of the system(s) where the FPolicy
server is running (i.e. the system where PeerSync
is running). Events generated on the SVM from
this IP will be automatically filtered unless the
"Disable IP Filtering" option is used. Therefore it is
important to note that in order for real-time detection to work, all changes must be made from different systems and not the system where PeerSync
is running.

Asynchron- Enabled by default, PeerSync will not wait for a reous Mode sponse from the FPolicy server, which enhances
overall performance. Currently, this setting must
always be enabled.
Disable Alternate
Share
Lookup

Get Info

Alternate shares are automatically discovered and
registered for by default. This can be disabled by
unchecking the Disable Alternate Share Lookup
option. For example, use this in cases where the
alternate share points to the root level and should
not be included.

Click this button to display a short description about the source
NetApp host PeerSync is connecting to.

Network Logon Settings
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Provides the ability to connect to a source folder that may require a different account then
the on PeerSync is running under.
Network Logon Settings Connect As Provide the user name to allow PeerSync connection to the source directory that is not accessible
using the current service or logged on account. Be
sure to include the domain name if applicable (i.e.
MyDomain\UserName).
Password Enter the password information for login.
Source TCP/Port Configuration
The Source Folder Configure Button is activated by clicking on the Configure button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button
opens the Source TCP/Port Configuration window. Alternatively, you may right-click on the
Source Folder field and select Configure: Source Folder (See Source Folder Popup Menu).
TCP Configuration Tab
This tab provides a guided method for entering the Source TCP path.
Host Name

Enter the IP address or machine name of the Source Folder
into this filed. You may use the machine name only if the remote Source Machine resides on the same network as that on
which PeerSync is running.

Path to Host

Provide the full path (i.e. C:\Documents and Settings\Source)
to the Source folder in this field. The path entered needs to be
a local path without a machine name or UNC format. This field
does not validate the existence of the path you provide therefore you must exercise great care when doing so. If the path
does not exist, PeerSync will create it during run time as long
as a valid host name or IP address has been provided and it
can find the drive letter specified.
A UNC path can be entered for the Path on Host selection for
a TCP source or TCP target. This gives the ability to configure non-windows to non-windows Jobs over TCP (i.e. NetApp
to NetApp over TCP). Note: This will make use of a new
NETWORK constant in the source or target selection.
Example:
TCP:\\WindowsServer\NETWORK\\NetAppSVM
\vol1\Data
Care must be exercised if your PSListener contains a "Root
Path". If you specify such a path in your PSListener it will behave like an FTP server that sets Root Paths to limit user access to the local file system. If a "Root Path" exists on the
PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access directories equal to or bellow the specified "Root Path" level
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provided that it meets the Port and Encryption requirements. In
no circumstances can PeerSync access directories located
above this path. If the remote path you enter in the Path to
Host field references a directory above the "Root Path", PeerSync will create that folder structure at runtime bellow the
"Root Path".
Example:
PSListener "Root Path"
PeerSync's "Path to Host"
Actual Remote Source Path

= C:\Backup\Users\Admin
= C:\Backup\My Documents
=
C:\Backup\Users\Admin\C
\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication
using Normal Mode (i.e. Local or UNC paths).

Port Configuration Tab
This tab provides settings to be used by both the Source and Target connections when using TCP and/or Byte Replicator.
Time Out

Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure operation.

Port

This is the TCP Port used to communicate with the Listener on
the remote machine. This must match the port number that the
PSListener is configured for. By default both Listener and
PeerSync use port 7333.
Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Compression

Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance.

User Information

This is an optional setting that allows you to specify a User
Name and Password to be used for encryption as well as authentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication,
you must specify both a User Name and a Password value.
Strong DES encryption will be used to encrypt the data and
communication as it is being transmitted over the Internet,
LAN, WAN, or VPN.
The User Name and Password entries can be arbitrarily
chosen and are not required to be valid. However, once specified, you must enter the same User Name and Password
entries in the PSListener Configuration residing on the remote
location.
If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur.
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Source FTP Logon Configuration
The Source Folder Configure Button is activated by clicking on the Configure button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button
opens the Source FTP Configuration window. Alternatively, you may right-click on the
Source Folder field and select Configure: Source Folder (See Source Folder Popup Menu).
FTP Configuration Tab
Provides a guided method for entering the Source FTP path as well as connection authentication.
Host Name

Enter the IP address or machine name of the Source folder into
this filed. You may use the machine name only if the FTP
Source machine resides on the same network as that on which
PeerSync is running.

Path to Host

Provide the full path to the Source folder in this field (i.e. /FTProot/My Data/Source). Make sure the path begins at the base
directory to which the FTP server allows connection. The path
does not need to be preceded by the key phrase 'FTP' however
it must start with a forward slash ( / ). This field does not validate the existence of the path you provide therefore you must
exercise great care when doing so. If the path does exist, PeerSync will create it during run time as long as a valid host name
or IP address has been provided.

User Name

Stores the Source FTP User Name information for login.

Password

Stores the Source FTP Password information for login.

FTP Settings Tab
Provides configuration for the FTP Source Selection.
Enable Passive Mode

Sets the FTP mode to passive. The phrase passive refers to
the FTP server which passively accepts connections and data
while the client initiates both the control connection and the
data connection to random ports specified by the server.
Passive mode is enabled by default.

Host is using GMT

Option to adjust for GMT time on the FTP server side.

Time Out (seconds)

Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure operation.

Port

Port number used to initiate an FTP session or "command"
connection to the FTP server. Uses standard port 21 by default.

Use Proxy - Firewall

This option allows you to specify the Host Name, User ID,
Password, and Port number to a network Proxy - Firewall.

File types to transfer as
ASCII

Through this field, file types can be selectively tagged for transfer as ASCII upon synchronization. File types can be typed
manually, or can be specified using either the "Files to Trans-
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fer as ASCII Button" or the drop-down list located to the right of
the field. The drop-down list located to the right of this field will
be dynamically populated with file types as they are set
through the dialog box described above. They are also added
to the list when you exit the field after manually editing the file
types field. File types can then be specified by selecting them
from this list. This provides a way to store and/or retrieve sets
of file types for later use with other Jobs.
Alternatively, clicking on the "Files to Transfer as ASCII Button" to the right of this field opens a dialog box into which file
types may be entered. To add a File Type click "New," then
type the desired file type into the field located at the bottom of
the dialog. These file types are set by specifying file extensions (i.e. ".txt") which, if found within a file name, will be transferred as an ASCII file during synchronization. Multiple strings
will be semicolon delimited. These settings are not case sensitive, (i.e. "A" = "a"). Repeat this process for each File type. Entries can be deleted by selecting them from the list and clicking
the "Delete" key at the bottom of the box. Once you have finished, click the "OK" button. The box will close and all of the
file types you have specified will automatically appear in the
Files to transfer as ASCII field.

Notes:
1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.

Located to the right of the Source Folder Selection Field, this button opens a "Browse for
Folder" dialog box. Once this box has opened, locate your chosen Source folder, select it using the left mouse button, and click "OK."
Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Explore/Open/Create Source Button
This button provides three options to be selected from the attached drop-down list. The button label will change to reflect whichever item has been checked on this list.
Explore

When "Explore" has been selected and the button is depressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Source Field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it. You may do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created folder will be shown in the Explorer-type window.

Open

When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
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contents of whichever folder is currently shown in the Source
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it. You may do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the navigation window.
Create

When "Create" has been selected and the button is depressed, a "Select Directory" dialog will open allowing you to
specify a Source Folder path by using the mouse to select a
desired drive, directory, and folder. Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hit the ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Source Folder Popup Menu: Using Normal Mode
The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first four features allow the user to Browse for Source Folder, Explore, Open and/or
Create the Source Folder selection.
Configure: Source Folder Selecting this option displays the Source Network Logon Settings window. This allows the user to specify Network Logon
credentials for the Source Folder which enables connection to
directories that are not accessible with the current logged on
account.
Edit: Source Variable
File

This will allow the user to view/edit Variable Data Import and/
or Job Data Import files that are used in the Source Folder selection. This option is only available if using Job data import
files.

Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.

Source Folder Popup Menu: Using TCP Mode
The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first two features allow the user to Explore and Open the Source Folder selection.
Configure: Source Folder Selecting this option displays the Source TCP/Port Configuration window. This window provides a guided method for entering the Source TCP path as well as TCP and/or Byte Replicator settings (see TCP Configuration).
Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.
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Notes:
1. The TCP features listed above require the TCP WAN Connector option. Please visit http://www.peersoftware.com
or contact Sales for additional information.
2. The Browse for Source Folder and Create options are not available when using TCP Source Mode.

Source Folder Popup Menu: Using FTP Mode
The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first feature allows the user to Open the Source Folder selection.
Configure: Source Folder Selecting this option displays the Source TCP/Port Configuration window. This window provides a guided method for entering the Source TCP path as well as TCP and/or Byte Replicator settings (see TCP Configuration).
Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.

Notes:
1. The FTP features listed above require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. The Browse for Source Folder, Explore, and Create options are not available when using FTP Source Mode.

Target Folder Selection
The options listed on this page can be accessed from the Folder Selection window. The following options are available for selecting a Target folder.
Using Normal Mode

Select a "Normal" Target folder if you can navigate to the desired Target directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired Target directory. In some instances Network Logon may be required.
Select a Target Folder by typing the file path into the field
provided or by using the Select Target Folder Button. By default, the Target Folder field will contain the path in which PeerSync has been installed: in most cases this will be C:\Program
Files\PeerSync\Target. The convention outlined in this path
must be used when manually typing entries, (i.e. a drive must
be specified followed by a colon, with subsequent folders separated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are part of valid folder
names (i.e. "Program Files"). No space should appear between
slashes and folder names. This field also supports File/Folder
Path Variables.
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UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder" dialog box (see Select Target Folder Button). UNC names will appear in the form \\COMPUTER\SHAREDDEVICE\PATH. For
example: \\SERVER11\D\USERDATA
Note: We do not recommend using UNC paths for folders that
reside on the local machine, in this scenario you should use
the local path to that folder.
Folders can also be dragged and dropped from MS Windows
Explorer into the Target Folder Field for automatic insertion.
The Target Folder Field holds a folder selection History of
more then 10 entries. They can be selected by clicking on the
drop down button located to the right of the field.
The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the default
PeerSync installation path C:\Program Files\PeerSync\Target
instead.
The Host Name and User Name & Password values (if
provided) are displayed above the Target Folder Selection field
(see Network Logon).
Using TCP Mode

Select a "TCP" Target folder if the Target directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be installed and running on the remote Target machine in order for
PeerSync to be able to communicate with it. This feature supports encryption and compression.
Note: We strongly recommend the use of a VPN when transferring files over
the public Internet for security purposes. Otherwise, you should use our Encryption feature with a user name and password to protect data and all communication as it is being transferred.

When selecting the TCP Mode for the first time the Target
TCP/Port Configuration window will open automatically for Target Folder configuration. Otherwise, the previously entered
TCP folder path will be displayed. This path can be manually
edited by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Target IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.
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The Target Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.
The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the last
valid TCP path specified or the default path TCP:\\127.0.0.1\C
\Target. 127.0.0.1 represents the loopback IP address of the
local host (i.e. the machine on which PeerSync is running).
The provided Host Name and User Name & Password values
are displayed above the Target Folder Selection field (see
Configuration Button).
Using FTP Mode

Select an "FTP" Target folder to automatically logon to a Target FTP server. This feature supports proxy servers/firewalls
and has an option to adjust for GMT time on the FTP server
side.
When selecting the FTP Mode for the first time the Target FTP
Logon Configuration window will open automatically for Target
Folder configuration. Otherwise, the previously entered FTP
folder path will be displayed. This path can be manually edited
by typing directly into the field provided or by using the Configuration button. The convention outlined in this path must be
used when manually typing entries, (i.e. the key word FTP
must be specified followed by a colon, two forward slashes, the
Target IP address or machine name, and subsequent folders
separated by forward slashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should appear between slashes and folder names. This field also supports File/Folder Path Variables.
The Target Folder Field holds a folder selection History of up
to 10 entries. They can be accessed by clicking on the drop
down button located to the right of the field.
The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to correct the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the last
valid FTP path specified.
The provided Host Name and User Name & Password values
are displayed above the Target Folder Selection field (see
Configuration Button).

Related Options
Target Folder Configuration Button
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Select Target Folder Button
Explore/Open/Create Button
Target Folder Popup Menu
Alternate Target Path Selection
Notes:
1. TCP (i.e.TCP WAN Connector Option) and FTP are optional modes which may not be included in your package.
Please visit http://www.peersoftware.com or contact Sales for additional information.
2. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored when using a TCP Target.
3. Selecting an FTP Source and a FTP Target for the same Job is not recommended/supported.
4. Selecting a TCP Source and a TCP Target for the same Job is not supported.
5. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the synchronization process (Source or Target).

Using Normal Mode
The Target Folder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure button opens the Target Network Logon Settings window. Alternatively, you may right-click on
the Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu).
This window allows for network logon Name and Password information for a remote Target
connection.

Using TCP Mode
The Target Folder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure button opens the Target TCP/Port Configuration window. Alternatively, you may right-click on
the Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu).

TCP Configuration Tab
This window provides a guided method for entering the Target TCP path.
Host Name

Enter the IP address or machine name of the Target folder into
this filed. You may use the machine name only if the remote
Target machine resides on the same network as that on which
PeerSync is running.

Path to Host

Provide the full path (i.e. C:\Documents and Settings\Target) to
the Target folder in this field. The path entered needs to be a
local path without a machine name or UNC format. This field
does not validate the existence of the path you provide therefore you must exercise great care when doing so. If the path
does exist, PeerSync will create it during run time as long as a
valid host name or IP address has been provided and it can
find the drive letter specified.
A UNC path can be entered for the Path on Host selection for
a TCP source or TCP target. This gives the ability to config-

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

51

PeerSync Help

ure non-windows to non-windows Jobs over TCP (i.e. NetApp
to NetApp over TCP). Note: This will make use of a new
NETWORK constant in the source or target selection.
Example:
TCP:\\WindowsServer\NETWORK\\NetAppSVM
\vol1\Data
Care must be exercised if your PSListener contains a "Root
Path". If you specify such a path in your PSListener it will behave like an FTP server that sets Root Paths to limit user access to the local file system. If a "Root Path" exists on the
PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access directories equal to or bellow the specified "Root Path" level
provided that it meets the Port and Encryption requirements. In
no circumstances can PeerSync access directories located
above this path. If the remote path you enter in the Path to
Host field references a directory above the "Root Path", PeerSync will create that folder structure at runtime bellow the
"Root Path".
Example:
PSListener "Root Path"
PeerSync's "Path to Host"
Actual Remote Target Path

= C:\Backup\Users\Admin
= C:\Backup\My Documents
=
C:\Backup\Users\Admin\C
\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication
using Normal Mode (i.e. Local or UNC paths).

Port Configuration Tab
Provides settings to be used by both the Source and Target connections when using TCP
and/or Byte Replicator.
Time Out

Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure operation.

Port

This is the TCP Port used to communicate with the Listener on
the remote machine. This must match the port number that the
PSListener is configured for. By default both Listener and
PeerSync use port 7333.
Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Compression

Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance.

User Information

This is an optional setting that allows you to specify a User
Name and Password to be used for encryption as well as authentication purposes when connecting to the remote
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

52

PSListener. In order to activate encryption or authentication,
you must specify both a User Name and a Password value.
Strong DES encryption will be used to encrypt the data and
communication as it is being transmitted over the Internet,
LAN, WAN, or VPN.
The User Name and Password entries can be arbitrarily
chosen and are not required to be valid. However, once specified, you must enter the same User Name and Password
entries in the PSListener Configuration residing on the remote
location.
If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur.

Using FTP Mode
The Target Folder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure button opens the Target FTP Configuration window. Alternatively, you may right-click on the
Target Folder field and select Configure: Target Folder (See Target Folder Popup Menu).
FTP Configuration Tab
Provides a guided method for entering the Target FTP path as well as connection authentication.
Host Name

Enter the IP address or machine name of the Target folder into
this filed. You may use the machine name only if the FTP Target machine resides on the same network as that on which
PeerSync is running.

Path to Host

Provide the full path to the Target folder in this field (i.e. /FTProot/My Data/Target). Make sure the path begins at the base
directory to which the FTP server allows connection. The path
does not need to be preceded by the key phrase 'FTP' however
it must start with a forward slash ( / ). This field does not validate the existence of the path you provide therefore you must
exercise great care when doing so. If the path does exist, PeerSync will create it during run time as long as a valid host name
or IP address has been provided.

User Name

Stores the Target FTP User Name information for login.

Password

Stores the Target FTP Password information for login.

FTP Settings Tab
Provides configuration for the FTP Target selection.
Enable Passive Mode

Sets the FTP mode to passive. The phrase passive refers to
the FTP server which passively accepts connections and data
while the client initiates both the control connection and the
data connection to random ports specified by the server.
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Passive mode is enabled by default.
Host is using GMT

Option to adjust for GMT time on the FTP server side.

Time Out (seconds)

Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure operation.

Port

Port number used to initiate an FTP session or "command"
connection to the FTP server. Uses standard port 21 by default.

Use Proxy - Firewall

This option allows you to specify the Host Name, User ID,
Password, and Port number to a network Proxy - Firewall.

File types to transfer as
ASCII

Through this field, file types can be selectively tagged for transfer as ASCII upon synchronization. File types can be typed
manually, or can be specified using either the "Files to Transfer as ASCII Button" or the drop-down list located to the right of
the field. The drop-down list located to the right of this field will
be dynamically populated with file types as they are set
through the dialog box described above. They are also added
to the list when you exit the field after manually editing the file
types field. File types can then be specified by selecting them
from this list. This provides a way to store and/or retrieve sets
of file types for later use with other Jobs.
Alternatively, clicking on the "Files to Transfer as ASCII Button" to the right of this field opens a dialog box into which file
types may be entered. To add a File Type click "New," then
type the desired file type into the field located at the bottom of
the dialog. These file types are set by specifying file extensions (i.e. ".txt") which, if found within a file name, will be transferred as an ASCII file during synchronization. Multiple strings
will be semicolon delimited. These settings are not case sensitive, (i.e. "A" = "a"). Repeat this process for each File type. Entries can be deleted by selecting them from the list and clicking
the "Delete" key at the bottom of the box. Once you have finished, click the "OK" button. The box will close and all of the
file types you have specified will automatically appear in the
Files to transfer as ASCII field.

Notes:
1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.

Located to the right of the Target Folder Selection Field, this button opens a "Browse for
Folder" dialog box: once this box has opened, locate your chosen Target folder, select it using the left mouse button, and click "OK."
Note: This button is not available when selecting TCP or FTP Modes for Source or Target.
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Explore/Open/Create Target Button
This button provides three options to be selected from the attached drop-down list. The button label will change to reflect whichever item has been checked on this list.
Explore

When "Explore" has been selected and the button is depressed, an Explorer-type window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Target field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it: you can do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the Explorer-type tree.

Open

When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Target
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it: you can do so by clicking "Yes" button located at the
bottom of this dialog. Once you have done so the newly created Folder will be shown in the navigation window.

Create

When "Create" has been selected and the button is depressed,
a "Select Directory" dialog will open allowing you to specify a
Target Folder path by using the mouse to select a desired
drive, directory, and folder (See image in "Source Folder
Selection" topic above). Folder paths can also be manually
entered into the "Directory Name" field. If you enter a path for a
folder that does not exist and hit the ENTER key or click "OK,"
a dialog box will appear allowing you to create this folder.

Note: This button is not available when selecting TCP or FTP Modes for Source or Target.

Target Folder Popup Menu: Using Normal Mode
The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The
first four features allow the user to Browse for Target Folder, Explore, Open and/or Create
the Target Folder selection.
Configure: Target Folder

Selecting this option displays the Target Network Logon Settings window. This allows the user to specify Network Logon
credentials for the Target Folder which enables connection to
directories that are not accessible with the current logged on
account.

Edit: Target Variable File

This will allow the user to view/edit Variable Data Import and/
or Job Data Import files that are used in the Target Folder selection. This option is only available if using Job data import
files.

Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.
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Set Alternate/Additional
Targets

Selecting this menu item will open the Alternate/Additional Targets selection window. This feature allows for alternate or additional Target paths associated with the base Job.

Force Source Folder
Root as Target Folder
Root

Appends the Source folder directory to the Target folder path.

Target Folder Popup Menu: Using TCP Mode
The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The
first two features allow the user to Explore and Open the Target Folder selection.
Configure: Target Folder

Selecting this option displays the Target TCP/Port Configuration window. This window provides a guided method for entering the Target TCP path as well as TCP and/or Byte Replicator
settings (see TCP Configuration).

Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.

Force Source Folder
Root as Target Folder
Root

Appends the Source folder directory to the Target folder path.

1. The TCP features listed above require the TCP WAN Connector option. Please visit http://www.peersoftware.com
or contact Sales for additional information.
2. The Browse for Target Folder and Create options are not available when using TCP Target Mode.

Target Folder Popup Menu: Using FTP Mode
The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The
first feature allows the user to Open the Target Folder selection.
Configure: Target Folder

Selecting this option displays the Target FTP Configuration
window. This window provides a guided method for entering
the Target FTP path, specify network authentication, as well as
FTP configuration options (see FTP Configuration).

Create Auto Job Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make
it a simple task to organize the Job list.

Force Source Folder Appends the Source folder directory to the Target folder path.
Root as Target Folder
Root

Notes:

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

56

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit http://www.peersoftware.com or contact Sales for additional information.
3. The Browse, Explore, Create, and Set Alternate/Additional Target options are not available when using TCP and
FTP Target Modes.

This link will be enabled if you are using a Normal Target Mode Selection. By selecting this
link you can set and access your current Alternate Target Path Selections. Through this feature, Jobs can now have alternate or additional Target paths associated with the base Job.
This allows for the ability to redirect data on a failed connection to the base Target and/or
easily setup, one-to-many scenarios for distribution purposes. Selecting this menu item will
open the Alternate Target Path Selection dialog.
To add an alternate or additional Target click "New," then type the desired path into the field
located at the bottom of the dialog or select the "Browse" button to select a path.. Repeat this
process for each Target path you wish to add. Entries can be deleted by selecting them from
the list and clicking the "Delete" key at the bottom of the box. You can also use the "Up" and
"Down" buttons to reorder the paths.
Notes:
1. This feature requires the Enhanced Package.
2. Alternate Target Path Selection is not available for TCP or FTP Target Mode Selections.
3. When using Alternate Target Path Selections you cannot use variables that are specific to the Job (i.e. %
JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

If this check box is selected, all sub-folders contained within the Source Folder will be synchronized to the Target.
This button reverses placement of the file paths shown in the Source and Target Folder
Fields (so that what was formerly a Source Folder now becomes a Target Folder, and vice
versa).
Represents the date/time the last scan started for the selected Job. This is the date/time of
the last bi-directional synchronization scan of a Job that will be used when comparing files
during the Bi-directional Synchronization Mode option on the File Options screen. This feature is also displayed and can be reset from the Profile Job List Pop-Up Menu.
Represents the date/time and user when the selected Job was last saved.
This section describes additional features related to the Folder Selection topic. The features
below apply to both the Source and Target folder selections and related configuration options.
Related Options
File/Folder Path Variables
Variable Data Import
Job Data Import
Dynamic Network Drive Mapping and Unmapping
Variable file/folder paths can be used to create:
1. Dynamic archives for yearly, monthly, weekly and/or daily backups
2. Dynamic synchronization based on date
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3. Dynamic synchronization based on logged on user or machine name
4. Dynamic synchronization based on personal folders or other variables read in from the registry
5. Log file storage, manipulation and organization
6. Administrative report file storage, manipulation and organization
7. Deleted file storage, manipulation and organization
File/Folder Path Variables
Depending upon the argument used, these folders will be dated, named after the currently
logged user, named for the PC from which synchronization was launched, or based on a
pre-determined variable stored out and read in from the registry. The following variables
can be used in any folder path Job setting available through the Profiler:
Date

%Date%

Time

%Time%

Date/Time

%DateTime%

Minute

%Minute%

Hour

%Hour%

Day

%Day%

Year

%Year%

Month/Year

%MonthYear%

Minute (all formats)

%n, nn%

Hour (all formats)

%h, hh%

Day (all formats)

%d, dd, ddd, dddd, ddddd, dddddd%

Month (all formats)

%m, mm, mmm, mmmm, mmmm%

Year (all formats)

%y, yy%

Custom Peer Variables
Logged On User Name

%UserName%

Computer Name

%ComputerName%

Job Name

%JobName%

Source Folder Path

%SourcePath%

Target Folder Path

%TargetPath%

Deletion Folder Path

%DeletePath%

Report File Path

%ReportPath%

Windows Variables
Windows Directory

%WinDir%

Windows

%Windows% (also %SystemRoot%)

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

System Temp Path

%Temp%

System Temp Path

%Tmp%

System Drive Letter

%SystemDrive%

System 32 (WIN 9x/
NT/00)

%System32%
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Windows Variables from the "HKEY_CURRENT_USER\Software\Microsoft\Windows
\CurrentVersion\Explorer\Shell Folders" Registry
Desktop

%Desktop%

Favorites

%Favorites%

Fonts

%Fonts%

Personal

%Personal%

Programs

%Programs%

Recent

%Recent%

SendTo

%SendTo%

Start Menu

%Start Menu%

Startup

%Startup%

Templates

%Templates%

Notes:
You can also use any variables that are located in the registry under HKEY_CURRENT_USER. For example:
HKEY_CURRENT_USER\Environment (used by default default)
HKEY_CURRENT_USER\Volatile Environment (used by default)
The HKEY_CURRENT_USERS locations can be modified in the PSDef.cfg file as follows:
[Misc Options]
RegVarStr=\Environment;\Volatile Environment;
In addition, the %USERPROFILE% Environmental Variable is now also supported.
Use the variable %Personal% to define the "My Documents" folder in Profiles that will be used on multiple operating
systems such as XP and Windows 7. Since the location of the My Documents folder is different on these operating
systems, using the %Personal% variable will dynamically resolve to the correct location on each system. This simplifies configuration and keeps the Profile generic and deployable on multiple operating systems.
Note for PeerSync Jobs linked to PeerLock: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables such
as %JobName% are currently not supported and will not work in PeerLock.

PeerSync now contains tools for importing data from files. The ability to extract specific fields
of data from a file has been included to allow unlimited scalability. Within an organization,
one generic Profile can now be created, and utilizing text files, specific information about the
user and the desired folders to be synchronized can be imported dynamically. Variables can
be used to dynamically introduce data from a file into various fields throughout the interface
including file paths, deletion paths, log file paths, log file names, etc.

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

59

PeerSync Help

Field data is imported through:
<<#FileName.txt [section] item#>>
In which the [section] is a defined field in a file, such as the example file content below.
[Info]
Name=Cris Smith
Home=c:\mydocuments
Using <<#FileName.txt [Info] Name#>> will import "Cris Smith" into the path it was used in
and using <<#FileName.txt [Info] Home#>> will import "c:\mydocuments" into the path it was
used in.
Note: This feature requires the Enhanced Package.

PeerSync now contains tools for importing data from files to dynamically create Jobs. Within an
organization, one generic Profile can now be created, and utilizing text files, specific information
about the user and the desired folders to be synchronized can be imported dynamically. Lists can
be used in Source and Target path names as such:
Source: <<$FileNameSources.txt$>>
Target: <<$FileNameTargets.txt$>>
or:
Source: <<$C:\Path\To\File\FileNameSources.txt$>>
Target: <<$C:\Path\To\File\FileNameTargets.txt$>>
Corresponding entries of each delimited file entry will be used to dynamically create a Job
based upon the Jobs properties.
Note: This feature requires the Enhanced Package.

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder selection. The way you do this is to add a letter to the beginning of the UNC path that you wish
to map the drive to. This can be done for the Source or Target selection (i.e. n\\COMPUTER
\SHAREDDEVICE\PATH).
For Example: n\\DELLSERVER\D\USERDATA
The example above will map the D drive on the DELLSERVER to the N drive upon start of
PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful feature
especially when running PeerSync as a service in the scenario where you want to synchronize to a mapped drive. This feature will allow for it to occur seamlessly.
Note: If you are going to run PeerSync as a Service it is advised to use UNC paths or PeerSync's Dynamic Network Drive Mapping and Unmapping feature instead of using mapped
drives due to the fact that mapped drives are not understood when a user is not logged on.
Next/Last Available Drive Mapping
This feature allows for the dynamic mapping of the next (A) or last (B) available network drive
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by using the following format in the Source or Target Fields:
Map Next Available Example: A\\COMPUTER\SHAREDDEVICE\PATH
Map Last Available Example: B\\COMPUTER\SHAREDDEVICE\PATH

Local Drive Mapping
This feature allows for the dynamic mapping of a local drive by using the following format in
the Source or Target Fields:
Map Local to N Example: N\\LOCALCOMPUTER\SHAREDDEVICE\PATH
1.1.3 Automation

Topics
Automation Overview
Automation Options
The Automation screen allows you to apply Real-Time Monitored or Scheduled synchronization to individual Jobs within a given Profile. Real-Time operations (also referred to as "File/
Folder Change Detection") monitor Source Folders for any changes and synchronize them to
the specified Target as they occur. Scheduled operations automatically launch synchronization according to a user-specified schedule. Through these settings, PeerSync allows you to
build a Profile with as many as 255 different Jobs -- each run according to a unique schedule
or in Real-Time (Also see Command Line Arguments for Global Automation Settings).

Scanning Options
The options listed on this page can be accessed from the Automation window. This screen
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allows the user to set the frequency of scans as well as enable Real-Time replication.
Scan Job Once at Start

This feature directs PeerSync to run the current Job as an
Automatic Operation. An Automatic Operation allows you to
perform an immediate launch of the current Profile. As a nonpersistent process, Automatic Operations are run a single time
upon manual initiation by the user. We also refer to this type of
run as an Initial Sync.

Scan Job every x
minute(s)

Checking this feature assigns a Scheduled operation to the selected Job(s). The field associated with this feature allows you
to set an interval in minutes: after this time has elapsed the selected folders will be synchronized. 5 minutes is the default
setting. Intervals in seconds can be specified through the use
of decimals, (i.e. 0.5, 2.5, etc.); the minimum interval is 0.01.

Scan Job at x

Checking this feature will allow for the synchronization of Jobs
at a specific times of the day for selected days of the week.
When selected the Daily Timer Options dialog will appear with
the following options:
Run selected Jobs at
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Selecting this feature will run the Job at the selected time of
day.
List of Job Selections
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
is a list of the currently selected Daily Timer selections. You
can Add New selections by selecting the New button and Delete existing selections by selecting the Delete button.
Select days of week to run
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. Allows you to turn on/off which days to run this schedule.
Selection Options
Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
feature will give you the option to run the selected daily timer
schedules in a Recurring mode (synchronization will run every
time according to the set scheduled options) or Run Once
(synchronization will run only once).

Use Enhanced Scanning
(Enhanced Scanning)

The Enhanced Scanning option is required for this feature to
be enabled. Enhanced Scanning provides the ability to build
multiple dynamic Jobs for parallel processing of folders during
scans. This will significantly improve the time PeerSync takes
to scan trough directories. By default PeerSync scans through
a Job sequentially, one folder at a time. With the Enhanced
Scan option enabled PeerSync will spawn a Job Thread for
each folder or subfolder encountered during a scan.
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When the Use Enhanced Scanning checkbox on the Automation window is checked the Enhanced Scanning dialog will
open. By default the slider in the Enhanced Scanning dialog is
set to the Off position all the way to the left side. To enable the
Enhanced Scan feature move the slider to the right. Each slide
position represents a depth level of 1, 2, 3, 4, and 5 respectively. Each value represents the depth level at which PeerSync
will spawn a Job thread for each folder it encounters.
Example:
If you set the Enhanced Scanning slider to Level 3, then PeerSync will spawn 7 dynamic Jobs for the Users directory depicted bellow. It will in essence create a dynamic Job for each of
the folders at Level 3 (Folder1, Folder2, Folder3, and Folder4).
It will then create a Job for the folders at Level 2 (Users1 and
User2) but will exclude all their subfolers. Lastly, it will create a
Job for the directory at Level 1 (Users) and exclude all the subfolders.

Notes:
1. The Enhanced Scanning and the Multi-Threading add-on options are required for this feature. Please visit http://www.peersoftware.com or contact
Sales for additional information.
2. When using this option be sure you make available a large pull of Job
Threads to be used by PeerSync so that dynamic Jobs can be created for
each folder during a scan.
3. This feature is not supported when using FTP source or target modes.
4. This feature is not supported when using the Enhanced Bi-directional option.

Real-Time Event Detection Options
The options listed on this page can be accessed from the Automation window. This screen
allows the user to set the frequency of scans as well as enable Real-Time replication.
Use Real-Time Monitoring

Selects the current Job(s) for Real-Time Monitoring.

Real-Time Options...

This button opens an "Additional Options" dialog box. Once
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this box has opened, it allows you to choose from two RealTime operations. The first is a Folder Replication feature,
which monitors for changes to the Source Folder and synchronizes the Target accordingly. The second, a Folder Restoration feature, monitors for changes to the Target Folder and
restores files on the Target accordingly. To properly use the restore feature, you will need to select the "Always overwrite Target files" option.
Notes:
1. Bi-directional will be ignored for Real-Time Jobs.
2. When synchronizing to an FTP Target, PeerSync will suppress Real-Time
Jobs until initial synchronization has completed.

Enhanced Real-Time Monitoring
This feature allows the Real-Time feature in PeerSync to detect individual changes to files and synchronize only the file
which has changed without scanning the entire folder where
the change occurred. Normally, synchronization software
scans and compares all files into a folder which is being synchronized. This feature does not scan folders unless the
change is indeterminate. If a file or folder is renamed, PeerSync will rename the corresponding Target File or folder using
rename functions as opposed to copying the newly renamed
Source Folder to the Target and then subsequently deleting
the outdated Target file/folder. This feature greatly reduces the
time required to synchronize files and also reduces network
band width requirements.
With this option enabled PeerSync will continue to detect realtime events even during a scan.
Notes:
1. Bi-directional, During comparison subtract/add x minute(s)
from Target, and Trigger Selections, as well as, other non applicable features may be ignored during Enhanced Real-Time.
2. It is recommended either use the Enhanced Real-Time option for all or none of your Real-Time Jobs within a Profile.
3. Using Enhanced Real-Time will produce a different file output format for all modes of reporting and message logging (Reporting, Admin Reporting and Email Reporting). The output will
NOT contain a start and stop section or a summary, each entry
will also be initially marked with a date and time stamp. If use
summary is selected for Admin or Email reporting then the
standard selection will be used. The reason this is done is due to the fact
that processes will be running in parallel.

Use Standard Real-Time Monitoring
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When the Real-Time feature detects a change to synchronize,
this method will cause a scan to run on the root folder, but not
the subfolders. For folder manipulations such as renames, the
entire folder including its subfolders will be scanned.
Global Settings

See Source Folder Global Options.

1.1.4 Blackout Settings

Topics
Blackout Settings Overview
Blackout Period
This screen will enable you to set a Blackout period during the daily synchronization. This
is a period in which the synchronization will stop and wait until the blackout period has expired according to the specified settings. This would be a useful feature if you wish to stop
all the synchronization activities during a particular time when the Network Bandwidth is
busy with other activities (such as during working hours).
Suspend active scans Enabling this option will pause all the scheduled scans during
when a Blackout period the specified Blackout and will resume after the Blackout
starts
period ends.

What happens if PeerSync is performing a scan when it enters the Blackout period?
If the option to "Suspend active scans when a Blackout period starts" is enabled the scan will
be suspended and resumed at the point it was left off after the Blackout period ends. If this
option is not enabled, the scan will be stopped during the Blackout period and will be restarted from the beginning after the Blackout period ends.
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What happens if PeerSync was in the middle of transferring a large file
when it entered the Blackout period?
PeerSync will allow the transfer to complete but suspend any new events from being processed until the Blackout period ends. The suspended events or scans will be processed
after the Blackout period ends.
What happens if a scan is scheduled to run during the Blackout period?
Regardless if the option to "Suspend active scans when a Blackout period starts" is enabled
the scan that is scheduled to run during the Blackout period will run after the Blackout period
ends. Multiple suspended scans for a single Job will be compiled into a single scan that will
run at the end of the Blackout period.
1.1.5 Scan Limitations

Topics
Maximum Duration of Scans
Initiate Scan on trigger File Change
Note: Features listed on this page require the Enhanced Package.

Enabling the Set maximum duration to x minutes option allows you to specify a maximum
duration for each Job. This gives you the ability to limit the run time of a Job during initial, interval, and scheduled scans.

Trigger Files
These settings ensure that the Target Folders always remain updated to their corresponding Source by comparing dates indicated by individual Trigger Files. For example, if a
Source Trigger is found to be newer than a corresponding Target Trigger, a synchronization process will be allowed to proceed for the selected Job(s). If the files date and time
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stamps match then the synchronization will not be processed. Therefore, the run of the
sync process is in essence, determined by the trigger files.
Use Trigger Files

This feature is used to activate or trigger synchronization
based upon date comparison between an individual Source
Trigger File and a separate Target Trigger File. If the Target
Trigger File is older then the Source Trigger File, the entire
Source Folder(s) will be synchronized.

Default File Name

Displays the Default Global Trigger File Name: GLBCHG.000

Source Trigger File

This field allows you to specify a Global Trigger File by entering it manually, or by selecting it using the browse button located at the right side of the field.

Use Current Paths

Automatically selects the current Trigger Files associated with
the Source and Target Folders.

Target Trigger File

This field allows you to specify a Global Trigger File by entering it manually, or by selecting it using the browse button located at the right side of the field.

Note: During Enhanced Real-Time, Trigger Selections will be ignored.
1.1.6 File Options

Topics
Mode Selection
Event Options
Mode Selection
The options listed on this page can be accessed from the File Options window.
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Standard (update Target With this mode selection, PeerSync will update files on the
Files if Source is newer) Target only if the Source is newer.
Always overwrite (Up- This feature automatically overwrites any files in the Target
date Target Files if the Folder that have a different date\time stamp than their corresSource is newer or older) ponding Source File, even if the Target File is newer. This feature can be used to restore folders to a previous state either for
backup/restore operations or to reset files after training operations.
Bi-directional (both direc- With this feature selected, PeerSync will merge the data of the
tions)
Source and the Target folders during Scan at Start, interval
and scheduled scans. This feature may be ignored during
Real-Time and Enhanced Real-Time modes. The following will
happen when this feature is selected with the Replicate - Delete unmatched files/folders option enabled:
If a File exists in both Source and Target Folders
PeerSync will compare the Modified date/time of the files and
update/overwrite the older file with the newer file. If the modified date/time is identical PeerSync will not perform any action.
If a File exists in only the Source or Target Folder
PeerSync will compare the Modified, Created and Accessed
date/time of the file with the stored Last Run On date/time of
the Job. If any of the three file date/times are newer than the
stored Last Run On date/time the file will be added, otherwise
the file will be deleted.
If a Sub-Folder exists in only the Source or Target Folder
The Source will be seen as the primary folder and any subfolders with content existing on the Source will be added to the
Target. If the folder is empty or exists on the Target, PeerSync
will compare the Modified, Created and Accessed date/time of
the folder with the stored Last Run On date/time of the Job. If
any of the folder date/times are newer than the stored Last Run
On date/time the folder and all of its contents will be added,
otherwise the folder will be deleted.
Note:
PeerSync now also supports real-time or scheduled bi-directional replication
using our TCP replication mode. To achieve real-time bi-directional replication
across TCP, PeerSync and PSListener would need to be installed on both the
Source and the Target machines. For scheduled bi-directional replication
across TCP, PeerSync would need to be installed on one side, while the
PSListener on the other. This feature is not supported when using a TCP or
FTP Target.

Related Options
Global Bi-directional Options
Notes:
1. The Bi-directional feature is only supported when working with a Normal Source and a Normal or TCP Target.
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2. The Bi-directional feature may be ignored when using FTP Source or Target.
3. The Bi-directional feature may be ignored when using TCP Source.
4. The Bi-directional feature is only valid during scans and will be ignored during Real-time monitoring.
5. The Bi-directional feature may be ignored when using Compression.
6. Non NTFS partitions may behave differently using the Bi-directional mode. You may notice files being retained for up to
one day, even if you delete a file from the Source or Target.
7. Modifications, such as renames and deletes, of Target Folders are subject to restoration in the Bi-directional mode.

Event Options
The options listed on this page can be accessed from the File Options window.
Add - synchronize new
files to Target

If the Source contains files not found within the Target and this
feature is selected, those files will be added to the Target
Folder during synchronization. This feature is selected by default.

Update - synchronize ex- If this feature is selected, Target Folder files which are also
isting files in Target
found within the Source will be updated to match those Source
files during synchronization. This feature is selected by default.
Replicate - Delete unmatched files

If this feature is selected, any unmatched files found in Target
Folders will be deleted automatically.
CAUTION: Use this feature carefully. If not configured properly, needed files may be permanently deleted. A deletion
warning is NOT displayed by default: Profiler must be first set
to display this warning through the "Deletion Warning Message" check box.

Related Options
Deletion Options
Move Options
Note: The Replicate feature may be ignored when using Compression.

Delete Options
The options listed on this page can be accessed by clicking on the Deletion Options button
from the File Options window. Once the Replicate - Delete unmatched files option is turned
on the Deletion Options button will be enabled for further configuration. Clicking on the Deletion Options button opens the "Additional Options" dialog box which contains the following features:
Deletion Warning Message

The upper section of this screen allows you to enable or disable a Deletion Warning Message, as well as set the number
of seconds for which a Message will be displayed. (a message
is NOT enabled by default and is not available during Enhanced Real-Time). In addition, you can also choose to display
a message requiring manual intervention in order to activate
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deletions.
Move Options
By clicking on the Move Options button in the File Options window you will be able to access the Move Deleted File Options dialog which has the following settings available:
Move Deleted Files Options

This section provides a field where the user can designate an
alternate folder to which unmatched files will be moved in order
to avoid permanent deletion. This folder path can be typed
manually, or selected using the browse button provided to the
right of the field. If the designated folder exists, all unmatched
files will be moved there, allowing you the opportunity to recover files deleted from the Target. This field also supports
File/Folder Path Variables and when used, the current path will
be displayed above the field. Beneath this field are path options.
We strongly recommend using a Deletion Folder that is located
on the Target host computer. Relocation to an alternate drive
or host adds unnecessary processing and bandwidth overhead. For this reason PeerSync uses the following Deletion
Folder variables:
%TARGETROOT%
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETROOT%\Deletions will resolve to
\\machine1\c$\Deletions. This variable is used by default.
%TARGETPARENT%
This variable resolves to the parent directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETPARENT%\Deletions will resolve
to \\machine1\c$\Target\Deletions.

Relative Paths

This feature will move files deleted by PeerSync from the root
folder to the root of the selected folder. Files deleted from sub
folders will be moved to corresponding sub folders below the
root selected deletion folder. This feature is intended (works
best) for a Profile with a single Job.
E
x
a
m
p
l
e
:

Source Folder:

C:\MyDocs\Files\

Target Folder:
Move Path:

D:\MyDocs\Files\
C:\DeleteFolder\

If you delete:
PeerSync
will
move:
To:

C:\MyDocs\Files\Sub\File.txt
D:\MyDocs\Files\Sub\File.txt
C:\DeleteFolder\Sub\File.txt
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Preserve Paths

This feature will recreate the original path of the deleted file under the specified path. Therefore, a file deleted by PeerSync
will be moved into a folder that corresponds to the file's original
location: under the selected deletion folder. This feature is intended (works best) for a Profile with Multiple Jobs.
E
x
a
m
p
l
e
:

Use Recycle Bin
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Source Folder:

C:\MyDocs\Files\

Target Folder:
Move Path:

D:\MyDocs\Files\
C:\DeleteFolder\

If you delete:
PeerSync
will
move:
To:

C:\MyDocs\Files\Sub\File.txt
D:\MyDocs\Files\Sub\File.txt
C:\DeleteFolder\D_MyDocs\Files\Sub\File.txt

This feature allows you to specify the Windows Recycle Bin as
a location for unmatched files. This feature is not intended for
use when file deletions made by PeerSync may occur on a
non-local machine or device. Only files deleted from a local
drive can be moved to the Recycle Bin, if this feature is used
all network files will be permanently deleted.

Delete unmatched Target This feature is intended for the cleanup of files that were candidates for deletion but were selected to be moved to an unFiles older than x days
matched folder. By use of this feature, PeerSync can be used
to temporarily store files setup for deletion and then have the
files deleted after a specified number of days. By default deletion folders are checked every 24 hours or immediately after
the initial scan (if Scan Job Once at Start is enabled). This interval can be modified by using the /LH:n argument where n is
represented in minutes.

Notes:
1. Only one copy of any file can exist in your designated Recovery folder.
2. To avoid filling up your hard drive unnecessarily, you should periodically check this folder and delete unwanted
files or use the Delete unmatched Target Files older than x days option.
3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files will
be permanently deleted.
4. When synchronizing to an FTP Target, the Move unmatched Target Files option is not available.
5. When using Compression, the Move unmatched Target Files option is not available.
6. The Deletion Warning Message option is not available during Enhanced Real-Time.
7. When using the Alternate Target Path Selections feature you cannot use variables that are specific to the Job
(i.e. %JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.
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1.1.7 Open Files

Topics
Open Files Overview
Managed Files
Global Settings
Open Files
The options listed on this page can be accessed from the Open Files window.
Include open files (allow
read & write access to
source file during transfer)

Use this option when you want to include open files and allow
users to modify them while they are being transferred. For
locked files such as database files, PeerSync will first attempt
to process them using the Managed Files setting if enabled. If
this process is not enabled or fails, locked files will be retried
based on the retry open/inaccessible files setting.
Note: If PeerSync is able to synchronize files which are in use by other applications, access to those applications may in certain instances be temporarily
lost during synchronization.

Include open files (allow
read access to source
file during transfer)

Use this option when you want to include files that are open for
read-only access. Users will be able to open source files for
read-only access while they are being transferred. For files
that are being modified or are locked PeerSync will first attempt to process them using the Managed Files setting if enabled. If this process is not enabled or fails, these files will be
retried based on the retry open/inaccessible files setting.

Exclude open files (allow
read access to source
file during transfer)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based on
the retry open/inaccessible files setting. Users will be denied
write access to source files that are being transferred but may
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have the option to open them in read-only mode.
We recommend you use this option when doing replication/collaboration from one source to multiple destinations. This option
allows PeerSync to replicate files from one source to multiple
destinations, in parallel, while at the same time protecting the
source files from write access during their transfer.
Exclude open files (deny
all access to source file
during transfer)

Use this option when you want to replicate only files that are
closed. Files that are opened or locked will be retried based on
the retry open/inaccessible files setting. Users will be denied
complete access to the source files that are being transferred.
We recommend you use this option when doing real-time bidirrectional synchronization/collaboration between two hosts.
For collaboration between more then two machines we recommend you use the Exclude open files (allow read access to
source file during transfer) option.

Related Options
Managed Files
Global Settings
Note: In order to replicate locked files you will require the VSS add-on module. If you do not configure the Managed
Files setting to use VSS, locked files will be retried based on the retry open/inaccessible files setting.
1.1.8 Managed Files

Topics
Managed Files Options
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Managed Files - Global Settings
Note: Features listed on this page require the VSS option.

Managed Files
The options listed on this page can be accessed from the Managed Files window.
Enable Managed File Ac- Enabling this option will allow you to reliably backup open and
cess (Source Files Only) locked files while users continue to work on them. For this feature to be available you will require the Volume Shadow Copy
Service (VSS) add-on module. This technology has been integrated with PeerSync to allow synchronization of critical data
such as system files and databases. By default this feature is
enabled at the end of a manual synchronization and is run
every 2 hours during persistent (Real-Time or scheduled)
modes. This interval can be modified from the Global Settings
screen via the Global Managed Files Options link to a minimum interval of 30 minutes. For more features on configuring
this option please view the Managed Files Arguments.
Synchronize open/locked Through the use of this feature PeerSync will enable profiles via Managed Files
cessing of the Open and Locked Files from the local machine,
through the use of the Volume Shadow Copy Service (VSS)
technology. Please note VSS will delay processing of files to
the specified interval. VSS is an add-on module.
Synchronize ALL files via
Managed Files (including
files that are not open/
locked)

Through the use of this feature, you can force PeerSync to
send all the file processing through the Volume Shadow Copy
Service (VSS) technology. Please note VSS will delay processing of files to the specified interval. VSS is an add-on
module.

Related Options
Global Settings
Notes:
1. These options require the VSS add-on module. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. This feature only works for local Source folders and will be ignored with an FTP Source.
3. This feature may be ignored when using an FTP Target in conjunction with File Compression.
4. This feature may be ignored when using Folder Compression.
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1.1.9 Performance

Topics
Performance Overview
Options/Commands
Performance Options
The options listed on this page can be accessed from the Performance window.
File Read/Write Buffer
Size

This feature allows you to change the read/write buffer sizes to
optimize performance/speed across various network environments or on the local machine. In most cases this will increase
performance dramatically but you will probably need to test this
feature in your environment to determine what advantages can
be gained from altering this size.
The minimum value is 256 bytes.
The default value is 64 KB.
The maximum value that can be set using the track bar is 128
KB.
The maximum value that can be set using the up arrow or by
manually typing in the spin edit field is 128 KB

Buffer Size Upper Limit
(* Multi Threading Optionng Option)

A higher upper limit of 1 MB is available with the Multi Threading Option option. This value can be set using the up arrow or
by manually typing a set value into the spin edit field.
Note: This option may be internally set to a maximum value when using an
FTP Source or Target.

Throttle bandwidth - Use
x percent of available
bandwidth

This feature is designed to limit or slow down the pulse of
reads and writes performed by PeerSync, at the percentage
specified, in order to keep bandwidth available for other applic-

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

75

PeerSync Help

ations to use. This is done at the file level and is performed by
each Copy Thread during the transfer of each file. As we copy
a file we track how long it takes to read and write data from the
source to the target. Every 100 milliseconds from the start of a
file transfer we calculate how much time to allot for processing
and sleeping based on the percentage set for the option.
Examples:

100% Always Process
90% Process for 90 milliseconds Sleep for 10 milliseconds
every 100 milliseconds
50% Process for 50 milliseconds Sleep for 50 milliseconds
every 100 milliseconds
10% Process for 10 milliseconds Sleep for 90 milliseconds
every 100 milliseconds
In summary, PeerSync determines bandwidth throttling by calculating the amount of time required to send a packet of data
across your network and then applying a delay based on the
throttling percentage specified.
Time & Day Options
Limit Bandwidth Trottling between the hours and days defined
for the selected Job. Using a W+ switch in the /Q8B argument
(i.e. /Q8BW+) will display/report bandwidth % used for file add
and update events as part of the remarks field.
Notes:
1. This methodology should dynamically allow for PeerSync to transfer data at
a fast pace when no other applications are using bandwidth and allow it to
back off when other applications are using bandwidth.
2. This methodology is more accurate when using smaller Read/Write Buffer
settings.
3. This methodology does not include small files that take less than 100 milliseconds to process.

Enable intelligent network load balancing
(when applicable)

The network load balancing option will automatically set a
read/write buffer size based on recommendation from NIC network cards (Installed network cards must also support this feature).

Set maximum number of
copy threads to x (* Multi
Threading Option)

This feature will limit the number of copy threads to be
spawned and used for the selected Job during folder scans.
This thread limit does not apply to enhanced Real-Time
events. By using limits for scanning, it helps the Profile to better process Enhanced Real-Time events during heavy scan operations.

Related Options
Options/Commands
Note: Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.
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1.1.10 Byte Replicator

Topics
Byte Replicator Options
Note: Features listed on this page require the Byte Replicator options.

<%REPLICATOR%> Options
The Byte Replicator screen enables and configures Block/Byte level synchronization for
the selected Job. Through the use of this feature PeerSync will be able to transmit only the
bytes/blocks of a file that have changed instead of transferring the entire file.
Use block/byte level
synchronization

Select this option to enable/disable block/byte level replication.
If this is disabled, PeerSync will use the standard copy method
to synchronize the file. If the Byte Replicator fails to synchronize a file, i.e. On Failure, PeerSync will either:
1. Log Messages & Use Recovery Intervals (if applicable)
2. Use Default File Copy for Synchronization

Block Size Selection

This slider controls whether either Performance or Bandwidth
Utilization is most important. Files synchronized with the slider
set Low will take longer to complete than with the slider set
High.

File Exclusions

Clicking on the Exclusions button in the Byte Replicator window opens theByte Replicator File Exclusions dialog. Files
that match types in the exclusion string (types by file extension) or files that have a size lower than the Minimum File Size
will use the default file copy method instead of the Byte Replicator feature.
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Excluded File Types by Extension
Field containing a list of file types that will use the default file
copy method instead of the Byte Replicator. This feature can
be configured by clicking the button to the right of this field. For
example, to exclude files with the extension LOG you may add
either .log or log to the exclusion list. Multiple entries need to
be semicolon (;) delimited.
Minimum File Size
Files with sizes lower than the value in this field will be copied
using the default file copy method instead of using the Byte
Replicator.
Port Configuration

Clicking on the Port Configuration button in the Byte Replicator window displays the Port Configuration dialog. This window allows for a common TCP and/or Byte Replicator configuration option for both the Source and Target paths (see the TCP
Port Configuration tab for more information).
Note: The TCP WAN Connector (TCP) is an optional feature which may not be
included in your package. Please visit http://www.peersoftware.com or contact Sales for additional information.
Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Notes:
1. The Byte Replicator is an optional feature which may not be included in your package. Please visit http://www.peersoftware.com or contact Sales for additional information.
2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is assigned as
an administrative share (i.e. D$) in order for the Byte Replicator to work properly.
3. In order for Byte Replicator to be enabled, the following criteria must be present:
The Target Path cannot be an FTP Target
The PS Listener Service has been installed on the remote machine
The PeerSync license has the Byte Replicator add-on feature
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1.1.11 Revisioning

Topics
Revisioning Options
Revisioning
The options listed on this page can be accessed from the Revisioning window. Through the
use of this feature, you can use PeerSync to keep multiple versions of each file. This is a
great feature for recovering a previously saved version of a file.
Revisioning - Keep
backup files of overwritten Target Files

Select this option to enable/disable the use of Revisions.

Number of backup files
to keep

Designates the number of revisions to keep for each file. PeerSync revisions each file by adding a ".PSBAK1" extension to
the existing Target File before replacing it with the updated
Source File.
Example: "MyFile.txt" will become "MyFile.txt.PSBAK1"
If more than one backup is selected, each file will be renamed
to the next revision when an update occurs:
Example:
"MyFile.txt.PSBAK1"
".MyFile.txt.PSBAK2"

is

renamed

to

The newest revisions (backup files) will bear the lowest number while the oldest will have the higher number:
Example:
...Older
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Note: If the "Delete Unmatched" option is selected and the Source File that
has corresponding PSBAK files deleted, all associated PSBAK files will also
be deleted.

Keep files in Target
Folder

By default, revisions will be stored in the Target Folder where
the updated Target Files reside.

Keep files in Deletion
Folder

You also have the option of using the Deletion Folder for storing revisions. This is quite useful when used in conjunction
with the Delete unmatched Target Files older than x days option, which is used for automatic cleanup of old revisions.

Keep files in Alternate
Folder

You may specify the folder path where you would like the revisions stored to. This option will give you the ability to specify a
separate revision folder per Job. We strongly recommend using a Revisions Folder that is located on the Target host computer. Relocation to an alternate drive or host adds unnecessary processing and bandwidth overhead. For this reason
PeerSync uses the following Revisions Folder variables:
%TARGETROOT%
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revision path %TARGETROOT%\Revisions will resolve to \
\machine1\c$\Revisions. This variable is used by default.
%TARGETPARENT%
This variable resolves to the parent directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revisions path %TARGETPARENT%\Revisions will resolve
to \\machine1\c$\Target\Revisions.

Notes:
1. This feature may be ignored when using an FTP Source.
2. This feature may be ignored when using Folder Compression.
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1.1.12 Miscellaneous

Topics
Temp Files
Source File/Folder Alterations
Additional Event Options
Target File/Folder Alterations
These options can be found in the Miscellaneous window.
Use intermediate file dur- If this box is checked, a temporary file will be created in the
ing copy
Target Folder: the contents of the Source File will then be
copied into this temporary file. After a successful copy, the Target File will be deleted and the temporary file will be renamed
to bear the Target File name. This feature ensures that the updated file will only replace the Target File if copy is successful.
If the copy process should be interrupted because of some outside factor (network down, power outage, etc), the original Target file will still be preserved. This option is enabled/disabled
automatically when the Bi-directional or Revisioning options
are enabled/disabled.
Trigger additional event
after successful copy

When this option is checked PeerSync will apply the time
stamp of the target file after successfully completing the file
transfer in order to trigger an event on the target side. This action will cause the PeerSync installed on the Target to take further action with the file such as transferring it to another location that is not accessible from the originating machine.

Transfer NT security de- If this feature is checked, PeerSync will transfer over and
match the security descriptions (ACLs) to the Target file upon
scriptions (ACLs)
synchronization, under Windows NT platforms. When this op-
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tion is enabled, the "ACL Options" and Global Settings link will
be enabled for further configuration.
ACL Options

This dialog is available if you enable Transfer NT security descriptions (ACLs) or click on the" ACL Options" button located
on the Miscellaneous window. The options in this dialog allow
you to specify the types of permissions you want PeerSync to
transfer.

Force target file attribute
settings

If this feature is selected, the File Attributes Options dialog will
be displayed. In this dialog, you may select to force any attribute on or off for the Target files that are synchronized within
the selected Job(s).

File Attribute Options

This dialog provides the user the selection to ignore, force on,
or force off attribute settings on Target files that are synchronized within the selected Job(s).

Related Options
Global Settings
Notes:
1. Care must be exercised when using ACL options to synchronize files and folders between different domains. File
security transfers could make the target file inaccessible after transfer/update.
2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is assigned as an administrative share (i.e. D$) in order for ACLs to work properly.
3. This feature may be ignored when using an FTP or TCP Source or Target.
4. This feature may be ignored when using Folder Compression.

Source File/Folder Alterations
These options can be found in the Miscellaneous window.
Move Files - Delete
This feature will delete the Source file after the file is copied to
source file after success- its corresponding Target folder.
ful copy to target
Note: This feature should not be used with the Delete Unmatched Target Files option on the File Options screen because conjunct use of the two options will greatly increase the
chance of data loss.
Turn file archive attribute This feature resets the archive flag on the Source and Target
off after synchronization file after synchronization. The Windows file system automatically sets the archive bit for every file that has changed; normally, this is used to indicate that a given file has been modified since the last time its archive bit was set. Most tape backup programs use this flag to determine which files have
changed since the last backup. This option will alter Source
files. PeerSync uses this feature to reduce the number of files
that are checked on the Source drive.

Notes:
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1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This process only occurs after successful synchronization of a changed file.
2. This feature may be ignored when using an FTP Source.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature.
This configures all files for synchronization and consequently qualifies them for the reset of
archive flags. This feature only needs to be selected once to be applied to existing sync operations.

Additional Event Options
This option can be found in the Miscellaneous window.
Include attribute change
as synchronization criteria

This feature allows for the synchronization of files that have different attributes. If this feature has been selected, a Source file
whose attributes do not match the Target will still be included
in the synchronization process.
Notes:
1. This option is not supported for Jobs using FTP source or target.
2. By default this option only works during scans. Use the /LA command line
argument if you wish to enable attribute detection in real-time.

1.1.13 Additional Features

Topics
Additional Options
Validation Options
File Time Change Options
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Note: Features listed on this page require the Enhanced Package.

Additional Options
The options on this page can be accessed from the "Additional Features" window, available only with the Enhanced Package.
Enable file recovery

This enables the file recovery option to continue a file copy
which may have been interrupted. If the Source and Target file
name and date match but the Target file is smaller, PeerSync
will start the copy operation from the last byte that was sent the
next time a sync operation is executed on the folder.
Note: Enable file recovery will be ignored with an FTP Source
or FTP Target.

Replace
in-use
upon reboot

files If this feature is selected, once a file is open and locked on the
Target Folder, it will be set to be replaced the next time the
machine is rebooted.
Note: This option is only applicable for Jobs with a local Target Folder.

Reboot Options Button

This button opens the Reboot Options dialog box. The default
option is "Do not reboot", you may also choose to "Display reboot dialog", or to "Automatically reboot".

Note: Features described on this page require the Enhanced Package.

Validation Options
These settings can be accessed from the "Additional Features" window, available only with
the Enhanced Package.
Perform binary comparison on all files (using
CRC32)

Option to check all Source and Target files for binary match
during folder scan/compare cycle (using CRC32). This check
ensures that what is on the Target matches the Source at a
binary level.

Validate target file (using Option to validate file using CRC32 binary comparison after
CRC32)
successful file copy operation. Clicking on the Retry Options...
button opens the Validate File Copy Options dialog box. In this
window you may set PeerSync to continue re-validating a file a
set number of times.
Retry file copy until CRC of target files is validated
Checking this option will enable the CRC Retry cycle, where, if
a file is not validated, PeerSync will retry the CRC32 validation
x times. The default retry value is 1.
Set maximum number of tries to
Specify the number of times PeerSync will perform CRC32 validation on a file if the initial validation fails. The default retry
value is 1.
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Note: Features described on this page require the Enhanced Package.

File Time Change Options
These settings can be accessed from the "Additional Features" window, available only with
the Enhanced Package.
During comparison subOption to add or delete time from Target file during folder comtract/add x minute(s) from parison. This allows for synchronization of files between distarget
similar time zones or to allow for some time difference between
Source and Target in case Target machine date is slightly different from Source.
Note: This feature may be ignored during Enhanced RealTime.
Convert file times to GMT
for comparison between
time zones

Option to convert file times to GMT for comparison between
time zone differences of the Source and Target folders. This
feature is quite useful way of synchronizing data between machines located in different parts of the world.

After synchronization sub- This option can add or delete time from Target file after syntract/add x minute(s) from chronization. This allows for synchronization of files between
target
dissimilar time zones, or to allow for some time difference
between Source and Target in case Target machine date is
slightly different from Source.

Note: Features described on this page require the Enhanced Package.
1.1.14 Exceptions
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Topics
Exceptions Overview
Include Files
Exclude Files
Exclude Folders
Exclude File by Size
Exclude Files by Attributes
Exclude Selected File Dates
The Exceptions screen is used after you have selected a Job or Multiple Jobs from the Profile Job List and then created an associated Source and Target Folder on the Folder Selection screen. Through Exception options, PeerSync allows you to selectively apply synchronization to files contained within the Source Folder according to a wide range of explicit criteria.

Include Files
The options on this page can be accessed from the Exceptions window.
Include Files

Use this field to determine which file types will be included as
part of synchronization. File Type Inclusions are specified by a
star command followed by the file extension (i.e. *.doc). You
can also specify specific file names and/or sub strings using
the * wildcard character.
The default setting * includes all files.
Multiple Inclusions can be used and are semicolon delimited
(i.e. *.doc;*.txt;*.exe).
Inclusions are not case sensitive, (i.e. "A" = "a").
Exampl *.doc
es
docs
copy*
file;dat
a;

- includes any file ending with the extension
.doc
- includes any file that contains the string docs
- includes any file starting with the string copy
- includes any file containing the strings file or
data

You may also use the ? wildcard character to further narrow
down your inclusions. The ? wildcard character can be used to
substitute any single character in the file name including numbers.
Exampl ????.* - includes files that have extensions and cones
tain only 4 characters in the name
June?? - includes files that have extensions, start with
??.*
the word June, and are followed by 4 characters
??
- includes files that have the characters ne in
ne???? the 3rd and 4 th positions followed by at least 4
*
characters
Inclusions can be typed manually, or can be specified using
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either the Include File Types button or drop-down list located to
the right of the field.
Include Files Button

Opens an "Exceptions" dialog box into which file extensions
may be entered. The "include all files" command * will be
shown by default.
To add an extension, click "New." Next, type the desired extension into the field located at the bottom of the dialog. Repeat
this process for each desired file type. Inclusions can be deleted by selecting them from the list and clicking the "Delete"
key at the bottom of the dialog box. Once you have finished,
click the "OK" button. The dialog will close and all of the Inclusions you have specified will automatically appear in the Include File Types field in the proper format (separated by semicolons).
The drop-down list located to the right of this field will be dynamically populated with Inclusions as they are set through the
"Exceptions" dialog described above. They are also added to
the list when you exit the field after manually editing the Include File Types field. Inclusions can then be specified by selecting them from this list. This provides a way to store and/or
retrieve sets of Inclusions for later use with other Jobs.

Exclude Files
The options on this page can be accessed from the Exceptions window.
Exclude Files

Through this field, files can be selectively excluded from synchronization using sub strings or using wild cards. Exclusions
are set by specifying individual characters (i.e. ~), sets of characters (i.e. copy*), or file extensions (i.e. *.tmp) which, if found
within a file name, will exclude that file from synchronization.
Multiple characters and strings can be used and are semicolon
delimited (i.e. ~;*.tmp;copy*)
These settings are not case sensitive, (i.e. "A" = "a")
Exampl ~
es
tmp
copy*
*.tmp

- excludes any file containing the character ~

- excludes any file that contains the string tmp
- excludes any file starting with the string copy
- excludes any file ending with the extension
.tmp
.tmp;.b - excludes any file bearing the strings
ak;~ .tmp, .bak or the character ~

You may also use the ? wildcard character to further narrow
down your exclusions. The ? wildcard character can be used to
substitute any single character in the file name including numbers.
Exampl *tmp? - excludes all files that contain the string tmp
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es

*.*

followed by at least one character before the
extension

Exclusions can be typed manually, or can be specified using
either the Exclude Files Button or drop-down list located to the
right of the field.
Exclude Files Button

Opens a dialog box into which Exclusions may be entered.
To add an Exclusion click "New," then type the desired character or string into the field located at the bottom of the dialog.
Repeat this process for each Exclusion. Entries can be deleted
by selecting them from the list and clicking the "Delete" key at
the bottom of the box. Once you have finished, click the "OK"
button. The box will close and all of the Exclusions you have
specified will automatically appear in the Exclude Files field.
The drop-down list located to the right of this field will be dynamically populated with Exclusions as they are set through
the dialog box described above. They are also added to the list
when you exit the field after manually editing the Exclude Files
field. Exclusions can then be specified by selecting them from
this list. This provides a way to store and/or retrieve sets of Exclusions for later use with other Jobs.

Exclude Folders
The options on this page can be accessed from the Exceptions window.
Exclude Folders

Use this field to exclude folders from synchronization by specifying a folder name in file path format, (i.e. \TEMP\ or C:
\WINDOWS\). These examples will exclude any folder path
that contains these strings including sub-folders.
If you wish to exclude only a specific or root folder such as "C:
\WINDOWS\" but include sub-folders you must include a "#" in
front of the complete folder path (i.e. "#C:\WINDOWS\"). This
example will exclude any files in this directory but include any
files in its sub-folders. A semicolon separates multiple folder
exclusions.
If you wish to exclude multiple folders that contain the same
string do not include the "\" at the end of the folder exclude (i.e.
\Docs).
These settings are not case sensitive, (i.e. "A" = "a")
Exampl \Docs - excludes files and sub-folder in folders startes
ing with Docs (i.e. Docs, Docs1, DocsA, etc.)
\Docs\ - excludes files and sub-folder in folders named
Docs
C:
- excludes files and sub-folder in the folder C:
\Docs\ \Docs\
#C:
- excludes files in the folder C:\Docs\ but in\Docs\ cludes files in its sub-folders
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Exclusions can be typed manually, or can be specified using
either the Exclude Folders Button or drop-down list located to
the right of the field.
Exclude Folders Button

Opens a dialog box into which Folder Exclusions may be
entered.
To add an Exclusion, click "New," then type the desired folder
name into the field located at the bottom of the dialog. Repeat
this process for each Exclusion. Entries can be deleted by selecting them from the list and clicking the "Delete" key at the
bottom of the box. Once you have finished, click the "OK" button. The box will close and all of the Exclusions you have specified will automatically appear in the Exclude Folders field.
The drop-down list located to the right of this field will be dynamically populated with Exclusions as they are added. Exclusions can then be specified by selecting them from this list.
This provides a way to store and/or retrieve sets of Exclusions
for later use with other Jobs.

Exclude empty source
folders

This feature will exclude and will not sync empty Source
Folders to the Target.

Exclude File by Size
The options on this page can be accessed from the Exceptions window.
Exclude File Sizes

Use the "Less Than" or " Greater Than" fields to exclude files
based on their size in bytes. Zero, by default, includes all files.

Include Files by Date
The options on this page can be accessed from the Exceptions window.
Selected File Dates

Use this field to specify files set for synchronization according
to their date stamp. The default setting includes all file dates.
Clicking the button to the right of this field opens a "Select File
Dates" screen. This screen allows you to include all files, include files more than x days old, include files bearing the current and past x day's date, or specify a range of the dates. The
Set Today's Date button automatically updates the existing
range to reflect the current day.

Include Files by Attributes
The options on this page can be accessed from the Exceptions window.
Current Attributes

This field displays "Default" or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which file/
folder attributes may be included. All attributes are selected by
default. Uncheck the file/folder attributes you do not wish to be
used as criteria for synchronization.
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Exclude Files by Attributes
The options on this page can be accessed from the Exceptions window.
Current Attributes

This field displays "Default" or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which file/
folder attributes may be excluded. All attributes are unchecked
by default. Select the file/folder attributes you wish to be used
as criteria for exclusion.

1.1.15 Reporting

Topics
Reporting Overview
Report File Content
Log File Size/Content
SNMP Options
Reporting
The options listed on this page can be accessed from the Reporting window. PeerSync
automatically generates Log Files providing a detailed history of all synchronization
events. This screen is used to view Log Files and set their reporting characteristics.
Use Log File

This feature enables or disables Log file generation. The default file, PeerSync.Log, is located in the path in which PeerSync has been installed. This field also supports File/Folder
Path Variables and when used the current path will be displayed above the field.

Overwrite Existing Log
File

Use this feature to report only the most recent PeerSync activity in the Log File. If this feature is not selected, all PeerSync
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processes will be reported in succession.
View Log File

This button allows you to view Log reports by opening the file
in a text editor.

Clear Log File

This button allows you to clear Log reports.

Reporting File Content
The options listed on this page can be accessed from the Reporting window. Using the
check boxes provided in this section of the Reporting screen, you can specify what will be
reported in the Log File. The Default setting is to include all items except Folder Names.
Added Files

This feature adds an entry for any file that has been added to
the Target.

File Date

Includes date associated with each file contained in the Log.

File Size

Includes size of each file contained in the Log.

Updated Files

This feature adds an entry for any file that has been updated in
the Target.

File Time

Includes time associated with each file contained in the Log.

Transfer Time

Includes time it takes to transfer the file in milliseconds.

Summary

Appends a summary of activity to the end of the report.

Folder Names

Indicates the names of synchronized folders.

Folder Creation

This feature creates an entry for any folders that did not exist in
the Target and had to be created during the synchronization
process.

Messages

This feature logs any messages or application errors found
during synchronization.

Exceptions

This feature logs any file/folder exclusion found during synchronization.

ACLs

This feature logs any file/folder ACL updates during scans and
real-time.

Note: Application errors are additionally written to a file called "PS Error.log," regardless of whether or not that option has been selected.

Log File Size/Content
The options listed on this page can be accessed from the Reporting window.
Set the maximum log file
size to x bytes

By entering an amount into this field you can limit the size of
Log Files created by PeerSync. When this limit is reached, the
next reporting session will first rename the existing file to
FILENAME.BAK1.Log and then create a new, blank Log File to
which subsequent data will be added. Two backups
FILENAME.BAK1.Log and FILENAME.BAK2.Log will be kept
for each unique Log file.
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Unicode content

This option will enable the reporting of Unicode content.

SNMP Options
The options listed on this page can be accessed from the Reporting window, available only
with the Enhanced Package.
Use SNMP reporting (errors only)

Use Simple Network Management Protocol error reporting.

SNMP Options Button

This button opens the SNMP Options dialog box. Once this
box has opened, it allows you to select the Destination IP and
Trap Prefix to be used for SNMP reporting. Please refer to your
SNMP management software for more details.
Note: To properly use the installed mib file you need to rename
the psi_def.mib to psi.mib.

Note: Features described on this page require the Enhanced Package.
1.1.16 Admin Reporting

Topics
Admin Reporting Overview
Report File Content
Report File Name
Report File Path
Admin Report Cycle Options
Advanced Settings
Admin Reporting

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

92

The options listed on this page can be accessed from the Admin Reporting window. This
screen allows you to create a unique report for administration purposes. Admin Reports
generated during sync operations can be saved to a specific administrative folder (in a
local or network path). Admin Reports are made uniquely identifiable through a choice of
naming conventions, (i.e. Computer Name or User Name with date\time stamps).
Create administrative report files

This feature enables or disables the Administrative Reporting
feature.

Note: Admin reporting files do not display Unicode characters.

Report File Content
The options listed on this page can be accessed from the Admin Reporting window.
Summary/Messages only Appends a summary of activity to the end of the report. This
option will also log messages.
Standard report file content

This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files.

Messages only

Only reports messages and application errors.

Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary
is selected.

Report File Name
The options listed on this page can be accessed from the Admin Reporting window.
Report file name

Allows you to choose between a "Local Computer" or "LoggedOn User" Administrative Report. The reports will bear the selected name as a prefix, followed by the created date and time
of
the
Report
(i.e.
COMPUTER111507172625011_00001.RPT).

Report File Path
The options listed on this page can be accessed from the Admin Reporting window.
Report file path

This field displays the location of Admin Report files. This field
also supports File/Folder Path Variables and when used the
current path will be displayed above the field.

Admin Report Cycle Options
The options listed on this page can be accessed from the Admin Reporting window.
Create a report for every
event

This option allows for a report to be generated on every event
(Add/Update/Delete/Message).

Create a report on an interval

This option allows for a report to be generated at a specific interval. You may specify the interval from the input field to the

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

93

PeerSync Help

right of this option.
Create a report once a
day

This option allows for a report to be generated once a day. You
may specify the time of the day from the input field to the right
of this option.

Create a report once a
week

This option allows for a report to be generated once a week.
You may specify the day of the week from the drop down list to
the right of this option.

Only use Advanced Settings

This option allows for a report to be generated based on the
configuration of the Advanced Settings only.

Advanced Settings
The options listed on this page can be accessed on the "Advanced Settings" button from
the Admin Reporting window.
At the start of this Profile

This option allows for a report to be created at the start of the
Profile.

At the stop of this Profile

This option allows for a report to be created at the stop of the
Profile.

For each individual error
message as it occurs

This option allows for a report to be created for each error.

After each scan (log all
non-scan events on the
cycle specified)

This option allows for a report to be created once a day. You
may specify the time of the day from the input field to the right
of this option.

After each scan/cycle
even if no events occurred

This option allows for a report to be created after each scan
even when no events occurred.
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1.1.17 E-mail Reporting

Topics
E-Mail Reporting Overview
Report File Content
Report File Name
Email Configuration
Email Report Cycle Options
E-Mail Reporting
The options listed on this page can be accessed from the E-Mail Reporting window. This
screen allows you to create a unique report for administration purposes. E-mail Reports
generated during sync operations can be sent to an administrator, shared mailbox or a
specified user. E-mail notification of synchronization activity can be sent upon completion
of entire Profile or during persistent synchronization operations. E-mail Reports are made
uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or User
Name with date\time stamps).
Create administrative Email messages

This feature enables or disables the E-mail Reporting feature.

Note: E-mail reporting messages do not display Unicode characters.

Report File Content
The options listed on this page can be accessed from the E-Mail Reporting window.
Summary/Messages only Appends a summary of activity to the end of the report. This
option will also log messages.
Standard report file con-

This feature directs Report content to follow those conventions
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tent

also utilized in PeerSync Log Files.

Messages only

Only reports messages and application errors.

Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary
is selected.

Report File Name
The options listed on this page can be accessed from the E-Mail Reporting window.
Report file name

Allows you to choose between a "Local Computer" or "LoggedOn User" Administrative Report. The e-mails will bear the selected name as part of the Subject filed. For example: "PeerSync Summary Report for COMPUTER (PeerSync Started)".

E-mail Configuration
The options listed on this page can be accessed by clicking on the "Email Configuration"
button from the E-Mail Reporting window.
Attach log files

Allows you to attach the reporting section log file to e-mails
generated by this application.

Delete after successful Deletes the log file after a successful e-mail attached send.
send
E-mail Configuration But- This button opens the Email Configuration dialog box: Once
ton
this box has opened, it allows you to select the SMTP Host,
User ID, Port, who to send to, and who to send Carbon Copies
to and what e-mail address to send from.
SMTP Host
The host name or IP address of the SMTP mail server to send
alert emails to.
User ID
The username to authenticate with the SMTP mail server. This
is normally not needed. (Optional)
Port
TCP/IP connection port. It is recommended that you leave the
default setting unless your email server requires otherwise.
To
The email address of the person who is to receive the email.
This user sometimes needs to be a valid user on the SMTP
mail server. You may add multiple email addresses in this
field. Use a semicolon (;) as a delimiter.
CC
The email address of the person who is to receive a Carbon
Copy of the email. You may add multiple email addresses in
this field. Use a semicolon (;) as a delimiter.

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

96

From
The email address that will appear in the From field of the
email. This e-mail does not need to be a valid e-mail. For example it can be used to identify the Job that generated the email by using the %JobName% variable (i.e. %JobName%
@MyCompany.com).
Send Test Email
Clicking on the Test Connection button will send a test email to
the configured email address(es) and let you know if PeerSync
was able to successfully connect and send an email via the
configured SMTP mail server. It is highly recommended that
you test the configuration before saving the options.
E-mail Report Cycle Options
The options listed on this page can be accessed from the E-Mail Reporting window.
Create a report for every
event

This option allows for an E-mail to be sent on every event
(Add/Update/Delete/Message)

Create a report on an interval

This option allows for an E-mail to be sent at a specific interval.
You may specify the interval from the input field to the right of
this option.

Create a report once a
day

This option allows for an E-mail to be sent once a day. You
may specify the time of the day from the input field to the right
of this option.

Create a report once a
week

This option allows for an E-mail to be sent once a week. You
may specify the day of the week from the drop down list to the
right of this option.

Only use Advanced Settings

This option allows for an E-mail to be sent based on the configuration of the Advanced Settings only.

Send E-mail Reports
The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the E-Mail Reporting window.
At the start of this Profile

This option allows for an E-mail to be sent on every event
(Add/Update/Delete/Message).

At the stop of this Profile

This option allows for an E-mail to be sent at a specific interval.
You may specify the interval from the input field to the right of
this option.

For each individual error
message as it occurs

This option allows for an E-mail to be sent at a specific interval.
You may specify the interval from the input field to the right of
this option.

After each scan (send all
non-scan events on the
cycle specified)

This option allows for an E-mail to be sent once a day. You
may specify the time of the day from the input field to the right
of this option.

After each scan/cycle

This option allows for an E-mail to be sent after each scan
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even if no events occurred

even when no events occurred.

E-mail Report Content
The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the E-Mail Reporting window.
Send content in the body
of the E-mail

This option will write the content for the email report into the
body of the e-mail.

Send content as an attachment to the E-mail

This option will generate a file with the content of the e-mail report and attach the file to the e-mail.

Place content in a file
and send a link in the Email

This option will generate a file with the content of the e-mail report and a link to the file will be sent within the body of the email.

1.1.18 Compression

Topics
Compression Overview
Compression Options
Compress/Expand
Compression File Extension
Compression Speed
Password-Encryption
While compressing your choice of folders, the Compression utility also employs a unique
method to minimize file damage. While creating Target directory structures to match those
found in the Source, the folder compression option creates a single file for every folder conCopyright © 1993-2014 Peer Software Inc. All Rights Reserved
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tained within the Target Folder set. This minimizes the amount of data added to each compressed file. If a single file were used for the entire directory structure were to become corrupt, all files might be lost. PeerSync's "one file per folder" scenario ensures that if damage
occurs, it is limited to individual folders only. We also offer file compression, which will compress the Source Files to the corresponding Target Files down to the file level which adds
even more flexibility.
During folder compression, all selected Source Files are synchronized to the compressed
Target Folder file bearing the name of the active folder plus the user selected extension (default extension is "ZIP").
During file compression, all selected Source Files are synchronized to the compressed Target Folder file bearing the name of the active file plus the user selected extension (default extension is "ZIP").
Compressed folder files can be expanded using most PKZip compatible extraction utilities. In
addition, passwords can be specified and entered on this screen to protect against unauthorized access to compressed files.
Compression Options
The options listed on this page can be accessed from the Compression window.
Use folder compression

This check box enables or disables the folder compression feature which will compress files in each sub-folder to a single file
per sub-folder.
Notes:
1. Folder Compression may be ignored when using an FTP Source or FTP
Target.
2. Bi-directional, Transfer NT security descriptions (ACLs), Move unmatched
target files, Force target file attribute settings, Use intermediate file during copy
and Revisioning, as well as, other non applicable features may be ignored
when using Folder Compression.

Use file compression

This check box enables or disables the file compression feature will compress file by file.
Notes:
1. File Compression may be ignored when using an FTP Source.
2. Bi-directional, Transfer NT security descriptions (ACLs) and Move unmatched Target Files, as well as, other non applicable features may be ignored when using Folder Compression.

Compress/Expand
The options listed on this page can be accessed from the Compression window.
Compress target

Selecting this feature enables compression of the Target
Folder.

Expand source

This feature extracts (expands) the Source folder. Use this feature to extract files from Source Folders that have already undergone compression.
Note: This option is not supported when using a TCP target.
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Note: A compressed Source Folder can not be synchronized to a compressed Target Folder.

Compression File Extension
The options listed on this page can be accessed from the Compression window.
Compressed File Extension

The extension entered into this field will be applied to the compressed folder file name. For example, if "rar" is entered for a
folder named "Samples," the compressed folder file name will
be "Samples.rar."

Note: it is NOT necessary to add a period (" . ") before this extension name. The default extension is "ZIP," which
associates the file with a Zip application (i.e. WinZip).

Compression Speed
The options listed on this page can be accessed from the Compression window.
Compression Speed

This setting allows you to set the compression speed and level
of compression. You may choose from "Normal" compression,
"Maximum" compression or "Maximum speed".

Encryption
The options listed on this page can be accessed from the Compression window.
Password - Encryption

The password entered into this field will be used as a key to
encrypt the compressed files. Without this key the original file
CAN NOT be extracted from the compressed files. Do Not
Lose This Password. Without it you will not have access to
your encrypted files, nor will Peer Software be able to recover
them.

Change Password

Selecting this button will display the Password Change dialog
box. This allows you to change your existing password for the
selected Job. This box requires you to enter your old password
in addition to whichever new one you wish to begin using. This
dialog box is also used to create a password if you do not currently have one. The password will be encrypted and saved for
the selected Job.

Note: You may only change the password for a single Job at a time. The old password must be checked against the
stored password for this feature to be changed.
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1.1.19 Pre/Post Process

Topics
Pre/Post Process Overview
Pre/Post Process
The options listed on this page can be accessed from the Pre/Post Process window. This
screen allows the user to choose external applications / scripts to be run before and after
the processing of a given Job.
Before

Use this field to specify (by file path) which application or script
you would like to run before processing a Profile. File paths
can be manually entered, or the open folder icon can be used
to locate files. You may also use pre defined configuration
commands. See our support page for a list of available options.

After

Use this field to specify (by file path) which application or script
you would like to run after processing a Profile. File paths can
be manually entered, or the open folder icon can be used to
locate files. You may also use pre defined configuration commands. See our support page for a list of available options.

Wait for application to
end before continuing

Check this feature if you want PeerSync to wait for the applications specified in the "Before" and "After" fields to close before
processing additional tasks.

Use maximum wait time
of x seconds

Selecting this feature sets a limit (in seconds) for how long
PeerSync will wait for the applications specified in the "Run
Before" and "Run After" fields to close. In order to activate this
function, the "Wait for Application to Terminate" function must
be checked. The default, when this feature is not checked, is to
wait indefinitely.
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1.2 Advanced Options

Advanced Options
Migrate Shares
NetApp Settings
Global Migrate Shares Options
Global Advanced File Xfer Options
1.2.1 Migrate Shares

Migrate Shares
The following settings can be accessed from the Advanced Options window.
Add Shares: Do Not Update or Delete

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are left on
the target.

Match Shares: Add, Update and Delete

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are removed.

Replace Shares: Add
and Overwrite

Copy shares from the source folder to the relative target folder,
where existing matching shares on the target system are overwritten.

Add Shares with the selected Prefix

Copy shares from the source folder to the relative target folder,
with the selected prefix.

Add Shares with the selected Suffix

Copy shares from the source folder to the relative target folder,
with the selected prefix.
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1.2.2 NetApp Settings

NetApp Settings
The following settings can be accessed from the Advanced Options window.
Source Configuration

Provide the Username and Password log on settings for the
Source cDOT system. Optionally, the Management IP address can also be provided. Click the Get Info button to validate the source system information. These settings are necessary if trying to Migrate Shares from a cDOT source system.

Target Configuration

Provide the Username and Password log on settings for the
Target cDOT system. Optionally, the Management IP address
can also be provided. Click the Get Info button to validate the
target system information. These settings are necessary if trying to Migrate Shares to a cDOT target system.

1.2.3 Global Migrate Shares Options

Global Migrate Shares Options (For All Jobs with Migrate Shares Enabled)
The following settings can be accessed from the Advanced Options window.
Process Migrate Shares
after each scan

If the Migrate Shares option is checked, this setting will process the selected share migration setting after each scan.

Process Migrate Shares
every x minute(s)

If the Migrate Shares option is checked, this setting will process the selected share migration setting every x minutes.

1.2.4 Global Advanced File Xfer Options

Global Advanced File Xfer Options (For All Jobs)
The following settings can be accessed from the Advanced Options window.
Admin Backup

Provides the ability to replicate files and folders that are denied
access because of their current ACL settings.

Advanced Backup

Select this option to replicate files such as Symantec Enterprise Vault stub files or files/folders which may be Reparse
Points, Sparse, Offline, Stub Files, etc.

Alternate Data Stream
(ADS) Backup

Replicate hidden Alternate Data Streams (ADS) which may be
stored behind a filename.
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1.3 PeerSync Global Settings

PeerSync Global Settings
Global Recovery/Offline Options
Global Performance Options
Global ACL Options
Global Bi-directional Options
Global Managed Files Options
Current Command Line Argument Selection
Options/Commands
1.3.1 Global Recovery/Offline Options

Retry Open and Inaccessible Files
The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options > "Global Settings" > "Global Recovery/Offline Options"
menu.
Retry open/inaccessible
files every x seconds

Use this feature to specify, in seconds, how often PeerSync
will attempt to synchronize Source Files that are in use. If the
"Include open files" option on the File Options screen has not
been checked and "Retry" is selected, PeerSync will continue
attempting to synchronize files that are opened by other applications. "Retry" will also work when "Include open files" has
been checked and a file is read-locked by another application.
When the "Retry" option is on, PeerSync will synchronize the
open file within x seconds after the file has been closed.

Set maximum number of
retries to x

This feature sets a limit indicating how many times to attempt
to process open files. If the maximum number of retries gets
exceeded for a particular file PeerSync will remove it from the
retry-list until another real-time event occurs on the file or a

Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

PeerSync Help

104

scan detects that the file needs to be added/updated. Setting
the retry cycle to 0 will check the file indefinitely.

Failed Connection Options
The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options > "Global Settings" > "Global Recovery/Offline Options"
menu.
Retry failed connections
every x minutes

PeerSync monitors persistent Jobs (Real-Time, scheduled, interval) for connectivity, and suspends the Job until a connection is resumed. This allows PeerSync to ensure that synchronizations are only attempted when a connection exists. This feature is set by default to a 1 minute interval and can be modified
or disabled.

Run a scan on reconnect
(if needed)

This feature will initiate a full scan at reconnect to process any
file/folder changes which may have occurred during the connection failure. A scan will be performed only if a failure occurs
in the middle of scan or if a scan was missed when the connection was lost.

Store missed events and
process on reconnect

This feature pertains to any Job running in a Real-Time mode.
Having this option enabled will store Real-Time events during
failed connections and will process these events at Reconnect,
eliminating the Source/Target Folder scan.

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
1.3.2 Global Performance Options

Global Performance Options
The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more information on this topic.
Set Application Priority

If this feature is selected, an icon will appear on the system
tray when PeerSync is loaded. When you right/click on this
icon a menu will appear. Through this menu the Profiler can be
shown, the About PeerSync screen can be accessed, and
PeerSync can be terminated. Once this dialog has opened, it
gives you the ability to Set the Application Priority allowing
PeerSync to run at a higher or lower priority then other applications.

Use Multiple Job
Threads / Set maximum
number of Job threads to
x (Multi Threading)

This option is accessible with the Multi-Threading add-on module available for the Server version of PeerSync only. Enable
this option to allow multiple Job threads to be used for parallel
processing of Jobs. Without this feature each Job will run se-
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quentially in the order it is listed, scheduled to run, or in the order that events are received.
Use Multiple Copy
Threads / Set maximum
number of Copy threads
to x (Multi Threading)

This option is accessible with the Multi-Threading add-on module available for the Server version of PeerSync only. Enable
this option to allow multiple Copy Threads to copy multiple files
in parallel processes (i.e. Simultaneous Distribution - Synchronizing from one server to multiple servers simultaneously
in a Web Farm type environment).

Use Enhanced Event
Processing

This option provides the ability to parallel process real-time,
retry or any other non-scan events. Enabling this feature will
improve the speed of synchronization during real-time or any
other non-scanning scenarios.

Exclude Common Job
Exceptions in Event Processing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list.The command line argument for this option is /
QR.

Notes:
1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
2. Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.
3. Using Multiple Job Threads will produce a different file output format for all modes of reporting and message logging (Reporting, Admin Reporting and E-mail Reporting). The output will NOT contain a start and stop section or a
summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for Admin or Email reporting then the standard selection will be used. The reason this is done is due to the fact that processes will be running in parallel.
4. We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your
threads over this limit may lead to potential operational issues. We strongly discourage the use of more then 50
threads, however, you do have the option to exceed this limit by placing a greater than symbol ">" before your desired thread value (maximum allowed is 200). We recommend you test your setting to ensure PeerSync continues to operate acceptably in your environment.
5. The Include open files (if possible) option should be used if you are using the Performance Options: Multiple Job
Threads and Multiple Copy Threads.
6. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.
1.3.3 Global ACL Options

ACL Options
This screen is activated by clicking on the Global Settings link located to the right of the
ACL Options button in the Miscellaneous window as well as from the PeerSync Global Settings window or the Options menu. This window has the following features:
Monitor ACL changes
during real-time
Check for ACL changes
during scans

This global feature will enable Real-Time monitoring to detect
and process ACL changes.
This global feature will validate and apply ACLs during folder scans.
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Notes:
1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
2. Folder security checks occur during scans and folder create only.
3. For real-time detection of ACLs for empty folders or folders that contain files for which inheritance is disabled add
the /LG1 option to the command line argument.
4. If you enable or disable Inheritance at the folder level, these changes will only get replicated during a scan.
1.3.4 Global Bi-directional Options

Global Bi-directional Options
This screen is activated by clicking on the Global Settings link located to the right of the Bidirectional option in the File Options window as well as from the PeerSync Global Settings
window or the Options menu. This window has the following features:
Always create a superset during bi-directional
synchronization

This feature will alter the way the Enable bi-directional synchronization mode option functions by always creating a superset of the data on the source and target. In this mode folders
and files will always be added and not deleted.

Use enhanced bi-directional synchronization
mode options

This feature will alter the way the Enable bi-directional synchronization mode option functions by using enhanced features to track all file and folder adds, updates, deletions, renames and moves between scan cycles. In this mode, PeerSync will use a hidden system trigger file within each subfolder to store information about the last scan cycle for that
sub-folder. Using this trigger file, PeerSync can determine if a
Folder was added, deleted, renamed or moved since the last
scan.
Note: This feature is not supported when using the Enhanced Scanning
option.

Notes:
1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
2. Please refer to our White Papers page for step-by-step tutorials to achieve real-time or scheduled bi-directional
synchronization.
3. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing
standard or enhanced bi-directional synchronization) we recommend you add /YO- and /QYD:0 to your list of
command line arguments. These options will ensure that during standard or enhanced bi-directional synchronization, deleted files from one side are not re-added by the other side. These arguments should NOT be used if there
are more than two machines involved in a bi-directional synchronization.
1.3.5 Global Managed Files Options

File Manager Interval
Copyright © 1993-2014 Peer Software Inc. All Rights Reserved

107

PeerSync Help

By clicking on the Global Settings link from the Managed Files window you will be able to
configure the File Manager Interval option. Alternatively you can access this screen from
theGlobal Settings window or from the Options menu.
PeerSync uses the Volume Shadow Copy Service (VSS) in order to allow synchronization
of open/locked files. In order to enable this feature you will require the Managed Files addon module. Developed by Microsoft, VSS is a storage management framework designed to
create a point-in-time copy/snapshot of a volume. This method works well with applications
that are VSS compliant. VSS does not support Novell NetWare systems.
Run Managed Files List
By default the Managed Files is set to run on an interval of 120
Manager every x minutes minutes. This interval may be changed by simply changing the
interval time. By default, Managed Files will run at the end of
the initial scan if Scan Job once at start is enabled. Subsequent open and locked files detected in real-time or during
scans will be thrown into the Managed Files list to be processed based on the Managed Files interval.

Notes:
1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
2. These options require the VSS add-on module. Please visit http://www.peersoftware.com or contact Sales for additional
information.
3. The minimum Managed Files interval is 30 minutes.
4. This feature only works for local Source folders and will be ignored with an FTP Source.
5. This feature may be ignored when using an FTP Target in conjunction with File Compression.
6. This feature may be ignored when using Folder Compression.
1.3.6 Current Command Line Arguments

Global Command Line Arguments List
From the Options/Commands window, double-clicking on the "Command Line Arguments"
filed or selecting the button to the right of it will open the Command Line Arguments dialog.
The Command Line Arguments dialog can also be accessed from the PeerSync Global
Settings window as well as from the Options/Commands window or the Options menu.
Command Line Arguments

In this dialog you can modify, add or delete arguments to be
used when launching PeerSync through any of the modes described in the Startup/Service screen or via the Run/View Current Profile Activity screen. This dialog displays the current arguments selected for the Profiler and will also allow for the selection and modification of additional Command Line Arguments by double-clicking this field or selecting the Current Arguments Button to the right of the field.

Note: These settings are Global. Global Settings are global to the current Profile. These settings and options pertain
to all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
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PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
1.3.7 Options/Commands

Topics
Display/Reporting Options
Performance Options
Command Line Arguments
Profiler Options
Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.
Enable Basic Display

This feature will have PeerSync open the Profiler, if it is not
already open, and send status messages to be displayed on
the Run/View PeerSync screen.

Enable Advanced Display

This option activates the Show Advanced Display link at the
bottom right corner of the Run/View PeerSync screen. When
this link is clicked, the PeerSync Advanced Display panel will
be shown. The advanced display contains a Jobs Stats panel
on the top and an Advanced Run/View PeerSync panel at the
bottom. The command line argument to disable this option is /
QQ<<.

PeerSync Options (Application Runs Only)
Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.
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Display status in PeerSync

This feature will show the PeerSync Status Display dialog box
during synchronization to view activity, status and other information while PeerSync is running.

Display status in PeerSync upon completion

This feature will have PeerSync pop-up the PeerSync Status
Display dialog at the end of synchronization (only in non-persistent modes) to view activity, status and other information
upon completion.

Profiler/PeerSync Options
Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.
Job Stats

This feature allows for the Jobs Stats panel in the PeerSync
Advanced Display to get updated. Use /QP to disable this option via the command line.

Job Scans

When enabled, this option adds a Job Scans tab to the Advanced Run/View PeerSync panel. This table lists Base/Root,
Enhanced/Expanded, and RT/Sub-folder scans with statistics
and progress for all the Jobs or only the selected Job. The
command line argument for this option is /Q8BJ+.

File Copy Progress

This feature will show the progress of a file transfer in the
PeerSync Status Display or the Advanced Run/View PeerSync panel. This feature requires the Multi-Threading Option.
The command line argument for this option is /QQ.

Historical Data

When enabled, this option adds a Historical Data tab to the
Advanced Run/View PeerSync panel. This tab contains a subset of data from the PeerSync Jobs Stats panel (Xfer Rate,
Bytes and Event Averages) and is broken down into total,
hourly, daily, and weekly statistics for all the Jobs or only the
selected Job. The command line argument for this option is /
Q8BH+.

Peer Administrator Options
Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.
Send status information
to Peer Administrator

This will send statistical information about the current Profile to
the Peer Administrator if it is installed/available. This utility allows for the ability to monitor PeerSync activity across the LAN
for the centralized viewing of all PeerSync activity on the network.

Related Options
Performance Options
Command Line Arguments
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Notes:
1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/Commands
screen.
2. Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or contact Sales for additional information.

2. PeerLock
2.1 PeerLock Job Settings

Topics
PeerLock Job Settings Overview
2.1.1 PeerLock Job Settings Overview

PeerLock Job Settings
If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerLock directly from the PeerSync Profiler. The following options allow you to link the selected Job to PeerLock as well as append the PeerSync exceptions to PeerLock. The options in this window can be accessed from the PeerLock >
PeerLock Job Settings window.
Include this Job in PeerLock

Select this checkbox to automatically add the selected Job to
PeerLock. This option can be enabled automatically when selecting the Bi-directional setting. In general PeerLock is used in
a collaboration environment where PeerSync is configured for
real-time bi-directional synchronization.

Append Default File/

This option is enabled by default. When checked, the Peer-
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Folder Exclusions from
PeerLock

Sync Exception settings (Include Files, Exclude Files, and Exclude Folders) will be appended to the default/existing list of
Exceptions in PeerLock.

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e.
%UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will not work in PeerLock.

2.2 PeerLock Global Settings

Topics
PeerLock Global Settings Overview
2.2.1 PeerLock Global Settings Overview

PeerLock Global Settings
If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerLock directly from the PeerSync Profiler. The following options allow you to add the selected PeerSync Jobs to PeerLock and launch the PeerLock
application or Global Options for configuration. The options in this window can be accessed from the PeerLock > PeerLock Global Settings window.
Link this Profiler to PeerLock

If this global setting is enabled, all the Jobs that have the "Include this Job in PeerLock" option selected will be added to
PeerLock. These Jobs in PeerLock will be managed by PeerSync and cannot be edited/removed directly from the PeerLock
interface. Un-checking this option will remove all PeerSync
managed Jobs from the PeerLock interface.

Disable Jobs that are Not Selecting this option then saving the PeerSync Profiler or clickConfigured from this Pro- ing on the "Save Changes in PeerLock" link will remove/delete
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filer

any existing Jobs from the PeerLock configuration. Only Jobs
that are managed by PeerSync will be maintained.

Save Changes in PeerLock

Click on this link to commit your PeerSync Job/Profile updates
to PeerLock. This link becomes available when you make Job
or Profile changes that need to be saved and applied to PeerLock (i.e. Source/Target path update, Exceptions, ...). This can
be achieved also by clicking on the Save button from the Toolbar or File Menu. If there are no Profile updates to be saved,
this link will be unavailable.

Global Options

Selecting this link will open the PeerLock Global Options dialog that contains the configuration settings for all the Jobs in
PeerLock. When the application is terminated/closed this link
will become available.

Show PeerLock

You can run PeerLock as an application or as a service. Clicking on this link will launch the PeerLock interface where you
can start PeerLock to run as an application or as a service.
You can also start/stop the PeerLock service directly from the
PeerLock Run/View window in the PeerSync Profiler.
Through the PeerLock interface you will be able to view the
files that are Locked or Released by PeerLock when it is running as an application. This status information is not available
when PeerLock is running as a Service. The PeerLock Jobs
that are managed by PeerSync will be un-editable. When the
application is terminated/closed this link will become available.
Note: You will need the Peer Administrator product In order to view the PeerLock status while running as a service.

Notes:
1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile.
2. PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %
UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will not work in PeerLock.
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3. Startup/Service
3.1 PeerSync Startup/Service

Topics
PeerSync Startup/Service Overview
3.1.1 PeerSync Startup/Service Overview

PeerSync Startup/Service Options
The options in this window can be accessed from the "Startup/Service" > PeerSync Startup/Service window. This screen allows the user to specify whether or not PeerSync will be
run upon startup of the active PC, while also defining its interaction with the network (if applicable). This screen provides shortcuts for installing PeerSync as a service, adding it to
the Windows StartUp list, or to the Windows registry for automatic loading upon startup.
Disable all Startup Options

Check this feature to prevent PeerSync from automatically
loading at Windows startup/logon.

Create Shortcut on
Desktop

This button will place the current Profile into a shortcut on your
desktop (See "Scan at Start of Profile List," Options/Command). A Profile Shortcut will need to be created through this
feature in order to use PeerSync's Command Line Mode.

Add to Windows StartUp

This button opens the Windows StartUp folder, showing links
to files and programs that open automatically upon user logon.
This button is only accessible when "Add to Windows Startup
Folder" is checked.

Add to Windows registry

Check this feature if you want PeerSync to run automatically
when Windows boots through specification in the Windows registry.
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Run RegEdit

This button opens the Windows Registry Editor. This button is
only accessible when "Add to Windows registry to run at boot"
is checked.

Install as an NT Service

Check this feature if you want PeerSync to run automatically
as a service under Windows NT. Click here for a Tutorial on
how to install PeerSync to run as an NT Service.
To configure and run the service you must go to "Services" located in the "Control Panel" and select "PeerSync Professional
Series Software." By default the service is installed with the
"Local System account" selected for the service "Log on as:"
option.
Caution: If any of your Source or Target Folder Selections are not located on
the local machine, then you will have to configure the service to "Log on as:"
an alternate (Domain Admin) account on your domain so that the service has
the rights to access the remote machines and/or devices. If you do not do this
the service may not run properly.
Notes:
1. If PeerSync is running as a Service it is advised to use UNC paths or PeerSync's Dynamic Network Drive Mapping and Unmapping feature instead of
using mapped drives do to the fact that mapped drives are not understood
when a user is not logged on.
2. You can add the argument /LSE (Log Service Events to NT Application Log)
to the following entry in the registry (HKEY_LOCAL_MACHINE\Software
\PeerSoftware\PeerSync\Service\Parameters). This will have PeerSync log
all changes to be reported to application log in addition to the normal logging
of the start, stop, pause and continue of the service.
3. If PeerSync is running in Real-Time mode as a service, subsequent realtime Profiles will interfere with service operation and should not be employed. Both Scheduled Operations and Manual (non-persistent) operations
should perform without interference to a service installation of PeerSync.

Details

This button is used to view the details of the currently installed
PeerSync service.

Remove

This button is used to remove the currently installed PeerSync
service.

Create SNC extension
association for Profiler

Checking this feature causes any file with the extension .SNC
to be associated with PeerSync: PeerSync Profiles bear this
extension by default. Once this feature has been selected,
double/clicking on any SNC file will open Profiler and load that
particular file.

Add Quick-Sync Folder
option to Explorer menu

Checking this feature adds or removes the Quick-Sync Folder
selection from Windows Explorer. This feature is a quick and
easy way to synchronize folder(s) on the fly to backup location(s) with the option to modify your Job settings at a later
time.

PeerSync Application
Path

This field is used to specify the location of the PeerSync executable file. You can use the open folder icon to browse
drives in order to locate this executable file.
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Starting Profiles
The following describes ways in which PeerSync can be launched or started.
From the Profiler

By using the Launch Profile Menu Item in the Run Menu
By using the Launch Current Profile button on the Tool Buttons
Toolbar
By using the Launch Current Profile button on the Run/View
Current Profile Activity screen

Externally without the
Profiler

Setup/run from a Shortcut on the Desktop
Setup/run from the Startup Folder
Setup/run at boot from the Registry
Setup/run as a NT Service
Setup/run using the Windows Task Scheduler

Notes:
1. Individual Jobs can be synchronized using the 'Synchronize Selected Jobs' feature, found in the Profile Job List
Popup Menu.
2. Another way of running PeerSync is by using the Quick-Sync Folder feature by right-clicking on a folder from MS
Windows Explorer.

3.2 PeerLock Startup/Service

Topics
PeerLock Startup/Service Overview
3.2.1 PeerLock Startup/Service Overview

PeerLock Startup/Services Options
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If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerLock directly from the PeerSync Profiler. This window
provides a way in which you can install the PeerLock service directly from the PeerSync
Profiler interface. The options can be accessed from the "Startup/Service" > PeerLock
Startup/Service window.
Install PeerLock Service

Check this feature if you want PeerLock to run automatically as
a service under Windows NT. To configure and run the service
you must go to the Services window by clicking on the "Details"
> "Show Services" button and select "PeerLock Utility Software" item. By default the service is installed with the "Local
System account". If your Source or Target folder is not located
on the local machine, then you will have to configure the service to "Log on as:" an alternate (Domain Admin) account on
your domain so that the service has the rights to access the remote machines and/or devices. Otherwise the service may not
run properly.
Note: It is advised to use UNC paths if you plan to run PeerSync or PeerLock
as a Service do to the fact that mapped drives are not understood when a user
is not logged on.

Details

This button is used to view the details of the currently installed
PeerLock service.

Remove

This button is used to remove the currently installed PeerLock
service.

PeerLock Path

This field is used to specify the location of the PeerSyncPeerLock executable file. You can use the open folder icon to
browse drives in order to locate this executable file.

Note:
PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %
UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported
and will not work in PeerLock.
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4. Run/View
4.1 PeerSync Run/View

Topics
Basic Display
Advanced Display
4.1.1 Basic Display

Run/View PeerSync - Basic Display
PeerSync can be run as an Application or as an NT Service, if available and installed from
the Startup/Service screen.
This screen is used to launch the current Profile and to view current Profile activity. If the
Display Status in Profiler option is turned on from the Options/Commands screen this
screen will be shown upon execution of a Profile and will dynamically show the status of
synchronization of the current Profile as the process occurs. This screen will also be
shown upon using the Synchronize Selected Jobs feature, found in the Profile Job List
Popup Menu to display the Current Activity of the Jobs sent to PeerSync as a temporary
Profile.
Profile

Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently being configured through Profiler.

Job

This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode

This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Launch Current Profile/

This button allows you to launch the current Profile. Once a
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Terminate Active Profile

Profile has been launched, its processing may also be terminated through this button (the label will change to read "Terminate Active Profile"). This button offers one of three ways to
initiate an Automatic Operation.

View Active Profile

This button allows you to connect to and view the Active Profile.

Run as a service

If PeerSync is installed as a Service you have the option of
running it as an Application or as a Service from this screen.

Start/View Service

This button allows you to start the current Profile as a Service
or view the Active Profile.

Stop Service

This button allows you to stop the current Profile as a Service.

Pause Service

This button allows you to pause the current Profile as a Service.

Resume Service

This button allows you to resume the current Profile as a Service.

Source

Displays a file path for the Source Folder presently being synchronized.

Target

Displays a file path for the Target Folder presently being synchronized from the Source indicated above.

Folders

This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder
is synchronized. An additional "thermometer" indicator will
also track the progress of folder synchronization.

Files

This indicator displays the total number of files contained
within the Source while also providing a count of synchronized files. In addition, a "thermometer" indicator will show file
synchronization progress by increasing according to the size
of the current folder, with 100% representing the cumulative
size of files contained within the Source Job set.

File

Indicates the name of the file currently being synchronized.

Large File or Compression Status

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during compression. The caption will show the size of the file that has been
copied to the Target and/or compression status.

Skip File

This button will appear once the active Profile has been
launched. This feature allows you to skip synchronization of
the file currently displayed in the indicator described below.
Skip Files enables you to avoid delays caused by large files
on slow network or dial-up connections.

Size

Indicates the size (in bytes) of the file currently being synchronized. A related "thermometer" indicator tracks the progress of synchronization for that file.

Checked

This indicator displays the total number of files contained in
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the selected Source Folders.
Excluded

Indicates the number of files that were excluded from synchronization (See Exceptions).

Messages

Indicates the number of error messages generated during Profile processing.

Updated

Indicates the number of Target Files that were updated during
synchronization of Profile Jobs.

Added

Indicates the number of new files added to Target Folders during synchronization of Profile Jobs.

Deleted

Indicates the number of files deleted (or moved) during synchronization of Profile Jobs.

Current Job Status

This indicator displays the status of the active Job. The indicator may display one of the following: Blackout, Source/Target
disconnected (Job name), Connecting to Target Folder
(Folder), or Normal.

Pending Event Status

This indicator displays the number of pending items.The indicator may display one of the following: Pending Items (Events:
n) (Managed Files: x) or No Pending Items

Current Event Status

This indicator display the status of the events pertaining to
Job/Copy thread information or Job automation (such as next
scheduled interval, daily timer info etc.). The indicator may
display one of the following: Running Items (Job Scans: x)
(Copy Threads: y) (Failed Events: z)

Total Transferred

Indicates the the total amount of bytes transferred for the entire running Profile.

Elapsed Time

Indicates the amount of time that has elapsed during the current Profile activity.

Show Advanced/Normal
Display

Click on this link to toggle between the Normal and Advanced Run/View PeerSync panels.

Refresh

Click on this link to force a manual reload of the Run/View
PeerSync panel and the statistics that are being displayed.

4.1.2 Advanced Display

Jobs Stats
To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerSync window. The Enable Advanced Display option must be checked
in order for this link to be active. The Jobs Stats display is the top panel and contains
runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update
the bottom Advanced Run/View PeerSync panel. Click on the All Jobs entry to display all
the Job statistics, cumulatively, in the bottom panel.
#

Represents the automatically assigned Job number for each
Job. An icon represents the state of the Job (Green, Yellow,
or Red):
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Green

Running with no failed events

Yellow
Red

Warning state indicates the Job is running with
failed events
Failed connection and/or offline/stopped

Job Name

Lists the unique name for each Job.

Last Scan (Status: Duration)

Displays the date and time of the last scan along with a description of the scan state and duration. For example:
11/17/2011 4:28:31 PM (Completed Successfully: 00:06:05)

Xfer Rate

Determines the transfer rate in megabits per second for each
Job. Takes into account the Event Averages rate and Total
Transferred and Total Saved bytes (bottom right corner of
Run/View PeerSync) to determine the transfer rate for each
Job. The more events and the larger the average file size calculated in the Event Averages the more accurate the transfer
rate will be. This also shows a cumulative transfer rate for all
Jobs.

Bytes

Displays the total number of bytes that were transferred for
the specific Job or all the Jobs.

Events

Shows the total number of events detected for the Job or all
the Jobs as well as number of active events currently being
processed.

Event Averages

Displays the average number of events that occurred per
minute. The average size of the events are also noted.

Failed Events

Total number of failed events for the selected Job or all the
Jobs.

Status

Shows the status of each Job or all Jobs.

Added

Counter indicating the total number of files that were added
and their size in bytes.

Daily Timer Scans

Information when the next scheduled scan is to occur.

Deleted

Counter indicating the total number of files that were deleted
and their size in bytes.

Excluded

Counter indicating the total number of files that were excluded
and their size in bytes.

Interval Scans

Information when the next interval scan is to occur.

Log File Path

Displays the location of the log file. Used in pop-up menu.

Messages

Counter indicating the total number of messages.

Next Scan (Run in)

Count down to the next scan for scheduled or interval scans.

Real-Time

Displays the state of Real-Time detection.

Scan Needed

Lets you know if a scan is needed (Yes) or not (No) after a
connection failure.

Souce

Displays the source path.
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Target

Displays the target path.

Updated

Counter indicating the total number of files that were updated
and their size in bytes.

Jobs Stats (Right-Click Pop-Up Menu)
To see this menu, right-click on the Job Stats panel.
Select Columns....

Add or remove columns from the Jobs Stats display.

View Log File

View the log file for the selected Job.

View Source Folder:
Path

Opens the source folder in a Windows Explorer window.

View Target Folder: Path

Opens the target folder in a Windows Explorer window.

Save As

Saves the current Jobs Stats list into a CSV file format (i.e.
PSJobStats.csv).

Reprocess Failed Events

If the Job is running in a Warning state (Yellow), the Job has
failed events. Selecting this option will notify PeerSync to reprocess any failed events. This option is also available in the
Run menu.

Advanced Run/View PeerSync
To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerSync window. The Enable Advanced Display option must be checked
in order for this link to be active. The Advanced Run/View PeerSync display is the bottom
screen. In addition to containing the same information as the Basic Display, the Advanced
Display contains the following additional tabs:
Status

Containing the same information as the Basic Display view/
panel.

Updated

Lists the total number of files that were updated for the selected Job or all the Jobs. Right-click and select Save As to export the list into a CSV file format (PSUpdated.csv).

Added

Lists the total number of files that were added for the selected
Job or all the Jobs. Right-click and select Save As to export
the list into a CSV file format (PSAdded.csv).

Deletions

Lists the total number of files that were deleted for the selected Job or all the Jobs. Right-click and select Save As to export the list into a CSV file format (PSDeleted.csv).

Excluded

Lists the total number of files that were excluded for the selected Job or all the Jobs. Right-click and select Save As to export the list into a CSV file format (PSExcluded.csv).

Messages

Lists the total number of messages for the selected Job or all
the Jobs. Right-click and select Save As to export the list into
a CSV file format (PSMessages.csv).
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Job Scans

Lists how many scans are running at a Job level either for the
selected Job or for all the Jobs. Right-click and select Save
As to export the list into a CSV file format (PSJobScans.csv).

Managed Files List

Lists the total number of files that are in the Managed Files
List for the selected Job or all the Jobs. Right-click and select Save As to export the list into a CSV file format (PSManagedFilesList.csv).

Failed Events

Lists all the failed files for the selected Job or all the Jobs. You
can right-click the list and select Reprocess Failed Events to
notify PeerSync to re-process them for all the Jobs (not Job
specific). To reprocess only a specific file, you can click the
Reprocess Selected button from the Failed Events tab
within the PeerSync Status Display (when running as an application only). Right-click and select Save As to export the
list into a CSV file format (PSFaileEvents.csv).

File Copy Progress

Visually displays the file copy progress for each file for the selected Job or all the Jobs. Right-click and select Save As to
export the list into a CSV file format (PSFileCopyProgress.csv).

Historical Data

This panel displays a subset of the Job Stats table (Xfer
Rate, Bytes and Event Averages) in an hourly, daily, weekly,
and total format for all the Jobs or only the selected Job. Furthermore, it displays a Running Event Count, a Running Event
Average and Peak Count, and a Running Job Count. Rightclick and select Save As to export the list into a CSV file
format (PSHistoricalData.csv).

Job Control

This tab is available from the Advanced Run/View PeerSync
panel. It shows the Job Control Bar which allows every Job to
be stopped, started, or restarted individually. In addition, this
tab displays all Pending Jobs in a grid from where they can be
individually selected and started. This tab can also be seen in
the PeerSync Status Display panel under the Job Stats and
Control tab.

Notes:
For efficiency purposes, only when you click on the screens/tabs within the Advanced Run/View PeerSync panel
will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary event
files that will be loaded into the advanced display screens/tabs.
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4.2 PeerLock Run/View

Topics
Basic Display
Advanced Display
4.2.1 Basic Display

Run/View PeerLock - Basic Display
If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will
now be able to configure PeerLock directly from the PeerSync Profiler. This window will allow you to start/stop/pause/resume the PeerLock service. Click here for information on how
to install the PeerLock service or run PeerLock as an application. The following options can
be found in the Startup/Service window.
Launch PeerLock

This button allows you to launch the PeerLock application and
monitor the files that are Locked or Released by PeerLock.
When the application is terminated this button will become
available.

Run as a service

This option is available only if the PeerLock service has been
installed and the Run as a Service option is enabled. Check
this option to run PeerLock as a Service. When checked, you
will have the options to Start, Stop, Pause and Resume the
Service. Uncheck the "Run as a service" option run PeerLock
as an Application. When this option is uncheck you will have a
"Launch PeerLock" button available.

Start Service

This button allows you to start PeerLock as a Service. This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock service is stopped or not running.
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Stop Service

This button allows you to stop the PeerLock Service. This option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock service is running.

Pause Service

This button allows you to pause the PeerLock Service. This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock service is running.

Resume Service

This button allows you to resume the PeerLock Service. This
option is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock service is paused.

Show Advanced/Normal
Display

Click on this link to toggle between the Normal and Advanced Run/View PeerLock panels.

Refresh

Click on this link to force a manual reload of the Run/View
PeerLock panel and the statistics that are being displayed.

4.2.2 Advanced Display

Jobs Stats
To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerLock window. The Enable Advanced Display option must be checked in
order for this link to be active. The Jobs Stats display is the top panel and contains
runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update
the bottom Advanced Run/View PeerLock panel. Click on the All Jobs entry to display all
the Job statistics, cumulatively, in the bottom panel.
#

Represents the automatically assigned Job number for each
Job. An icon represents the state of the Job (Green, Yellow,
or Red):
Green

Running with no failed locks

Yellow
Red

Warning state indicates the Job is running with
failed locks
Failed connection and/or offline/stopped

Job Name

Lists the unique name for each Job.

Locks (Active)

Represents the total number of locks created by the specific
Job. The total number of locks that are actively being held are
also shown.

Releases

Shows the total number of releases created by the specific
Job.

Lock Average

Represents the number of locks that are created on average
ever minute for the specific Job.

Release Average

Represents the number of locks that are released on average
ever minute for the specific Job.

Failed Locks

Shows the total number of locks that failed to be created for
the specific Job.
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Status

Displays the status of the Job (i.e. Stopped, Starting and
Normal).

Source

The folder which is monitored for open activity.

Target

The folder which is contains the files for PeerLock to lock.

Jobs Stats (Right-Click Pop-Up Menu)
Select Columns....

Add or remove columns from the Jobs Stats display.

View Log File: Path

Open the log file in the default editor for the selected Job.

Open Source Folder:
Path

Opens the source folder in a Windows Explorer window.

Open Target Folder:
Path

Opens the target folder in a Windows Explorer window.

Save As

Saves the current Jobs Stats list into a CSV file format (i.e.
PLSelectionList.csv).

Advanced Run/View PeerLock
To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerLock window. The Enable Advanced Display option must be checked in
order for this link to be active. The Advanced Run/View PeerLock display is the bottom
screen. In addition to containing the same information as the Basic Display, the Advanced
Display contains the following additional tabs:
Target File Path

Shows the file name complete with folder path for a target file
that is locked, if the file exists and/or can be locked.

Locked

Display the date/time when the target file was locked.

Duration

Displays the amount of time that the source file has been
opened.

Accessed By

The name of the user who has opened the file or accessed
the resource.

Target Access Allowed

Displays the permissions that are allowed on the opened target file which are applied by PeerLock.

Source File Path

Displays the file name complete with folder path for the source
file that has been detected as an open file.

Job Number

Represents the automatically assigned Job number for each
Job.

# Locks

Displays the number of locks on the source.

Application

Displays the application that has been detected as opening
the source file.
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Detection Type

This column represents the PeerLock detection mode used to
detect what source files are locked/opened. This will either be
File Server Mode Detection or Local Detection.
Note: Starting with version 3.0, PeerLock supports File Server
Mode Detection only.

Idle Time

Shows the amount of time the target file will remain locked
once the source file has been released. When the source file
is closed PeerLock will wait the number of Idle Time seconds
specified before releasing the target file. During the Idle Time
period the file entry in the Locked list will be highlighted Yellow. The Idle Time value can be set in the Release Options
dialog. This feature is intended to protect the releasing of files
during file opens and saves. Certain applications may temporary release files during these procedures. With this feature
enabled PeerLock will wait the set period of time to make sure
the file is fully released before unlocking the corresponding
target files

Lock File Handle

Displays the handle value created that is being used to lock
the temporary Lock File created by PeerLock to Interact with
other Peer Software Products. If the Interact features are disabled then this will display 'None'.

Release Detected

Shows the date and time when PeerLock detected the source
file was closed. This value will be cleared if the file is reopened within the Idle period and the target file handle is not
released.

Source Access Allowed

Displays the permissions that are allowed on the opened
source file.

Source Attributes

Shows the attributes of the source file.

Source Handle

Displays the handle value created when the source file was
opened.

Source Modified

Shows the modified date/time of the source file when it was
detected as being open.

Source Open Mode

Displays the permissions that were used to open the source
file.

Target Handle

Display the handle value created that is being used to lock the
target file by PeerLock.

Target Open Mode

Displays the permissions that were granted when the target
file was locked by PeerLock.

Temporary Releases

Shows the number of times the source file was closed during
the Idle period.

Notes:
For efficiency purposes, only when you click on the screens/tabs within the Advanced Run/View PeerLock panel
will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary event
files that will be loaded into the advanced display screens/tabs.
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Command Line Arguments
PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off" installation, where operation and distribution occurs from within an easily manageable, administrative environment. This mode allows Profiles to be executed from logon scripts, system
batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands -- while also
providing full access to the Profiler features through command line arguments.
Profiles will need to be created through the Profiler first in order to be further modified
through the arguments described in this topic (See Profiler Overview and related Help Topics).
Command Line Arguments are entered into a Profile shortcut, created during build through
the "Add to Desktop" button found on Profiler's Startup/Service screen.
Notes:
1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order in
which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the
format outlined in the examples provided.
2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other arguments described in this topic are used to configure operation of the PeerSync and its execution of Profiles.

Profiler Command Line Arguments
As noted above, Profile (.SNC) file names are the only variables associated with operation
of Profiler. To change an .SNC file name through the command line:
1. Right click the Profile shortcut you created during build (see StartUp/Service, "Add to
Desktop" button).
2. Select the "Properties" item from the pop-up menu.
3. Select the "Shortcut" tab. As shown in the following sample, the "Target" field will contain
a command line for the Profile, where "Profile One" represents a sample Profile name:
" C:\Program Files\PeerSync\PeerSync.exe" " C:\Program Files\PeerSync\Profile One.SNC" /
USEPROFILEARG

4. Manually change the Profile Name to reflect that of the new .SNC file
5. Click the "OK" button
PeerSync Command Line Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).

Topics
Configuration Arguments
FTP Arguments
Performance Arguments
Reporting and Display Arguments
Automation Arguments
Synchronization Arguments
Real-time Arguments
Managed Files Arguments
Bi-directional Arguments
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Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page may require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

1. Configuration Arguments
Configuration Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/0:Profile
Set SNC File to Load (Profile = File): If the /0 argument is used in a shortcut or from the
command line, PeerSync will load the Job information specified in the file.
Examples:
/0:"C:\My SNC\MyBackups.snc"
/0:MyBackups.snc
MyBackups.snc

Full path to file
Will use install directory
Will use install directory (Must be first argument)

/1:source
Set Source Path (source = Folder): If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path for a Job.
Example:
/1:c:\source /2:c:\target

c:\source to c:\target

/2:target
Set Target Path (target = Folder): If the /1 argument is used in a shortcut or from the command line, PeerSync will use it in conjunction with /2 to define a Source and Target path for
a Job.
Example:
/1:c:\source /2:c:\target

c:\source to c:\target

/C:cfile
Load Alternate Configuration File (cfile = File): If the /C argument is enabled, PeerSync
will use the values specified in cfile for synchronization information instead of using the default configuration file: PSDef.cfg which is located in the install directory.
Example:
/C:C:\PeerSync\configs\altconfig.cfg Use alternate configuration file

/USEPROFILEARG
Use Arguments from Profile: If the /USEPROFILEARG argument is used in conjunction
with a /0:Profile, PeerSync will use the arguments specified in Profile, for synchronization.
By default, when you create a shortcut on the desktop or in the startup folder from the
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StartUp Options screen this argument is used.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

2. FTP Arguments
FTP Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/FTPPASSIVE
Force FTP passive mode on: The /FTPPASSIVE argument forces on the passive mode
option for all Jobs using FTP in a Profile.
/GH:mm-dd-yy
Set FTP Short Date Format: The /GH argument sets the Short Date Format used in FTP
transmission. This feature is necessary if an FTP Server uses a non-standard date format.
Example: /GH:dd-yy-mm

/GJ:x
Set FTP Failed Upload Retry Count: The /GJ argument sets the number of times PeerSync will attempt to upload a file after it has failed.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the FTP add-on module.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

3. Performance Arguments
Performance Arguments
The following arguments are appended to the end of the command line followed by a space
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and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/GE:x
Set Shared Process Delay: The /GE argument is used to set the shared process delay to
allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU) will use
the most delay and 10 (more CPU).will use the least amount of delay.
/GK:x
Copy Thread Utilization: If the /GK argument is enabled, PeerSync will allow up to x
threads to watch the queue that manages changes allowing for increased Copy Thread utilization.
/GP:x
Set Email Threads: If the /GP argument is enabled, PeerSync will allow up to x threads to
be used for email tasks.
/LK:x
Set Multitasking Delay: The /LK argument is used to adjust the delay during multitasking.
This value may be set between 1 and 10 where 10 is the highest amount of delay and 1 is
the least amount of delay. The default value is 4.
/LN:x
Set Processor Affinity: If the /LN argument is enabled, PeerSync will allow you to limit
which CPUs to use in a multi-processor environment, where each CPU is represented by 2
to the x value:
/LN:1 = Use CPU 1
/LN:2 = Use CPU 2
/LN:4 = Use CPU 3
/LN:8 = Use CPU 4
Examples:
/LN:1
/LN:3
/LN:4
/LN:5
/LN:15

/LN:16 = Use CPU 5
/LN:32 = Use CPU 6
/LN:64 = Use CPU 7
/LN:128 = Use CPU 8
Use CPU 1
Use CPU 1, CPU 2
Use CPU 3
Use CPU 1, CPU 3
Use CPU 1, CPU 2, CPU 3,
CPU 4

(/LN:1 + /LN:2 = /LN:3)
(/LN:1 + /LN:4 = /LN:5)
(/LN:1 + /LN:2 + /LN:4 + /LN:8
= /LN:15)

Note: By default all CPUs will be used.

/MCT:x
Set Copy Threads: If the /MCT argument is enabled, PeerSync will allow up to x file copy
threads to be spawned for file copy tasks. These copy threads will be shared by one or
more Jobs during the synchronization process.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/MFT:x
Set Job Threads: If the /MFT argument is enabled, PeerSync will allow up to x Job threads
to be spawned for managing Job tasks.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/OPTIMIZE
Optimize Performance: If the /OPTIMIZE argument is enabled, PeerSync will disable
status screen windows used for outputting status information. This will minimize memory
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allocation for the User Interface.
/PERFORMANCE:x
Set Application Priority: If the /PERFORMANCE argument is enabled, PeerSync will set
the application's priority based on the following value of x
0: Lowest Priority
1: Below Average Priority
2: High Priority.
Notes:
1. This item is selectable from the Profiler via the Options/Commands Screen.
2. If the /PERFORMANCE argument is not used, PeerSync will use a default priority.
3. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

/YK:n
Set Real-time Copy Thread Pool: Used to set the percentage of Copy Threads to reserve
for Real-Time events, where n can be set between the values of 1 and 99. The default
value is 10.
/YX:n
Set File Read/Write Buffer Delay: Used to set a delay in n milliseconds between each file
read/write cycle to allow the limiting of CPU usage and system resources during file transfers. The higher the delay value, the less CPU used but the slower the performance or
speed of PeerSync.
/QR
Exclude Common Job Exceptions in Event Processing: Checks the global exclusions before file hits such as before event processing and before adding the event to the visual list.
This option creates a global file exclude list based on the file exclude list from all the Jobs.
The filter applies to real-time add and update events. Since they are applied early in event
processing there are no log entries for these exclusions. Remove the /QR option to
achieve logging.
/Q70
Exclude Common Job Exceptions in Event Processing for FPolicy Jobs Only: This argument is the equivalent of the /QR option but applies to FPolicy Jobs only. In the user interface, set the Exclude Extensions list to %AUTO% to achieve the same result.
/Q70:s
Exclude Extensions: Provide a list of comma (,) delimited file extensions to exclude when
using NetApp FPolicy detection during scans or in real-time. This can be done in the user
interface or via the command line. Use use /Q70:s, where s represents the comma (,) delimited list of extensions to exclude (i.e. /Q70:tmp,dwl,dwl2).
/Q7-s
Exclude Volumes: Provide a list of comma (,) delimited volumes to exclude when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user interface or via the command line. Use /Q7-s, where s represents the comma (,) delimited list of
volumes to exclude (i.e. /Q7-vol3,vol4).
/Q7+s
Include Volumes: Provide a list of comma (,) delimited volumes to include when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user interface or via the command line. Use /Q7+s, where s represents the comma (,) delimited list
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of volumes to include (i.e. /Q7+vol1,vol2).

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page may require the Enhanced Package or Multi Threading Option. Please
visit http://www.peersoftware.com or contact Sales for additional information.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

4. Reporting and Display Arguments
Reporting and Display Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/AP
Run Pre-Sync Report: If the /AP argument is used a Pre-Sync Report will be generated
and files/folders will not be synchronized. If you add an O to the /AP then the previous PreSync report will be Over written, if you exclude the O then the file will be appended to an
existing Pre-Sync report. If you add an S to the /AP then the Pre-Sync report will be Shown
at the end of the run (i.e.: /AP, /APO, /APOS or /APS).
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GL[S]
Display status in Profiler: If the /GL argument is used, PeerSync will open the Profiler, if it
is not already open, and send status messages to be displayed on the Run/View Current
Profile Activity screen using mail slot messaging to communicate with the Profiler. By
adding an S you can suppress the initial connection of PeerSync to the Profiler upon activation of PeerSync.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GM:x
Enable MSMQ messaging: If the /GM argument is used, PeerSync will use x as the location to manage messages in the queue.
Example: /GM:DIRECT=TCP:209.51.171.142\PRIVATE$\MYQUEUE
/GO[F:y][C:group]

Enable Peer Administrator Broadcasts: If the /GO argument is used, PeerSync will use
mail slots to broadcast activity across the LAN to the Peer Administrator utility for the centralized viewing of all PeerSync activity on the network. You can launch the Peer Administrator utility, if it is installed/available from the View Menu.
y: Identifies the number of seconds between each broadcast. The default is 3 seconds.
group: Identifies a group for the current Profile. The default is the Profile Name.
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Example: /GOF:5C:MyProfiles

Enabled and broadcasted every 5 seconds with a group name of

/GQ:[file][maxsize]
Create and Append Summaries into One Report: If the /GQ argument is used, PeerSync
will append summaries into one log file.
/GR
Report Non Standard Events: If the /GR argument is used, PeerSync will report non add,update, and delete actions.
/GS:x
Enable Summary Statistics Collection: If the /GS argument is used, PeerSync will use x
as the file location to save summary statistics.
/H
Hide Splash Screen: Available through all registered versions of PeerSync, this argument
will suppress and hide the splash screen from the Taskbar for both the PeerSync and Profiler applications.
/HOnly Hide the about screen: Available through all registered versions of PeerSync, this
argument will suppress and hide the About screen for both the PeerSync and Profiler applications.
/H+
Skip setting of main form visible: Available through all registered versions of PeerSync,
this argument will no set the main form visible and always hide the application from the
Taskbar for both the PeerSync and Profiler applications.
/LQ:[file][maxsize]
Enable FTP Logging: If the /LQ argument is used, PeerSync will log FTP activity to the
user defined file, or to PS_FTP.LOG by default.
/LSE
Log Service Events to the Event Viewer: If the /LSE argument is used, PeerSync will log
events to the Event Viewer. The following options are available for this argument:
/LSEE
/LSEEW
/LSEEM
/LSEEWM

Log messages as errors
Log messages as warnings
Only log messages and log them as errors
Only log messages and log them as warnings

/M
Show Tray Icon: If the /M argument is used, PeerSync will display an icon in the system
tray for PeerSync.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/PROGRESS
Display status in PeerSync: This feature will show the PeerSync Status Display dialog
box during synchronization so the user can see activity, status and other information while
PeerSync is running.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/SNMP
Enable SNMP Error Reporting: If the /SNMP argument is used, PeerSync will use SNMP
reporting to report any errors that occur during the synchronization process.
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/TD
Display status in PeerSync upon completion: This feature will have PeerSync show the
PeerSync Status Display dialog box at the end of synchronization (only in non-persistent
modes) so the user can see activity, status and other information upon completion.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YL
Log Messages Only to a Log File by Filter and/or by Profile: If the /YL argument is used,
PeerSync will log messages only to a log file based on the Filter and/or Profile. The following options are available for this argument:
/YL
/YLF
/YLP

Log messages for Both
Log messages by Filter Only
Log messages by Profile Only

When logging by Filter (/YL or /YLF), the Filter message log file will reside in the same directory as the primary log file, with the same file name as the primary log file but with a
"flt.log" file extension.
When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile but with a "snc.log" file extension.
/QP
Don't Display Job Stats: If the /QP argument is used, PeerSync will not display any Job
statistics in the Status Display window. Disabling this option reduces the amount of overhead work PeerSync is doing.
/QY7
XML File Creation Interval: By default PeerSync stores Profile and Job related statistics
into an easily readable XML files on an interval of every 60 seconds (if applicable) as well
as during the completion of a Job scan. This interval can be adjusted using the /QY7:n
command line argument where n represents the interval in seconds of how often you want
PeerSync to update the Profile related XML statistics.
/QY7:(T-)(C-)(A-))(n)
n
T
C
A
-

(Interval to write out statistics (60 is the default))
(Suppress .tot file creation)
( Suppress .cur file creation)
(Suppress all XML file creation and new logic for tracking file extensions)

/YB:x
Disable Tray Icon Menu Items: If the /YB argument is enabled, PeerSync will allow you to
limit which Tray Icon menu items to be disabled, where each menu item is represented by
2 to the x value.
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Note: To disable multiple menu items simply add the /YB values together for the items you
wish to disable.
EXAMPLES
/YB:512

Disables the Exit PeerSync menu option

/YB:24

Disables the Open Source Folder and Open Target Folder options
8+16=24

/YB:767

Disables All Menu Options except About PeerSync
1+2+4+8+16+32+64+128+512=767

/QP
Disable Job Stats: If the /QP argument is enabled, the Job Stats option will be unchecked,
resulting in no Job statistics being shown in the PeerSync Advanced Display panel.
/Q8BJ+
Enable Job Scans Tab: If the /Q8BJ+ argument is set, a Job Scans tab will be created in
the Advanced Run/View PeerSync panel showing Base/Root, Enhanced/Expanded, and
RT/Sub-folder scans with statistics and progress for all the Jobs or the selected Job.
/QQ
Enable the File Copy Progress Tab: If the /QQ argument is set the File Copy Progress tab
will be created in the Advanced Run/View PeerSync panel to show the progress of a file
transfer. This feature requires the Multi-Threading Option.
/Q8BH+
Enable the Historical Data Tab: If the /Q8BH+ argument is set, the Historical Data tab will
be shown in the Advanced Run/View PeerSync panel. This tab contains a subset of data
from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is broken
down into total, hourly, daily, and weekly statistics for all the Jobs or only the selected Job.
/QQ<<
Disable the Show Advanced Display link at the bottom right corner of the Run/View PeerSync screen.
/Q7O
Share Migration reporting levels: The default behavior with no arguments is to report
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Share Errors, Share Totals, Share Actions and Share Permission Errors.
/Q7OR/Q7OR
/Q7OR+
/Q7OR++
/Q7OV
/Q7O/Q7OR- /Q7OI/Q7OE

Report Share Errors and Share Totals only
Report Share Errors, Share Totals, Share Actions, Share Permission Errors and Extended Share Information
Report Share Errors, Share Totals, Share Actions, Share Permission Errors, Extended Share Information, Get and Set of Shares, Share Permission Matches and Share Permission Skips
Share Errors, Share Totals, Share Actions, Share Permission Errors, Extended Share Information, Get and Set Share Information, Share Permission Matches, Share Permission Skips and Share Permission Actions
Report source and target system information
Use previous Share Migration Logic from v9.0
Same as /Q7OR- and disables share migration starting information
Disable share migration starting information
Report all activity at the end of share migration, instead of during

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any). For more information
on the latest features and how to implement specific scenarios please goto our support page at: http://www.peersoftware.com/support/submit-a-case.html

5. Automation Arguments
Automation Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/A
Scan at Start: If the /A argument is appended to the command line, the Profile can be run
through its associated shortcut. As non-persistent processes, Automatic Operations are
run a single time upon manual initiation by the user.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/D(H):x
Delay Start of Profiler: If this argument is used, PeerSync will delay the load/start of PeerSync by x seconds. With this option enabled synchronization can be canceled via a dialog
box if done within the designated interval. For example, /D5 would provide you with a 5
second delay during which the operation can be canceled. If the /D argument includes an
H, i.e. /DH60, then the delay timer dialog will be hidden. This argument is useful for allowing PeerSync to begin after other applications have been loaded if you are running PeerSync at Windows startup.
/R[OyCz]
Real-time Monitoring Argument: The /R argument activates Real-Time Mode.
The Oy and Cz arguments are optional and specify the following retry values during RealCopyright © 1993-2014 Peer Software Inc. All Rights Reserved

137

PeerSync Help

Time Mode:
y = The
z = The

retry count if the file is open or network is unavailable
retry count maximum

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/S
Run Scheduled Operation: The /S argument enables or disables Scheduled Operation
Mode for the entire Profile. This feature must be selected in order for all Scheduled Operations set for individual Jobs to be recognized. Scheduled Mode does not apply a global
schedule to the entire Profile: rather, it enables those schedules set for all individual Jobs
on to run at their specified intervals.
All Scheduled Operations set for individual Jobs will be ignored if this mode is not selected.
If none of the Jobs within a Profile are set for Scheduled Operation and this mode is selected, all active Jobs within the Profile will be assigned a default synchronization schedule of
five minutes.
/Sx
Synchronization Timer Argument: The /Sx option is used to run PeerSync automatically
at regular intervals. This argument sets PeerSync to synchronize the selected Profile
every x minutes. Through this feature PeerSync remains persistent and will not terminate
upon completion.
Examples: /S10

Synchronization will be performed every 10 minutes

/SxKz
Synchronization Timer Argument with Keyboard Activity: The /SxKz option is used to run
PeerSync automatically at regular intervals only when it senses keyboard activity. This argument sets PeerSync to synchronize the selected Profile every x minutes upon Keyboard
activity and will always run every z cycles with/without keyboard activity. The z is optional
and will be ignored if set to 0. Through this feature PeerSync remains persistent and will
not terminate upon completion.
Note: This item is selectable from the Profiler via the Options Commands Screen.

/TIME
Daily Timer: This argument will allow for scheduling of PeerSync for specific times of the
day down to the minute for selected days of the week and selected Jobs within a Profile. If
you use a /TIMEF argument all selections at the Job level from the Automation screen will
be used. You can also specify Global Daily Timer selections for the entire Profile from the
Options/Commands Screen or by using the following format:
1. Select the time of day (by default all Jobs will be run all days)
/TIME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes
Examples:
Every Day at
12:00 am:
Every Day at
1:00 am:
Every Day at
8:00 am:
Every Day at
12:00 pm:
Every Day at
8:00 pm:

/TIME:00:00
/TIME:01:00
/TIME:08:00
/TIME:12:00
/TIME:20:00
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2. (Optional) - To select the days of week to run append the following:
D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)
Sunday:
Monday:
Tuesday:
Wednesday:
Thursday:
Friday:
Saturday:

D:1000000
D:0100000
D:0010000
D:0001000
D:0000100
D:0000010
D:0000001

Examples:
M, W & F at 8:00/TIME:08:00D:0101010
am:
/TIME:17:15D:1000001
Sat & Sun at
/TIME:03:30D:0111110
5:15 pm:
Mon - Fri at 3:30
am:
3. (Optional) - To select the Jobs to run append F:f1;f2;f3
Where f1-fn are the Job numbers.
Examples:
Job 1 Every day /TIME:06:00F:1
at 6:00 am:
/TIME:20:25F:1;2;3;4;5
Jobs 1 - 5 Every /TIME:03:30D:0111110F:1;3;5
day at 8:25 pm:
Jobs 1, 3 & 5
Mon - Fri at 3:30
am:
Note: Will accept multiple command lines.
Example:
Job 1 Every day at 8:00 am, Jobs 1 - 5 Every day at 8:25 pm and Jobs 1, 3 & 5 Mon - Fri at 3:30 am
/TIME:08:00F:1 /TIME:20:25F:1;2;3;4;5 /TIME:03:30D:0111110F:1;3;5
Sample:
Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon -Fri, (M)inimized on the tray.
"C:\Program
Files\PeerSync\PeerSync.exe"
"C:\Program
Files\PeerSync\test.snc"
/
TIME:3:00D:0111110 /M
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/UDD
Use Device Driver method: This argument uses of the Windows NT device driver for realtime detection. When using this argument PeerSync can detect changes made to remote
Source folders but only when the changes are made by the machine where PeerSync is installed.
/<
Applications to Ignore: If using the Device Driver method for Real-Time detection you can
select applications to ignore by appending application names (semicolon delimited) to the /
< argument.
Example: /<Explorer.exe;Word.exe

Will ignore any Real-Time changes made by Explorer.exe and Word.exe.

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions
(ACLs) is ignored in Real-Time.

/X
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Disable Initial Synchronization During Startup: The /X command line argument disables
initial synchronization during /A /M /R operations at PeerSync startup.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

6. Synchronization Arguments
Synchronization Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/GC:x
Set File Comparison Value: If the /GC argument is used, PeerSync will add x seconds to
the Target File date and time stamp to use during comparison.
/GD:n,z:n,z
Set Job Comparison Delta: If the /GD argument is used, PeerSync will add or subtract z
seconds from the Target File date and time stamp during a comparison for Job number n.
Example: /GD:1,+30:2,-60:

/GF
Use Alternate Copy File Methods: The following copy file methods may be invoked:
/GFC
/GFS
/GFE
/GFA

Use CopyFile API method
Use File Stream method
Use CopyFileEX method
Transfer Alternate Data Streams - The same functionality can be used at a Job
level by using the SETVAR INCLUDEALTFILESTREAMS switch in the Pre/Post
paths.

/GI(S)(D)
Ignore File Size and/or Date Comparison: If the /GI or /GIS argument is used, PeerSync
will ignore file size during folder scans (if date matches then skip file). If the /GID argument
is used, PeerSync will ignore file date comparison during folder scan (if size matches then
skip file).f the /GISD argument is used, PeerSync will ignore file date and size comparison
during folder scan (always replace Target file even if they are identical).
/GT
Get Remote PC Time: If the /GT argument is used, PeerSync will attempt to get the time
from the Target PC as well as the local PC and automatically compensate for time differences.
Note: /GT is only applicable in an NT/2K Environment
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/GX
Use Delete Path for Revisions: If the /GX argument is used, PeerSync will use the deletions path for all PSBAK revision files.
/I
Ignore Target Space During File Copy: The /I argument sets PeerSync to ignore Target
space available during file copy.
/J
Move Files: If the /J argument is used, PeerSync will move files - deleting them from the
Source after they have been successfully transferred.
/KA:x
Active Connection Interval: If the /KA argument is used, PeerSync will attempt to connect
every x minutes to Target machine(s).
/LH:x
Set Deletion Move To Folder Cleanup Interval: If the /LH argument is used, PeerSync will
check the Move To Folder (the folder where deleted files are move to), every x minutes to
see if files needed to be deleted on the cycle specified by the Delete unmatched Target
Files older than x days option.
/LI [ R | T | A ]
Target In-Use Replacement: If the /LI argument is used, PeerSync will perform the following operation if Target File is unavailable:
R
T
A

Force rename of open Target File
Force terminate of open Target File application
Force terminate of all open Target applications

/LM:xOyCz
Set Failed Connection Timer: If the /LM argument is used, PeerSync will use the following
variables to determine retry frequency:
x
y
z

Approximate time, in minutes, for retry of failed connection (time may vary as much
as a few minutes).
Frequency to retry files
Maximum Retry Count

Example: /LM5O25C100

Checks failed connections every 5 minutes, retries files every 25
seconds, to a maximum retry count of 100.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/LMD
Disable Failed Connection Timer: If the /LMD argument is used, PeerSync will not check
for failed connections:
Example: /LMD

Does not check for failed connections.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/LR:file
Run application at start of PeerSync: If the /LR argument is used, PeerSync will execute
an application or shell script specified by file at the initialization of PeerSync.
Example: /LR:C:\WINNT\notepad.exe

/LW
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Enable Last Access Compare: The /LW argument allows you to use the last access date/
time instead of the modified date/time for comparisons to determine file updates.
/NODELFLDR
Do not delete folders: If the /NODELFLDR argument is used, PeerSync will not delete
folders during synchronization.
/O
Set Target File Overwrite: The /O argument sets Target File overwrite on all Jobs.
/QB
Use Full Access File Copy: If the /QB argument is used, PeerSync will only copy files it
can gain full access to during synchronization.
/QFn
Shadow Time Range: This argument will use an n second time range for file time stamps
during comparison. If the Source and corresponding Target File time stamps fall in the
range then the file time stamps will be seen as equal.
n = Time

in seconds

Note: /QF:1 is equivalent to a value between 1 to 3 seconds depending on the file systems being used.

/QF[+][++][+++]
Precision Comparison: Use this argument to remove minutes, seconds, or milliseconds
from files during comparison.
/QF+

Removes/ignores the milliseconds from both the source and target file time
stamps during comparison
/QF++ Removes/ignores the milliseconds and seconds from both the source and target
file time stamps during comparison
/QF+++ Removes/ignores the milliseconds, seconds, and minutes from both the source
and target file time stamps during comparison
/QG
Always use the local machine time for the Last Run Time: If this argument is used, PeerSync will always uses the local machine time for the Last Run Time, instead of using the
minimum time of the Source and Target machines involved in the synchronization.
/QH:n
Force Flush File Buffers: Forces the file data that has been written across the network to
be fully committed to disk before continuing. The Interval n is the number of buffers worth
of data to write before forcing a disk write of the data, if n is not used the default is 100
cycles.
Note: This is expected to naturally occur without this argument, but on some systems across slower networks it
is necessary to force the commit of data to correctly gauge process of writing the file.

/QHD
Direct Disk Write: Forces the file data that has been written across the network to be fully
committed to disk before continuing. This will occur for each buffer worth of data that is
transferred.
Note: You may use this argument or the /GFC option to resolve Windows "Delayed Write Failed..." messages.

/QI:ext
Ignore Matching/Locked File Extensions: This argument will ignore an add/update of a
file, if a matching file with the same base name and the specified extension ext exists.
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Example: /QI:dwl
Note: One instance of this example is if a file called MyFile.dwg is updated it will be excluded from synchronization while MyFile.dwl exists.

/QJ:str
Ignore Matching/Locked File Postfix Replacement: This argument will ignore an add/update of a file, if a matching file with the same base name with the specified postfix replacement str exists.
Example: /QJ:~$
Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from synchronization while ~$Document.doc exists.

/T
Terminate All Instances of PeerSync: The /T argument terminates all running instances of
PeerSync, including itself.
/VRBn
Verify User-Name: If the /V argument is used, PeerSync will verify logged on User-Name
defined in the local user file list, specified by the following options:
R
B
n

Require user to be in the user file list
Bypass the request to add to list dialog
Maximum number of user allowed

/W:x
Set Queue Directory Change Count: If the /W argument is used, PeerSync will set queue
directory change count, events to wait for action x.
/WPFIX
Disable application associated with active file synchronization: When a file is being synchronized, this option searches all active windows on the desktop for a caption that contains the path/filename of the active file. PeerSync then disables the active application in
one of two ways. The command lines "/WPFIX or /WPFIX2" disables the entire application
and" /WPFIX1" disables the save toolbar and file menu save item. (This option also verifies
that the word "WordPerfect" is in the caption before disabling). Both options will append
"(Synchronizing)" to the existing caption and when the file is synchronized, the caption will
be restored.
/WPMOD
WordPerfect Fixes for synchronization: The /WPFIX and /WPMOD arguments are used
to help in the synchronization of WordPerfect files.
DLL file to improve interaction with WordPerfect v8 and higher: Working with the Corel corporation, we developed a 3rd party utility that disabled the save function in WordPerfect
when a document is "unmodified." This reduces the possible "File Access Denied" error
that WordPerfect produces when PeerSync is synchronizing the active document. To run
this option, you must rerun the PeerSync installation program again. The file
"PSWPMod.DLL" file will be installed in the windows System32 folder.
For WordPerfect 8, add "/WPMOD8" on the PeerSync command line, which will modify the registry as follows:
Key: HKEY_LOCAL_MACHINE\SOFTWARE\COREL\WordPerfect\8\Third Party
String: DLL16
Value: C:\WinNT\System32\PSWPMod.DLL
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For WordPerfect n, add "/WPMODn" on the PeerSync command line, which will modify the registry as follows:
Key: HKEY_LOCAL_MACHINE\SOFTWARE\COREL\WordPerfect\n\Third Party
String: DLL16
Value: C:\WinNT\System32\PSWPMod.DLL
Note: The DLL16 string may vary based on the installation of other 3rd party add-ons to your WordPerfect installation. The value could be DLL15, DLL14, etc.

/YC:x
Folder Queue Watch Interval: Change the default timer interval for checking the folder
queue to x seconds (the default is .5 seconds).
Example: /YC:3

/YD
Allow Replication During Dynamically Created Jobs: This argument will allow dynamically created Jobs (i.e. Job scans triggered by Folder Additions) to use the replicate option.
/YF:ext1;ext2;extn
Partial Locked File Extensions List: This argument is used for file types that are partial
locked when open by other applications (i.e. Outlook PST files). If the /YF argument is
used, and Volume Shadow Copy Service (VSS) is enabled PeerSync will always process
files with the specified extensions as though they are open and locked files. If VSS is not
enabled, then PeerSync will pre-scan the files to ensure complete access before file copy.
PST files are included in this list by default and can be changed via this command line.
Example: /YF:.pst;.dba;

/YN
Use Network Password Dialog: If the /YN argument is used, PeerSync will display a network password dialog if you do not have right to access the Source or Target Folder.
/YR
Delete Empty Source Folders After Move: This argument will delete all empty Source
Folders after a synchronization scan when using the Move Files - Delete Source File after
successful copy to Target option.
/YV
Do Not Validate Connections Before Profile is Loaded: This argument will not try to validate Source and Target Folder connections during the load of a Profile. It will assume that
the connections will be available upon start of each Job. This option is useful if you are
running a Pre Process that will establish a connection and/or create a Source or Target
Folder. This argument should be used when using the /LJP (Always Run Post Process) argument or when needing to dynamically create the source and or target paths.
/Z:ext1;ext2;extn
Ignore Open File Extensions: If the /Z argument is used, PeerSync will ignore files with
the specified extensions that are currently opened where the full name of the file is displayed in the caption of another window. This argument may be ignored if Multiple Job or
multiple copy threads are enabled.
Example: /Z:.wpd;.txt;

/LJU:x
Exclude Folders that have a Reparse Point: By default PeerSync will exclude folders that
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have a Reparse Point object, which are common in Windows Vista. Use this argument to
alter this behaviour:
/LJU:0 Don't exclude folders that have a Reparse Point object
/LJU:1 Exclude folders that have a Reparse Point object recursively pointing back to itself
(Default)
/LJU:2 Exclude all folders that have a Reparse Point object
/LJP
Always Run Post Process: If the /LJP argument is used, PeerSync allows for the ability to
process Post commands even if the Job fails. This argument is useful for non persistent
Profiles that need to execute or start other processes regardless whether or not its Job was
able to run. This argument should be used in conjunction with the /YV command which allows for the Profile to be loaded before the source and target folder(s) are validated.
/LX:R
Listener Alternate Route Path: Adding this option will create an Edit: Listener Alternate
Route Path option when right-clicking on either the Source or Target folder selection paths.
This creates and opens a file called %PROFILENAME%.psl in the Profiles directory used
to configure alternate route(s) for the PSListener. Here is an example of what the content of
the %PROFILENAME%.psl file should look like:
[LISTENER]
NetAppA=Win2008A
NetAppB=Win2008B
The first column contains the name or IP address of the remote non-Windows server.
The second column lists the name or IP address of the Windows server where the
PSListener is running.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

7. Real-Time Arguments
Real-Time Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/GA:x
Set Empty File Delay: If the /GA argument is used, PeerSync will delay x milliseconds before synchronizing empty (zero size) files that are detected in Real-Time.
/GB:x
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Set Shadow Detection: If the /GB argument is used, PeerSync will delay x milliseconds to
synchronize subsequent updates of the same file during Real-Time.
/LA
Real-time Attribute Change: If the /LA argument is used, PeerSync will monitor attribute
changes to files in Real-Time and use these changes as triggers for file synchronization.
/LF
Use Update Sensitivity: If the /LF argument is used, PeerSync will use the update section
of PSChangeNotify to detect file changes during real-time.
Note: This feature is generally too sensitive, and will create multiple detections.

/LG
Folder Change Detection: If the /LG argument is used, PeerSync will detect folder
changes, and in Enhanced Real-Time will force the security description to be validated.
Any change to the folder will trigger a scan of the folder including its sub folders, so that
more CPU will be required. This option is not recommended for non-enhanced Real-Time.
/LG1
Folder ACL Detection: If the /LG1 argument is used PeerSync will detect folder changes,
and in Enhanced Real-Time will force only the ACLs and attributes to be validated. Any
change to the folder (i.e. file/folder adds or deletes) will force a comparison of security
descriptors and attributes. This argument is more efficient then the /LG option above because it will not perform a scan of the folder. Use this argument if you wish to detect and
replicate ACLs in real-time for empty folders or folders that contain files for which inheritances has been disabled. Without the /LG1 argument PeerSync would need to perform a
scan in order to replicate the permissions for such folders.
/LL
Disable Real-time Security Change: If the /LL argument is used, PeerSync will not trigger
updates in Real-Time when a file's security has changed.
/LPC:x
Set Maximum Number of Events to Process within each Enhanced Real-Time Queue
Check: If the /LPC argument is used, PeerSync will set the maximum number of events to
process within each Enhanced Real-Time queue check to x events. The default is 25
events and the minimum is 5 events.
/LPC:x+
Set Maximum Number of Events to Process within each Enhanced Real-Time Queue
Check: Adding the + argument PeerSync will process the events currently in the list at the
time of queue checking set by LPQ.
Example: To queue events for 30 minutes (1800 seconds) and process them on that interval use the following arguments: /LPQS1800 /LPC+

/LPD:x
Set Delay between Enhanced Real-Time Deletions: If the /LPD argument is used, PeerSync will delay the deletion of files x milliseconds during Enhanced Real-Time.
/LPE:x
Set Delay between Enhanced Real-Time Event Processing: If the /LPE argument is
used, PeerSync will delay the processing of each event x milliseconds.
/LPM:x
Set Enhanced Real-Time Event Upper Limit: If the /LPM argument is used, PeerSync will
set the maximum number of items x to allow in the Enhanced Real-Time event queue before reverting to non-enhanced Real-Time. If this value is set to 0 then the option is disCopyright © 1993-2014 Peer Software Inc. All Rights Reserved
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abled (the default is 20000 events). If and when the Upper Limit is reached PeerSync will
clear all Enhanced Real-Time events that have not been processed and scan the directories for changes.
/LPW:x:y
Set Enhanced Real-Time Event Queue Delay: If the /LPW argument is used, PeerSync
will set the number of items x in the enhanced real-time event queue to wait for before processing, as well as, the maximum time to wait for to y milliseconds.
/LPQ:x
Set Delay between Enhanced Real-Time Queue Checking: If the /LPQ argument is used,
PeerSyncwill delay x milliseconds before checking the Enhanced Real-Time queue for new
events.
/LPX:x
Set Process Delay for Enhanced Real-time Changes: The /LPX argument allows you to
set the delay time for Enhanced Real-Time changes to be processed to x milliseconds.
This value will be applied directly for adds and updates and will be multiplied by 3 for deletions. The default is 1000 milliseconds for adds/updates and 3000 milliseconds for deletions
/YK:n
Set Real-time Copy Thread Pool: Used to set the percentage of copy threads to reserve
for Real-Time events, where n can be set between the values of 1 and 99. The default
value is 10 percent.
/QR
Real-Time Global Exclusions: Use this argument when you want to exclude real-time
events earlier in the process and throw the events away. This argument will not log/report
the exclusions. Improves performance when a high amount of events need to be excluded.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

8. Managed Files Arguments
Managed Files Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/QD
Always Use Partial Locked File Extensions List for VSS: If the /QD argument is used,
any file that is in the Partial Locked File Extension List (default: .pst files) will always be
synchronized using VSS without scanning the file for partial locks.
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Note: Please refer to the /YF argument for more detail on the Partial Locked File Extensions List.

/GY:x
VSS Interval: The /GY argument is used to set the interval to try open and locked files via
E The Default is every 2 hours and the minimum value is every 30 minutes.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YY:n
Set VSS Try Count: This argument is used to set the amount of times n to try and lock
down a drive for full access via VSS during each cycle. The default is 5 times.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. All features described on this page require the VSS add-on module.
3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

9. Bi-directional Arguments
Bi-Directional Arguments
The following arguments are appended to the end of the command line followed by a space
and forward slash (i.e. /A). A space and forward slash are also used to separate each additional argument (i.e. /A /M).
/GV
Always Create Superset during Bi-directional Synchronization: If the /GV argument is
used, PeerSync will not use the TLR value, and therefore always create a superset of data
during a bi-directional synchronization.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GW
Enable Temp Files: If the /GW argument is used, PeerSync will enable the use of temporary files during file/folder renames and deletes. This is useful during 'Real-time Bi-Directional Synchronization' in order to prevent oscillation.
/LB
Bi-directional Folder Deletion: If the /LB argument is used, PeerSync will delete folders
that have been deleted from Target or Source during bi-directional scans.
/LC
Use Last Access File Time: If the /LC argument is used, PeerSync will always use last
access file time for bi-directional synchronization.
/LD [ M | A | T | R ]
Set Trigger Folder File Name: If the /LD argument is used, PeerSync will set enhanced bidirectional synchronization trigger folder filename extension to:
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Use machine name as extension
Use LastAccessTime for TLR comparison
Use "~FLDR" extension in place of TLR
Reset/Delete all trigger folder-files

/LE
Use Enhanced bi-directional synchronization mode: The /LE argument is equivalent to /
LDMAT mode. This will alter the way the bi-directional synchronization option functions by
using enhanced features to track all file and folder adds, updates, deletions, renames and
moves between scan cycles. In this mode PeerSync will use a hidden system trigger file
within each sub-folder to store information about the last scan cycle for that sub-folder.
Using this trigger file PeerSync can determine if a Folder was added, deleted, renamed or
moved since the last scan.
Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YORetain Last Access Time for Two Machine bi-directional synchronization: The /YO- argument will store the original Last Access time of the Source File before synchronization
and then it will set the Source and Target files' Last Access Times with the stored time after
a file add or update. This will allow bi-directional scans between two machines to properly
track file adds then subsequent file deletes within the next scan cycle.
Notes:
1. When using standard or enhanced bi-directional synchronization we recommend adding /YO- as well as /
QYD:0 to your list of command line arguments to ensure deleted files from one side are not re-added by
the other side.
2. The /YO- argument should NOT be used if there are more than two machines involved in a bi-directional
synchronization due to the need of the Last Access Time to be used by the third, fourth etc. machine during comparison with either of the other two machines.

/QYD:n
Set Safety Value for Last Run Time: By default PeerSync uses /QYD:5 during standard or
enhanced bi-directional synchronization. With this option enabled deletion events are programmatically delayed by approximately 10 seconds to account for any time differences
between machines. This can be problematic when performing standard or enhanced bi-directional synchronization where a deleted file from one side can be re-added by the other.
In this scenario we recommend using /QYD:0 which represents a safety value of 0 seconds
for deletions.
n=0
n=1
n=2
...
n=5

safety value = 0 seconds
safety value = approximately 2 seconds
safety value = approximately 4 seconds
safety value = approximately 10 seconds

Note: When using standard or enhanced bi-directional synchronization we recommend adding /QYD:0 as
well as /YO- to your list of command line arguments to ensure deleted files from one side are not re-added
by the other side.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.
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3. Command line arguments can also be identified through hints displayed on the Profiler.
4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a description of the feature as well as its related command line argument (if any).
5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/submit-a-case.html.

Other Components
1. PeerSync Status Display
Status Display Screen
This screen is used to view Current Profile Activity within the PeerSync application. The
Status Display window can only be viewed when PeerSync is running as an Application
and not as a Service. Enable the "Display status in PeerSync" option available in the Options/Commands > Display Options... dialog to have the Status Display show automatically
at the start/launch of PeerSync or right-click on the Tray Icon and select "Show Status Display".
Profile

Displays the name of the Profile actively being processed. This
label may not match the name of the Profile currently being
configured through Profiler.

Job

This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode

Displays the Operation Mode (Real-time Mode, Scheduled
Operation, etc.) applied to synchronization of the Active Profile.

Source

Displays a file path for the Source Folder presently being synchronized.

Target

Displays a file path for the Target Folder presently being synchronized from the Source indicated above.

Folders

This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder
is synchronized. An additional "thermometer" indicator will also
track the progress of folder synchronization.

Files

This indicator displays the total number of files contained
within the Source while also providing a count of synchronized
files. In addition, a "thermometer" indicator will show file synchronization progress by increasing according to the size of
the current folder, with 100% representing the cumulative size
of files contained within the Source Job set.

File

Indicates the name of the file currently being synchronized.

Large File or Compression Status

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during compression. The caption will show the size of the file that has been
copied to the Target and/or compression status.

Skip File

This button will appear once the active Profile has been
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launched. This feature allows you to skip synchronization of
the file currently displayed in the indicator described below.
Skip Files enables you to avoid delays caused by large files on
slow network or dial-up connections.
Size

Indicates the size (in bytes) of the file currently being synchronized. A related "thermometer" indicator tracks the progress of
synchronization for that file.

Checked

This indicator displays the total number of files contained in the
selected Source Folders.

Excluded

Indicates the number of files that were excluded from synchronization (See Exceptions).

Messages

Indicates the number of error messages generated during Profile processing.

Updated

Indicates the number of Target Files that were updated during
synchronization of Profile Jobs.

Added

Indicates the number of new files added to Target Folders during synchronization of Profile Jobs.

Deleted

Indicates the number of files deleted (or moved) during synchronization of Profile Jobs.

Target Space

Indicates the Target Folder space remaining during synchronization of Profile Jobs.

Elapsed Time

Indicates the amount of time that has elapsed during the current Profile activity.

Hide

Will hide this display, which can be re-accessed via the Tray
Icon Men.

Quit

Allows you to close/exit the current session of PeerSync.

Other Screen Features
Processed Lists

The Updated, Added, Deletions and Excluded screens will display statistical information in the above format. Each screen
will have statistical information (File Name, Size, Modified
Date/Time, Path, Duration, etc.) about the changes that have
occurred during the current PeerSync session.

Item Count

Display of the amount of changes that have occurred for the
current screen.

Maximum List Size

Allows you to select the maximum amount of changes that you
wish to store for the current screen. It is recommended to keep
this value low because each entry requires memory to be used
by PeerSync.

Status Display Popup Menu
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Activated by right clicking on the PeerSync Status Display. The Status Display window can
only be viewed when PeerSync is running as an Application and not as a Service. Enable
the "Display status in PeerSync" option available in the Options/Commands > Display Options... dialog to have the Status Display show automatically at the start/launch of PeerSync
or right-click on the Tray Icon and select "Show Status Display".
View Log File

Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Admin Folder

Allows you to access, launch and view Admin log file Folders
in Explorer for the current Profile.

Open Source Folder

Allows you to access, launch and view Source Folders in Explorer for the current Profile.

View Target Folder

Allows you to access, launch and view Target Folders in Explorer for the current Profile.

Print

Allows you to print the current screen information.

Save As

Allows you to save the current screen information to file.

Clear List

Allows you to clear/reset the current screen information.

Re-Load Profile

Allows you to re-load the current Profile if any changes have
occurred.

About PeerSync

Will display an about screen, that contains information about
the current PeerSync you are running.

Quit

Allows you to close/exit the current session of PeerSync.

2. PeerSync Remote Control
PeerSync Remote Control Screen Features
This feature allows you to connect to and monitor any PeerSync currently running on your
LAN. Including PeerSync running as an application or a service on the local machine and/
or any instances of PeerSync running on any machine that is accessible from the local machine.
Profile Selection

The field located to the left of the Add Button. This field is used
to add a Profile to the Profile Selection List. The format for a
Profile selection is: MACHINENAME:PROFILENAME (i.e.
DELLSERVER:Profile.snc).

Profile Selection List

The list located below the Profile Selection, which contains
Profile Selections that can be connected to and monitored by
selecting the item and using the Connect button.

Add

This button will add the current Profile Selection to the Profile
Selection List.

Connect

This button will connect to the current Profile Selection and display its activity on the screen.

Disconnect

This button will disconnect the current Profile Selection and
stop the display of activity.

Refresh

This button will refresh the current Profile Selection activity.
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Pause/Resume

This button will pause/resume the current Profile that is selected.

Query

This button will search for and add all Profiles that can be
found to the Profile Selection List.

Clear List

This button will clear out all entries from the Profile Selection
List.

Remote Connection Information

Displays the computer, user and last response for the current
connection.

Close

This button will close this dialog.
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Note: The features described on this page require the Enhanced Package.

3. Quick-Sync
This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s)
with the option to modify your Job settings at a later time.
Simply right click on any folder you wish to sync and select "Quick-Sync Folder...". This will
launch the Wizard, which will ask you to select a Target Folder to sync to...and your ready to
run the Quick-Sync. You also have the options to edit and/or add the current sync Job to your
Quick-Sync Profile or any other selected Profile. Then the next time you select a folder if it
matches any Source or Target selection in the Quick-Sync Profile the Jobs will be listed to
pick from or you have the option to add a new Job.
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Index
-%%Desktop% 56
%Favorites% 56
%Fonts% 56
%Personal% 56
%Programs% 56
%Recent% 56
%SendTo% 56
%Start Menu% 56
%Startup% 56
%Templates% 56

-//< (Applications to Ignore) 136
/0 (Set SNC File to Load) 128
/1 (Set Source Path) 128
/2 (Set Target Path) 128
/A (Scan at Start) 136
/AP (Run Pre-Sync Report) 132
/C (Load Alternate Configuration File) 128
/D (Delay Scan at Start) 136
/FTPPASSIVE (Force FTP passive mode on) 129
/GA (Set Empty File Delay) 144
/GB (Set Shadow Detection) 144
/GC (Set File Comparison Value) 139
/GD (Set Job Comparison Delta) 139
/GE (Set Shared Process Delay) 129
/GF (Use Alternate Copy File Methods) 139
/GH (Set FTP Short Date Format) 129
/GI (Ignore File Size and/or Date Comparison) 139
/GJ (Set FTP Failed Upload Retry Count) 129
/GK (Copy Thread Utilization) 129
/GL (Display status in Profiler) 132
/GLS (Display status in Profiler - Supress Initial
Connection) 132
/GM (Enable MSMQ messaging) 132
/GO (Enable PSObserver Broadcasts) 132
/GP (Set Email Threads) 129
/GQ (Create and Append Summaries into One
Report) 132
/GR (Report Non Standard Events) 132
/GS (Enable Summary Statistics Collection) 132

/GT (Get Remote PC Time) 139
/GV (Always Create Superset during Bi-directional
Sync) 147
/GW (Enable Temp Files) 147
/GX (Use Delete Path for Revisions) 139
/GY (VSS Interval 146
/H (Hide Splash Screen) 132
/H- (Only Hide the about screen) 132
/I (Ignore Target Space During File Copy) 139
/J (Move Files) 139
/KA (Active Connection Interval) 139
/LA (Real-time Attribute Change) 144
/LB (Bi-directional Folder Deletion) 147
/LC (Use Last Access File Time) 147
/LD (Set Trigger Folder File Name) 147
/LE (Use Enhanced bi-directional synchronization
mode) 147
/LF (Use Update Sensitivity) 144
/LG (Folder Change Detection) 144
/LG1 (Folder ACL Detection) 144
/LH (Set Deletion Move To Folder Cleanup Interval)
139, 140
/LI (Target In-Use Replacement) 139
/LJP (Always Run Post Process) 139
/LJU (Exclude Folders that have a Reparse Point)
139
/LK (Set MultiTasking Delay) 129
/LL (Disable Real-time Security Change) 144
/LM (Set Failed Connection Timer) 139
/LMD (Disable Failed Connection Timer) 139
/LN (Set Processor Affinity) 129, 130
/LPC (Set Maximum Number of Events to Process)
144
/LPD (Set Delay between Enhanced Real-Time
Deletions) 144
/LPE (Set Delay between Enhanced Real-Time Event
Processing) 144
/LPM (Set Enhanced Real-Time Event Upper Limit)
144
/LPQ (Set Delay between Enhanced Real-Time
Queue Checking) 144
/LPW (Set Enhanced Real-Time Event Queue Delay)
144
/LPX (Set Process Delay for Enhanced Real-time
Changes) 144
/LQ (Enable FTP Logging) 132
/LR (Run application at start of PeerSync) 139
/LSE (Log Service Events to the Event Viewer)
132, 133
/LW (Enable Last Access Compare) 139
/M (Show Tray Icon) 132
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/MCT (Set Copy Threads) 129
/MFT (Set Job Threads) 129
/NODELFLDR (No not delete folders) 139
/O (Set Target File Overwrite) 139
/OPTIMIZE (Optimize Performance) 129
/PERFORMANCE (Set Application Priority) 129
/PROGRESS (Display status in PeerSync) 132
/Q7+s (Include Volumes for NetApp FPolicy
Detection) 131
/Q70 (Exclude Common Job Exceptions in Event
Processing for FPolicy Jobs) 131
/Q70s (Exclude Extensions for NetApp FPolicy
Detection) 131
/Q7O (Share Migration Reporting levels) 132
/Q7-s (Exclude Volumes from NetApp FPolicy
Detection) 131
/Q8BH+ (Enable the Historical Data Tab) 135
/Q8BJ+ (Enable Job Scans Tab) 135
/QB (Use Full Access File Copy) 139
/QD (Always Use Partial Locked File Extensions List
For VSS) 146
/QF (Shadow Time Range) 139
/QG (Always use the local machine time for the Last
Run Time) 139
/QH (Force Flush File Buffers) 139
/QHD (Direct Disk Write) 139
/QI (Ignore Matching/Locked File Extensions) 139
/QJ (Ignore Matching/Locked File Postfix
Replacement) 139
/QP (Disable Job Stats) 135
/QP (Don't Display Job Stats) 132
/QQ (Enable the File Copy Progress Tab) 135
/QQ<< (/QQ<< (Disable the Show Advanced Display
link) 135
/QR (Exclude Common Job Exceptions in Event
Processing) 131
/QY7 (XML File Creation Interval) 132
/QYD (Set Safety Value for Last Run Time) 106,
147, 148
/R (Real time Monitoring Argument) 136
/S 6
/S (Run Scheduled Operation) 136
/SNMP (Enable SNMP Error Reporting) 132
/Sx (Synchronization Timer Argument) 136
/SxKz (Synchronization Timer Argument with
Keyboard Activity) 136
/T (Terminate All Instances of PeerSync 139
/TD (Display status in PeerSync upon completion)
132
/TIME (Daily Timer) 136
/UDD (Use Device Driver method) 136
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/USEPROFILEARG 128
/VRB (Verify User-Name) 139
/W (Set Queue Directory Change Count) 139
/WPFIX (Disable application associated with sync)
139
/WPMOD (WordPerfect Fixes for synchronization)
139
/X (Disable Initial Synchronization During Startup)
136
/YC (Folder Queue Watch Interval) 139
/YD (Allow Replication During Dynamically Created
Jobs) 139
/YF (Partial Locked File Extensions List) 139, 143
/YK (Set Real-time Copy Thread Pool) 144
/YK:n (Set Real-time Copy Thread Pool) 129
/YL (Log Messages Only to a Log File by Filter and/or
by Profile) 132
/YN (Use Network Password Dialog) 139
/YO (Retain Last Access Time for Two Machine
bi-directional synchronization) 106
/YO- (Retain Last Access Time) 147, 148
/YR (Delete Empty Source Folders After Move)
139
/YV (Do Not Validate Connections Before Profile is
Loaded) 139
/YX:n (Set File Read/Write Buffer Delay) 129
/YY (Set VSS Try Count) 146
/Z (Ignore Open File Extensions) 139

-1127.0.0.1

34, 47

-AAbout PeerSync 149
Accessing Open Files 66, 106, 108
ACL Options (Global) 105
Activate real-time monitoring 60
Active Connection Interval 139
Active Job 149
Active Profile List 149
Add Jobs with Wizard 14
Add - synchronize new files to target 66
Add Jobs 14
Add Quick-Sync Folder option to Explorer menu
113
Add Shares with the selected Prefix 101
Add Shares with the selected Suffix 101
Add Shares: Do Not Update or Delete 101

155

PeerSync Help

Add to Windows registry 113
Add to Windows StartUp 113
Add/Delete/Modify Jobs: Tool Buttons 14, 26
Added Files Reporting Feature 90
Added Indicator 149
Additional Configuration Entries 6
Additional Event Options 80, 82
Additional Features 82
Additional Features List 82
Additional Features Screen: 82, 83
Additional Options 82, 83
Enable file recovery 82, 83
Perform binary comparison on all files (using
CRC32) 83
Replace in-use files upon reboot 76, 83
Validation Options 83
Additional File Includes 71
Additional Folder Selection Features 56, 82
Additional Options 82
Additional/Alternate Target Paths 56
Admin Backup 102
Admin Report Cycle Options 92
Admin Reporting 91
Admin Reporting Features 92
Admin Reporting Screen: 91, 92
Admin Reporting Overview 91
Report file name 92
Report File Path 92
Use error information only 92
Use standard report file content 92
Use Summary Information Only 92
Administrative report file storage manipulation and
organization 56
Advanced Backup 102
Advanced Options 101, 102
Advanced View 29
Affinity 129
After each scan 96
After each scan (log all non-scan events on the cycle
specified) 93
After each scan/cycle even if no events occurred
93, 96
After synchronization subtract/add x minute(s) from
target 84
Allow for remote real-time configuration - NetApp
fPolicy 37
Allow Replication During Dynamically Created Jobs
139
Alternate Configuration File 128
Alternate Data Stream (ADS) Backup 102

Alternate Target Path Selection Dialog 56
Alternate/Additional Target Paths 56
Always create a super-set during bi-directional
synchronization 106
Always Create Superset during Bi-directional Sync
147
Always overwrite 66
Always Run Post Process 139
Always Use Partial Locked File Extensions List For
VSS 146
Always use the local machine time for the Last Run
Time 139
Append Default File/Folder Exclusions from PeerLock
110
Application Priority 129
Applications to Ignore 136
Argument Selection 107
Argument Selection from the Interface 108
Arguments 107
ASCII 44, 53
At the start of this Profile 93
At the stop of this Profile 93
Attach log file to messages 95
Attribute Exceptions 88, 89
Automatically detect and use recommended NetApp
configuration 39
Automatically use recommended settings based on
Detection Method - Source Folder 38
Automation 60
Automation Command Line Arguments: 136
Applications to Ignore 136
Daily Timer 136
Delay Scan at Start 136
Device Driver method 136
Disable Initial Synchronization During Startup
136
Interval 136
Keyboard Activity 136
Real time Monitoring Argument 136
Run Scheduled Operation 136
Scan at Start 136
Synchronization Timer Argument 136
Synchronization Timer Argument with Keyboard
Activity 136
Timer Argument 136
Use Device Driver method 136
Automation Features 60
Automation Screen: 60
Activate real-time monitoring 60
Automation Screen Overview 60
Daily Timer Options 60
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Automation Screen: 60
Run at specific times and selected days 60
Run on an interval every x minute(s) 60
Use enhanced real-time monitoring 60

-BBack Button 14
Back-Up 3
Bandwidth throttling 74
Basic View 29
Bi-directional Command Line Arguments: 147
Always Create Superset during Bi-directional
Sync 147
Bi-directional Folder Deletion 147
Enable Temp Files 147
Retain Last Access Time 147
Set Safety Value for Last Run Time 147
Set Trigger Folder File Name 147
Use Enhanced bi-directional synchronization
mode 147
Use Last Access File Time 147
Bi-directional Folder Deletion 147
bi-directional synchronization 66
bi-directional synchronziation 80
Binary Comparison 83
Bi-Sync Options Button 107
blackout 64
Blackout Settings 64
Block Size Selection 76
Buffer Size - File Read/Write 74
Buffer Size Upper Limit 74
Buttons 14
ByteReplicator 76
Block Size Selection 76
Excluded File Types 76
Exclusions 76
Minimum File Size 76
Port 76
Time Out 76

-CCarbon Copies - Email Reporting 95
Change Password 99
Changing Profile Job List Window 26
Check for ACL changes during scans 105
Checked Indicator 149
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Choose external applications/scripts to be run before
and after the processing of a given Job 100
Clear List 149
Clear Log File 89
collect real-time events 64
Command Line Argument Selection 107
Command Line Argument Selection from the
Interface 108
Command Line Arguments 108, 127
Compare Time Change 84
Compress target 98
Compressed File Extension 99
Compression 97
Compression - TCP Souce 43
Compression - TCP Target 51
Compression Features 98
Compression Overview 97
Compression Screen: 97, 98, 99
Change Encryption Password 99
Compress target 98
Compressed File Extension 99
Compression Speed 99
Expand source 98
Extraction 97
Overview 97
Password - Encryption 99
Use file compression 98
Use folder compression 98
Compression Speed 99
Compression Status 149
Computer Name Variable 56
Configuration Command Line Arguments: 128
Alternate Configuration File 128
Load Alternate Configuration File 128
Set SNC File to Load 128
Set Source Path 128
SNC File 128
Use Arguments from Profile 128
Configuration Entries 6
Configure FTP Source Folder 47
Configure FTP Target Folder 55
Configure Normal Source Folder 46
Configure Normal Target Folder 54
Configure TCP Source Folder 46
Configure TCP Target Folder 55
Connect As 41
Connect to and monitor any PeerSync currently
running on your LAN 151
Connection Manager 38
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Connection Manger for Failed Connections - Source
Folder 38
Convert to GMT for comparison purposes 84
Copy Jobs 14
Copy Thread Utilization 129
Copy Threads 104, 129
Copyright 3
CRC32 83
Create a report for every event 92
Create a report on an interval 92
Create a report once a day 92
Create a report once a week 92
Create administrative Email messages 94
Create administrative report files 92
Create and Append Summaries into One Report
132
Create Auto FTP Job Name 55
Create Email messages 94
Create Normal Souce Auto Job Name 46
Create Normal Target Auto Job Name 54
Create Pre Sync Report 26
Create Shortcut on Desktop 113
Create SNC extension association for Profiler 113
Create Souce FTP Auto Job Name 47
Create Source Folder 34
Create Target Folder 47
Create Target TCP Auto Job Name 55
Create TCP Source Auto Job Name 46
Current Arguments 107
Current Arguments Button 107
Current Attributes 88, 89
Current Command Line Argument Selection 103,
107
Customize Selection Tree 29
Customized View 29

-DDaily Timer 136
Daily Timer Options 60
Date variables for Folder Paths 56
Date/Time Variable 56
Dates Exceptions 88
Day variables for Folder Paths 56
Days of the week scheduling 60
Default inclusion 85
Default Read/Write Buffer Size 74
Delay between Enhanced Real-Time Deletions

144

Delay between Enhanced Real-Time Event
Processing 144
Delay between Enhanced Real-Time Queue
Checking 144
Delay Scan at Start 136
Delayed Write Failed 139
Delete Empty Source Folders After Move 139
Delete fPolicy on Close - NetApp Settings 39
Delete Jobs 14
Delete log file after successful send 95
Delete Unmatched Target Files 68, 69
Delete unmatched target files older than x days 69
Deleted file storage manipulation and organization
56
Deleted Indicator 149
Deletion Folder 69
Deletion Options 68, 69
Deletion Options Button 68, 69
Destination IP 91
Detection Method for Real-Time Monitoring 37
Detection Method Options 37
Device Driver method 136
Disable all Startup Options 113
Disable application associated with sync 139
Disable Failed Connection Timer 139
Disable Initial Synchronization During Startup 136
Disable Install Reboot 6
Disable Jobs that are Not Configured from this
Profiler 111
Disable Real-time Security Change 144
Disabled - Connection Manager 38
Display status in PeerSync 132
Display status in PeerSync upon completion 132
Dissimilar time zone synchronization 84
Distribution 3
Do Not Validate Connections Before Profile is Loaded
139
Drag and Drop Source Folder Selection 34
Drag and Drop Target Folder Selection 47
Drive Mapping 59
During comparison subtract/add x minute(s) from
target 84
Dynamic Network Drive Mapping and Un-mapping
59
Dynamic archives 56
Dynamic synchronization based on date 56
Dynamic synchronization based on logged on user or
machine name 56
Dynamic synchronization based on personal folders
or other variables read in from the registry 56
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-EEasy way to synchronize folders on the fly 152
Edit Job Groups Dialog 28
Edit Menu 18
Edit Normal Source Variable File 46
Edit Normal Target Variable File 54
Elapsed Time Indicator 149
Email Report Cycle Options 96
Email reporting 94
Email Reporting Features 94
Email Reporting Overview 94
Email Reporting Screen: 94, 95
Attach log file to messages 95
Create administrative Email messages 94
Delete log file after successful send 95
Report file name - Email Reporting 95
Use error information only 94
Use standard report file content 94
Use summary information only 94
Email Threads 129
Embedded Open File Manager 66
Enable file recovery 82, 83
Enable FTP Logging 132
Enable intelligent network load balancing 74
Enable intelligent network load balancing (when
applicable) 74
Enable Last Access Compare 139
Enable Passive Mode - FTP Source 44
Enable Passive Mode - FTP Target 52
Enable PSObserver Broadcasts 132
Enable SNMP Error Reporting 132
Enable Summary Statistics Collection 132
Enable Temp Files 147
Enabled for Source and Target Connections Connection Manager 38
Enabled for Source Connections Only - Connection
Manager 38
Enabled for Target Connections Only - Connection
Manager 38
Encryption - TCP Souce 43
Encryption - TCP Target 51
Enhanced real-time 60
Enhanced Real-Time Event Queue Delay 144
Enhanced Real-Time Event Upper Limit 144
Enhanced Scan Processing 61
Error Reporting 132
Evaluating a new version of PeerSync 10
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Evaluation Menu 24
Event Options 68
Exception Screen Features 84
Exceptions 84
Exceptions Screen:
Exceptions Screen Overview 84
Exclude Files by Character/String/Extension
86
Exclude Files from Sync by Size 88
Exclude Files in Sync by Attribute 89
Excluding Folders from Sync 87
Include File Types (using wild cards) 85
Include Files in Sync by Attribute 88
Include Files in Sync by Date 88
Exclude all open files until closed 71
Exclude File Sizes 88
Exclude Files 86
Exclude Files Button 86
Exclude Folders 87
Exclude Folders Button 87
Exclude Folders drop down list 87
Exclude Folders that have a Reparse Point 139
Exclude open files 71
Exclude open files (allow read access to source file
during transfer) 71
Exclude open files (deny all access to source file
during transfer) 71
Exclude root folders 87
Exclude specific folders only 87
Exclude Users - NetApp fPolicy 37
Excluded Indicator 149
Exclusion drop down list 86
Exclusive Remedy 3
Executable Path (PeerLock) 115
Executable Path (PeerSync) 113
Expand source 98
Explore Source Folder 34
Explore Target Folder 47

-FFailed connection 103
Failed Registration 8
Features 82
File Date Reporting Feature 90
File Dates 88
File Deletion Options 68, 69
File Exclusions 76
File Folder Path Variables 56
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File Indicator 149
File Menu 17
File Options 66
File Options Features 66
File Options Screen: 66, 69
Add - synchronize new files to target 66
Avoiding Permanent Deletion 68, 69
Delete Unmatched Target Files 68, 69
Delete Unmatched: Options 68, 69
Deletion Warning Message 68, 69
Mode Selection 66
Replicate - Delete unmatched files/folders 66
Update - synchronize existing files in target 66
Use Windows Recycle Bin 68, 69
File Path Variables 56
File Path Variables: Folder Selection 56
File Read/Write Buffer Size 74
File Recovery 82, 83
File Size Reporting Feature 90
File Sizes 88
File Time Change Options 82
File Time Reporting Feature 90
File types to transfer as ASCII - FTP Source 44
File types to transfer as ASCII - FTP Target 52
File Versions 78
Files Indicator 149
Folder ACL Detection 144
Folder Change Detection 144
Folder Creation Reporting Feature 90
Folder Names Reporting Feature 90
Folder Queue Watch Interval 139
Folder Restoration feature in real-time 60
Folder Selection Features 34
Folder Selection Screen: 34
File Path Variables 56
Folder Selection Screen Overview 34
Source Folder Selection 34
Target Folder Selection 47
Folders Indicator 149
For each individual error message as it occurs 93
for each message/error as it occurs 96
Force Flush File Buffers 139
Force FTP passive mode on 129
Force Source Folder Root as Target FTP Folder Root
55
Force Source Folder Root as Target TCP Folder
Root 55
fPolicy Name - NetApp Settings 39
FTP Command Line Arguments: 129

Force FTP passive mode on 129
Set Failed Upload Retry Count 129
Set Short Date Format 129
FTP Logging 132
FTP Source 36
FTP Source Configuration 44
FTP Source Mode Selection 44
FTP Source PopUp 47
FTP Source Settings Tab 44
FTP Target 49
FTP Target Configuration Tab 52
FTP Target Mode Selection 52
FTP Target PopUp 55
FTP Target Settings Tab 52

-GGeneral 3
Get Remote PC Time 139
Global ACL Options 105
Global Advanced File Xfer Options 101, 102
Global bi-directional Options 103, 106
Global Display Options - Profiler Options 108
Global Managed Files Options 103
Global Migrate Shares Options 101, 102
Global Options 111
Global Recovery/Offline Options 103
Global Settings (PeerLock): 111
Disable Jobs that are Not Configured from this
Profiler 111
Global Options 111
Link this Profiler to PeerLock 111
Save Changes in PeerLock 111
Show PeerLock 111
Global Settings (PeerSync): 103, 104, 105, 106,
107, 108
Global VSS Options 103
Greater Than File Size Exclusion 88

-HH+ (Skip setting of main form visible) 132
Help Button 14
Help Menu 22
Hide 149
Hide Splash Screen 132
Host is using GMT - FTP Source 44
Host is using GMT - FTP Target 52
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Host Name 50
Host Name - FTP Source 44
Host Name - FTP Target 52
Host Name - TCP Source 42
Host Server Name - NetApp Settings
Hour variables for Folder Paths 56
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-IIgnore File Size and/or Date Comparison 139
Ignore Matching/Locked File Extensions 139
Ignore Matching/Locked File Postfix Replacement
139
Ignore Open File Extensions 139
Ignore Target Space During File Copy 139
Improve Load Balancing 74
Include all open files 71
Include attribute change as synchronization criteria
82
Include Files 85
Include Files Button 85
Include open files 71
Include open files (allow read & write access to
source file during transfer) 71
Include open files (allow read access to source file
during transfer) 71
Include open files (if possible) 71
Include partially open files 71
Include Sub foldersFolder Selection Screen:
Include Source Sub-Folders 34
Include this Job in PeerLock 110
Inclusion drop down list 85
Information Required to Register software 8
initiate scan on trigger file change 65
Initiate Synchronization on Source or Target
File/Folder Change 60
Install Options 6
Install Service (PeerLock) 115
Install Service (PeerSync) 113
INSTALL.LOG 6
Installation (Silent Install) 6
Installation Configuration Options 6
Installing PeerSync 6
Intelligent Network Load Balancing 74
Intermediate View 29
Interval 136
Intervals Button 103
Item Count 149
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job data import 59
Job Indicator 149
Job Menu 21
Job Settings (PeerSync): 31, 34, 60, 64, 65, 66, 71,
72, 74, 76, 78, 80, 82, 84, 89, 91, 94, 97, 100
Job Settings PeerLock: 110
Append Default File/Folder Exclusions from
PeerLock 110
Include this Job in PeerLock 110
Job Threads 104, 129
Jobs 12, 151

-KKeep backup files of overwritten Target Files
Keep files in Alternate Folder 78
Keep files in Deletion Folder 78
Keep files in Target Folder 78
Keep multiple versions of files 78
Keyboard Activity 136

78

-LLarge File or Compression Status 149
Last Run On 56
Last Run On - Reset 26
Last Run On Feature 26
Last Save 56
Last Scan 56
Launch (PeerLock) 123, 124
Launch (PeerSync) 117, 119
Launch Current Profile 14
Left side Panel - Selection Tree 29
Less Than File Size Exclusion 88
License 3
License File 6
Limit CPU usage during file transfers 129
Limit number of processors to use 129
Limit system resources during file transfers 129
Limitations of Liability 3
Limited Warranty 3
Link this Profiler to PeerLock 111
List of Exclude Files (using sub strings) 26, 86
List of Exclude Folders 87
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List of Include File Types (using wild cards) 85
List of Job Selections - Daily Timer 60
Load Alternate Configuration File 128
Load Balancing 74
Log File - Clear 26
Log File - View 26
Log file storage/manipulation/organization 56
Log Files: Administrative 91
Log Messages by Filter 132
Log Messages by Profile 132
Log Messages Only to a Log File by Filter 132
Log Messages Only to a Log File by Filter and/or by
Profile 132
Log Messages Only to a Log File by Profile 132
Log Service Events to the Event Viewer 132
loopback 34, 47

-MManaged Files 73
Managed Files Arguments: 146
Always Use Partial Locked File Extensions List
For VSS 146
Set VSS Base Timeout 146
Set VSS Try Count 146
VSS Interval 146
Match Shares: Add, Update and Delete 101
Maximize Speed 74
Maximum compression 99
maximum duration of scans 65
Maximum List Size 149
Maximum Log File Size 90
Maximum Number of Events to Process 144
Maximum speed - compression option 99
Menu (PeerSync):
Edit 18
Evaluation 24
File 17
Help 22
Job 21
Options 19
PeerSync Tray Icon PopUp Menu 25
Run 20
View 18
View Popup Menu 25
Messages Indicator 149
Messages Reporting Feature 90
Migrate Shares 101

Minute variables for Folder Paths 56
Miscellaneous 80
Mode Indicator 149
Mode Selection 66
Monitor ACL changes during real-time 105
Monitor PeerSync activity across the LAN 151
Monitor Remote Instances of PeerSync 151
Month variables for Folder Paths 56
Move Files 81, 139
Move Job Down 14
Move Job Up 14
MS Windows Explorer Add On - Quick-Sync 152
MSMQ messaging 132
Multiple Copy Threads 104
Multiple Job Threads 104

-NNaming and Renaming Jobs 26
NetApp fPolicy 37
NetApp Settings 39
Network Constant - TCP Source 42
Network Constant - TCP Target 50
Network Drive Mapping 59
Network License 3
Network Load Balancing 74
Network Logon Settings - Connect As 41
Network Logon Settings - Password 41
New Profile 14
Next Button 14
No not delete folders 139
Non Persistent Processes 26
Normal 37
Normal Source 34
Normal Source Mode Selection 37
Normal Source PopUp 46
Normal Target 47
Normal Target Mode Selection 50
Normal Target PopUp 54
Number of backup files to keep 78

-OOnly Hide the about screen 132
Only include connections that are set for real-time
monitoring 38
Only use Advanced Settings 92, 96
Open File Manger Options 66
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Open File Options 66
Open Files 71, 108
Open Profile 14
Open Source Folder 34, 149
Open Target Folder 47
Open/Locked Files 71
Optimize Performance 129
Optimize speed 74
Options 31
Options Menu 19
Options/Commands 108, 149
Options/Commands Features 108
Options/Commands Overview 108
Options/Commands Screen: 107, 108
Current Arguments 107
Current Arguments Button 107
Overview 108
Set Access Password 108
Show tray icon 108
Other Global Options/Command 103
Overview 12, 151
Overwrite Existing Log File 89
Overwrite existing Pre-Sync report file 107

-PParameter Selection from Profiler 107
Partial Locked File Extensions List 139
Password 41
Password - Encryption 99
Password - FTP Source 44
Password - FTP Target 52
Password - Registration 8
Password - TCP Souce 43
Password - TCP Target 51
Password for Tray Icon 108
Path (PeerLock) 115
Path (PeerSync) 113
Path to Host 50
Path to Host - FTP Source 44
Path to Host - FTP Target 52
Path to Host - TCP Source 42
Path to Host - TCP Target 50
pause scan during specific times 64
Pause Service (PeerLock) 123, 124
Pause Service (PeerSync) 117, 119
PeerLock Selection Tree Category 29
PeerLock Service: 123, 124
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Launch PeerLock 123, 124
Pause Service 123, 124
Resume Service 123, 124
Run as a service 123, 124
Start Service/Application 123, 124
Stop Service/Application 123, 124
PeerSync Command Line Arguments 127
PeerSync Installation 6
PeerSync Remote Control 151
PeerSync Selection Tree Category 29
PeerSync Service: 117, 119
Launch PeerSync 117, 119
Pause Service 117, 119
Resume Service 117, 119
Run as a service 117, 119
Start Service/Application 117, 119
Stop Service/Application 117, 119
PeerSync Status Display 149
PeerSync Status Display Popup Menu 149
PeerSync Temp Folder 6
peersync92.exe 6
PeerSync92.lic file 6
Perform binary comparison on all files (using CRC32)
83
Performance 74
Performance - Threads 104
Performance Command Line Options: 129
Affinity 129
Application Priority 129
Copy Thread Utilization 129
Copy Threads 129
Email Threads 129
Job Threads 129
Limit CPU usage during file transfers 129
Limit number of processors to use 129
Limit system resources during file transfers
129
Optimize Performance 129
Priority 129
Processor Affinity 129
Set Application Priority 129
Set Copy Threads 129
Set Email Threads 129
Set File Read/Write Buffer Delay 129
Set Multitasking Delay 129
Set Processor Affinity 129
Set Real-time Copy Thread Pool 129
Set Shared Process Delay 129

163

PeerSync Help

Performance Command Line Options: 129
Set the percentage of copy threads to reserve for
real-time events 129
Shared Process Delay 129
Thread Utilization 129
Threads 129
Performance Features 74
Performance Options All Jobs 108
Performance Package 104, 108
Performance Priority Selection 104
Performance Screen: 74
Enable intelligent network load balancing (when
applicable) 74
File Read/Write Buffer Size 74
Set maximum number of copy threads to x 74
Throttle bandwidth - Use x percent of available
bandwidth 74
Pop Up Menu: Profile Job List 26, 29
Pop Up Menu: Selection Tree 29
Port - Email Reporting 95
Port - FTP Source 44
Port - FTP Target 52
Port - TCP Souce 43
Port - TCP Target 51
Port Configuration 76
Post Installation Configuration Options 6
Post process application 100
Pre Installation Configuration Options 6
Pre process application 100
Pre/Post Features 100
Pre/Post Overview 100
Pre/Post Process 100
Pre/Post Process Overview 100
Pre/Post Process Screen: 100
Select Application/Script to Run After 100
Select Application/Script to Run Before 100
Use maximum wait time of x seconds 100
Wait for application to end before continuing
100
Preserve Paths 68, 69
Pre-Sync Report Options 107
pricing information 8
Print 149
Priority 129
Priority Selection 104
Process Delay for Enhanced Real-time Changes
144
Process Migrate Shares after each scan 102
Process Migrate Shares every x minute(s) 102

Processed Lists 149
Processor Affinity 129
Product Definitions 12, 151
Product Support 12, 151
Product Updates 8
Profile Description: 17
Default Description 17
Hiding Profile Description Toolbar 17
Moving Profile Description Toolbar 17
Profile Indicator 149
Profile Job List Pop Up Menu 26
Profile Job List: 26
Add/Delete/Modify Jobs 26
Changing Size of Window 26
Naming and Renaming Jobs 26
Selecting Jobs and Multiple Jobs 26
Profile Options: Customize 29
Profile Options: Show All 29
Profile Selection 151
Profile Selection List 151
Profiler 12, 151
Profiler Command Line Arguments 127
Profiles 12, 151
PSDef.CFG 6
PSError.log 90
PSObserver Broadcasts 132

-QQuantity Discounts
Quick-Sync 152
Quick-Sync Folder
Quick-Sync Profile
Quit 149

8
152
152

-RReal time File Folder Change Detection
Real Time Mode 12, 151
Real time Monitoring Argument 136
Real Time Options 62
Real-time Attribute Change 144
Real-Time Command Line Arguments:
Disable Real-time Security Change
Folder ACL Detection 144
Folder Change Detection 144
Real-time Attribute Change 144

60

144
144
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Real-Time Command Line Arguments: 144
Set Delay between Enhanced Real-Time
Deletions 144
Set Delay between Enhanced Real-Time Event
Processing 144
Set Delay between Enhanced Real-Time Queue
Checking 144
Set Empty File Delay 144
Set Enhanced Real-Time Event Queue Delay
144
Set Enhanced Real-Time Event Upper Limit
144
Set Maximum Number of Events to Process
144
Set Process Delay for Enhanced Real-time
Changes 144
Set Real-time Copy Thread Pool 144
Set Shadow Detection 144
Use Update Sensitivity 144
Real-time Copy Thread Pool 144
Real-Time Event Detection Options 60
Real-time Monitoring 60
Real-time Options Button 60
Reboot Options Button 83
receive an e-mail at start of profile 96
receive an e-mail at stop of profile 96
Recovery Intervals Button 103
Register by FAX 8
Register by mail 8
Register by phone 8
Register online 8
Registering Evaluation Copy of PeerSync 9
Registering Unregistered Copy of PeerSync 9
Registration and Passwords: 8
Entering User ID/Password (Evaluation Copy)
8
Register By Mail 8
Registry variables to use in Folder Paths 56
Related Global Settings 71
Relative Paths 69
Re-load Profile 149
Remote Connection Information 151
Remote Connection Licenses 151
Remote Control 151
Remove Service (PeerLock) 115
Remove Service (PeerSync) 113
Rename Job 14
Replace In use Files Options 83
Replace in use files upon reboot 82, 83
Replace Shares: Add and Overwrite 101
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Replicate - Delete unmatched files/folders 68, 69
Replication 12, 151
Report file name 92, 95
Report file path 92
Report Non Standard Events 132
Reporting 89
Reporting Command Line Arguments: 132
Create and Append Summaries into One Report
132
Display status in PeerSync 132
Display status in PeerSync upon completion
132
Enable FTP Logging 132
Enable PSObserver Broadcasts 132
Enable SNMP Error Reporting 132
Enable Summary Statistics Collection 132
Error Reporting 132
FTP Logging 132
Hide Splash Screen 132
Log Messages by Filter 132
Log Messages by Profile 132
Log Messages Only to a Log File by Filter 132
Log Messages Only to a Log File by Filter and/or
by Profile 132
Log Messages Only to a Log File by Profile
132
Log Service Events to the Event Viewer 132
MSMQ messaging 132
Only Hide the about screen 132
PSObserver Broadcasts 132
Report Non Standard Events 132
Run Pre-Sync Report 132
Show Tray Icon 132
Skip setting of main form visible 132
SNMP Error Reporting 132
Summary Report 132
Summary Statistics Collection 132
Suppress connection of PeerSync to the Profiler
132
Tray Icon 132
Reporting Features 89
Reporting Screen: 89
Clear Log File 89
Include Options 90
Maximum Log File Size 90
Overview 89
Overwrite Existing Log File 89
Use Log File 89
View Log File 89
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Reporting Standard report file content 92, 94
Reporting Summary Information Only 92, 94
Reset Last Run On Value 26
Resume Service (PeerLock) 123, 124
Resume Service (PeerSync) 117, 119
Retain Last Access Time 147
Retry failed connections every x minutes 103
Retry open files every x seconds 103
retry open inaccessible files 103
Retry Options Button 83
Revisioning 78
Revisions 78
Root Path - TCP Source 42
Root Path - TCP Target 50
Root Path Prefix - NetApp Settings 39
Run a Pre-Sync Report (do not sync files/folders)
107
run a scan on reconnect 103
Run application at start of PeerSync 139
Run as a service (PeerLock) 123, 124
Run as a service (PeerSync) 117, 119
Run at specific times and selected days 60
Run External applications/scripts before and after the
processing of a given Job 100
Run Menu 20
Run Pre-Sync Report 132
Run RegEdit 113
Run Scheduled Operation 136
Run selected Jobs at a specific time of day 60
Run VSS every x minutes 106
Run/View 29
Run/View (PeerLock): 123, 124
Launch PeerLock 123, 124
Pause Service 123, 124
Resume Service 123, 124
Run as a service 123, 124
Start Service/Application 123, 124
Stop Service/Application 123, 124
Run/View (PeerSync): 117, 119
Launch PeerSync 117, 119
Pause Service 117, 119
Resume Service 117, 119
Run as a service 117, 119
Start Service/Application 117, 119
Stop Service/Application 117, 119
Run/View Current Profile Activity Screen: 149
Added Indicator 149
Checked Indicator 149
Deleted Indicator 149

Elapsed Time Indicator 149
Excluded Indicator 149
File Indicator 149
Files Indicator 149
Folders Indicator 149
Job Indicator 149
Messages Indicator 149
Mode 149
Profile Indicator 149
Size Indicator 149
Skip Files Button 149
Source Indicator 149
Target Indicator 149
Target Space Indicator 149
Updated Indicator 149
Running Jobs vs. Running Profiles (Run a Quick
Sync) 26

-SSample Exclusions 86
Save As 149
Save Changes in PeerLock 111
Save Profile 14
Saving Profiles 14
Scan at Start 136
Scan limitations 65
Scan real-time Jobs on reconnect if "Scan Job once
at start" is enabled 38
Scanning Options 60
Scheduled Mode 12, 151
Scheduling Options 60
Select a folder for deleted files to be placed 69
Select Application/Script to Run After 100
Select Application/Script to Run Before 100
Select days of the week to run Jobs 60
Select Source Folder 34
Select Source Folder Button 34
Select Target Folder 47
Select Target Folder Button 47
Selected File Dates 88
Selecting Jobs 26
Selecting Multiple Jobs 26
Selecting Source Folders 34
Selecting Target Folders 47
Selection Tree 29
Selection Tree: Customize Options 29
Send an email for every event 96
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Send an email on an interval 96
Send an email once a day 96
Send an email once a week 96
Service (PeerLock) 123, 124
Service (PeerSync) 117, 119
Service Details (PeerLock) 115
Service Details (PeerSync) 113
Set Access Password 108
Set Alternate/Additional Normal Targets 54
Set Application Priority 129
Set Copy Threads 129
Set Deletion Move To Folder Cleanup Interval 139
Set Email Threads 129
Set Empty File Delay 144
Set Failed Connection Timer 139
Set File Comparison Value 139
Set File Read/Write Buffer Delay 129
Set FTP Failed Upload Retry Count 129
Set FTP Short Date Format 129
Set Job Comparison Delta 139
Set maximum number of copy threads to x 74
Set maximum number of retries to x 103
Set Multitasking Delay 129
Set Processor Affinity 129
Set Queue Directory Change Count 139
Set Real-time Copy Thread Pool 129
Set Safety Value for Last Run Time 147
Set Shadow Detection 144
Set Shared Process Delay 129
Set SNC File to Load 128
Set Source Path 128
Set Target File Overwrite 139
Set the maximum log file size to x bytes 90
Set the percentage of copy threads to reserve for
real-time events 129
Set Today's Date Button 88
Set Trigger Folder File Name 147
Set VSS Try Count 146
Settings 31
Shadow Time Range 139
Shared Process Delay 129
Show Advanced/Normal Display 119
Show Advanced/Normal Display PeerLock 124
Show All Profile Options 29
Show PeerLock 111
Show Pre-Sync report file at end of run 107
Show Tray Icon 108, 132
Show/hide Selection Tree 14
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Show/hide the Selection Tree 29
Silent Installation 6
Simple Network Management Protocol reporting 91
Size Indicator 149
Skip File Button 149
Skip setting of main form visible 132
SMTP Host - Email Reporting 95
SNC File 128
SNMP Error Reporting 132
SNMP Options Button 91
SNMP reporting 91
Source and Target Selections 34
Source Configuration 102
Source File/Folder Alterations 80, 81
Source Folder Connection Manager 38
Source Folder Detection - NetApp fPolicy 37
Source Folder Detection - Normal 37
Source Folder Detection Method 37
Source Folder Field 34
Source Folder NetApp Settings 39
Source Folder Network Logon Settings 41
Source Folder Popup Menu 46
Source Folder Selection 34
Using FTP Mode 34
Using Normal Mode 34
Using TCP Mode 34
Source Indicator 149
Source to Target Combination Settings 31
Source-target backup/synchronization scenario 31
Specific time scheduling 60
Standard synchronization 66
Start Service/Application (PeerLock) 123, 124
Start Service/Application (PeerSync) 117, 119
Startup/Service 29
Startup/Service (PeerLock): 115
Executable Path (PeerLock) 115
Install Service (PeerLock) 115
Path (PeerLock) 115
Remove Service (PeerLock) 115
Service Details (PeerLock) 115
Startup/Service (PeerSync): 113
Add to Windows registry 113
Add to Windows StartUp 113
Create Shortcut on Desktop 113
Create SNC extension 113
Disable all Startup Options 113
Executable Path 113
Install Service 113
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Startup/Service (PeerSync): 113
Quick-Sync Folder Option 113
Remove Service 113
Run RegEdit 113
Service Details 113
Status Display 149
Status Screen 149
Stop Service/Application (PeerLock) 123, 124
Stop Service/Application (PeerSync) 117, 119
store events while connection is down 103
store missed events and process on reconnect 103
Summary Report 132
Summary Reporting Feature 90
Summary Statistics Collection 132
Suppress connection of PeerSync to the Profiler
132
Suppress Reboot during Install 6
suspend file transfer 64
Swap Source and Target Folders 56
Sync Selected Jobs 26
Synchronization 12, 151
Synchronization Command Line Arguments: 139
Active Connection Interval 139
Allow Replication During Dynamically Created
Jobs 139
Always Run Post Process 139
Always use the local machine time for the Last
Run Time 139
Delete Empty Source Folders After Move 139
Disable application associated with sync 139
Disable Failed Connection Timer 139
Do Not Validate Connections Before Profile is
Loaded 139
Enable Last Access Compare 139
Exclude Folders that have a Reparse Point
139
Folder Queue Watch Interval 139
Force Flush File Buffers 139
Get Remote PC Time 139
Ignore File Size and/or Date Comparison 139
Ignore Matching/Locked File Extensions 139
Ignore Matching/Locked File Postfix
Replacement 139
Ignore Open File Extensions 139
Ignore Target Space During File Copy 139
Move Files 139
No not delete folders 139
Partial Locked File Extensions List 139
Run application at start of PeerSync 139

Set Deletion Move To Folder Cleanup Interval
139
Set Failed Connection Timer 139
Set File Comparison Value 139
Set Job Comparison Delta 139
Set Queue Directory Change Count 139
Set Target File Overwrite 139
Shadow Time Range 139
Target In-Use Replacement 139
Terminate All Instances of PeerSync 139
Use Alternate Copy File Methods 139
Use Delete Path for Revisions 139
Use Full Access File Copy 139
Use Network Password Dialog 139
Verify User-Name 139
WordPerfect Fixes for synchronization 139
Synchronization of files between dissimilar time
zones 84
Synchronization Timer Argument 136
Synchronization Timer Argument with Keyboard
Activity 136
Synchronize ALL files via Managed Files 73
Synchronize open/locked files via Managed Files
73
Synchronize Selected Jobs Option 26

-TTarget Configuration 102
Target File Time Change Option 84
Target File/Folder Alterations 80
Target Folder Field 47
Target Folder Popup Menu 54
Target Folder Selection 47
Target Indicator 149
Target In-Use Replacement 139
Target Space Indicator 149
TCP Source 35
TCP Source Configuration Tab 42
TCP Source Mode Selection 42
TCP Source PopUp 46
TCP Source Port Configuration Tab 43
TCP Target 48
TCP Target Configuration Tab 50
TCP Target Mode Selection 50
TCP Target PopUp 55
TCP Target Port Configuration Tab 51
TCP Wan Connector Option 35, 42, 48, 50
Temp Files 80
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Temp Folder Selection 6
Term and Trial Period 3
Terminate Active Profile 14
Terminate All Instances of PeerSync 139
Thread Utilization 129
Threads 104, 129
Throttle bandwidth 74
Throttle bandwidth - Use x percent of available
bandwidth 74
Time Change After Sync 84
Time Delta Selection 84
Time Out - FTP Source 44
Time Out - FTP Target 52
Time Out - TCP Source 43
Time Out - TCP Target 51
Time variables for Folder Paths 56
Time Zone Option 84
Timer Argument 136
Tool Buttons 14
Tool Buttons: 14
Add Job 14
Back 14
Copy Job 14
Delete Job 14
Help 14
Hiding/Moving Toolbar 14
Launch Current Profile 14
Move Job Down 14
Move Job Up 14
New Profile 14
Next 14
Open Profile 14
Overview 14
Rename Job 14
Save Profile 14
Settings Screens Drop-Down List 14
Show Selection Tree 14
Terminate Active Profile 14
Toolbars: Profile Description 17
Transfer Time Reporting Feature 90
Trap Prefix 91
Tray Icon 108, 132
Tray Icon Popup Menu 25
Tree 29
trigger file 65
Turn file archive attribute off after synchronization
81
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-UUninstall 6
Uninstall previous versions of PeerSync 10
Update - synchronize existing files in target 66
Updated Files Reporting Feature 90
Updated Indicator 149
Updates: Product 8
Upgrade 10
Upgrade Information 10
Upgrade PSListener 10
Use Alternate Copy File Methods 139
Use Arguments from Profile 128
Use Block Byte Level Synchronization 76
Use block/byte level synchronization 76
Use daily timer scheduling 60
Use Delete Path for Revisions 139
Use Device Driver method 136
Use Enhanced bi-directional synchronization mode
147
Use enhanced bi-directional synchronization mode
options 106
Use enhanced real-time monitoring 60
Use error information only 92, 94
Use file compression 98
Use folder compression 98
Use Full Access File Copy 139
Use intermediate file during copy: 80
Use Last Access File Time 147
Use Log File 89
Use maximum wait time of x seconds 100
Use Network Password Dialog 139
Use Proxy - Firewall - FTP Source 44
Use Proxy - Firewall - FTP Target 52
Use SNMP reporting 91
Use standard report file content 92, 94
Use summary information only 92, 94
Use Update Sensitivity 144
Use Variables for folder paths stored in registry 56
Use VSS 66
User ID - Email Reporting 95
User Name - FTP Source 44
User Name - FTP Target 52
User Name - TCP Souce 43
User Name - TCP Target 51
User Name and Password 9
User Name variable 56
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Using # in Excluding Folders 87
Using Variable Paths 56
Using Wild Cards for files to Include

85

-VValidate target file (using CRC32) 83
Validation Options 82, 83
variable data import 58
Variables 56
Variables: File Path 56
Verify User-Name 139
version of files 78
View Admin Folder 149
View Alternate Target Path Selection 56
View Log File 26, 89, 149
View Menu 18
View PeerSync activity across the LAN 151
View Popup Menu 25
View Target Folder 149
Volume Shadow Copy Service (VSS) 72, 73, 106,
146
VSS 66, 72, 73, 106, 146
VSS Interval 106, 146

-WWait for application to end before continuing 100
Web Farms 108
What email address to send from 95
Who to send emails to 95
Window: Changing Height of Profile Job List 26
Windows Explorer Add On - Quick-Sync 152
Windows Platforms 12
Windows Variables for Folder Paths 56
WordPerfect Fixes for synchronization 139
Working With Jobs 12, 151
Working with Profiles 12, 151

-YYear variables for Folder Paths

56
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